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Notice 

The information in this manual was current when published. The manufacturer reserves the right to revise and improve its products. All 
specifications are therefore subject to change without notice. 

Copyright 

Under copyright laws, the contents of this manual may not be copied, photocopied, reproduced, translated or reduced to any electronic 
medium or machine-readable form, in whole or in part, without prior written consent of Tyco Security Products. 

O2015 Tyco Security Products. MI Rights Reserved. 

American Dynamics 

60 Congress Avenue 

Boca Raton, F L 33487 U.S.A. 

Customer Service 

Thanks you for using American Dynamics products. We support our products through an extensive worldwide network of dealers. the dealer 
through whom you originally purchased this product is your point of contact if you need service or support. Our dealers are empowered to 
provide the very best in customer service and support. Dealers should contact American Dynamics at (800) 507-6268 or (561) 912-6259 or 
on the Web at www.americandynamics.net.

Trademarks 

Window?)  is a registered trademark of Microsoft Corporation. PS/2® is a registered trademark of International Business Machines 
Corporation. 

The trademarks, logos, and service marks displayed on this document are registered in the United States [or other countries]. Any misuse of 
the trademarks is strictly prohibited and Tyco Security Products. will aggressively enforce its intellectual property rights to the fullest extent of 
the law, including pursuit of criminal prosecution wherever necessary. All trademarks not owned by Tyco Security Products are the property 
of their respective owners, and are used with permission or allowed under applicable laws. 

Product offerings and specifications are subject to change without notice. Actual products may vary from photos. Not all products include all 
features. Availability varies by region; contact your sales representative. 

License Information 

Your use of this product is governed by certain terms and conditions. Please see the detailed license information at the end of this manual. 
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Overview 

From a single, intuitive interface, victor enables management of live and recorded video from all of Tyco Security 
Products video recorders; Intellex DVRs, ADTVRs, VideoEdge NVRs and exacqVision. victor supports multiple 
integrations and Unification with C•CURE 9000, allowing unified control and monitoring of your entire security system. 

victor's complete and scalable portfolio of clients offers a solution that is right for any business, of any size: 

victor Express 
victor Express offers the ability to manage live and recorded video from multiple Intellex DVRs and VideoEdge NVRs 
through the victor interface. victor Express does not rely on a victor Application Server for its database, instead using 
SQL Express Localdb. 

victor Express is limited to one client connection and so does not support features which rely on multiple clients being 
connected (e.g. video wall). victor Express does not support integrations or Unification with C•CURE 9000. victor 
Express is upgradable to victor Professional. 

IP C aloe. as IP Came( as 

VideoFdge Intellex 

victor L xpress Installation 

American Dynamics 3 

EFTA01223812



victor Professional 
victor Professional enables management of live and recorded video from all Tyco Security Products video recorders 
(Intellex DVRs, ADTVRs, VideoEdge NVRs and exacqVision). victor Professional also supports integration of 
supported 3rd party devices (e.g. Fire Panels, Intrusion systems) and Unification with the CCURE 9000 access 
control system, enabling monitoring and control of your entire security system from the single victor interface. 

victor Professional uses victor Application Server to manage data. victor Application Server is an industry standard 
Microsoft SQL Server database and as such, can be hosted either on the local client machine or remotely, enabling 
scalability to suit your business. 
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For users with large, dispersed systems, victor (along with CCURE 9000) supports enterprise deployments. 
Enterprise architecture supports a Master Application Server (MAS) which synchronizes data with up to 20 Satellite 
Application Servers (SAS). This provides the ability to view and manage all aspects of the unified security system 
from the MAS, as well as rolled up reporting and event management for the entire enterprise. 
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Enterprise deployments are typically 'Hub and Spoke' with the MAS at the hub and SAS's forming the globally 
deployed spokes. 

Refer to "Appendix A: victor MAS/SAS support" for further details including installation instructions. 
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Updates 

Introduction 
You can update victor unified client and VideoEdge NVR (4.4+) recorders from within the victor unified client. Updates 
files are hosted in a repository on the victor Application Server machine and can be downloaded by connected clients 
and pushed to supported recorders. 

Tyco Update Utility 
During install, the Tyco Update Utility is installed alongside victor client. This component communicates with an 
update repository which is hosted on the victor Application Server providing a means to update Tyco software. 

The update application lists all available updates that can be installed on the user's system along with the location of 
the machine hosting the update repository. 

Unless disabled in Windows, Tyco Update Utility will launch on startup. Tyco Update Utility can be manually 
launched by navigating to C:1Program Files (x86)1TycolUpdateClient' and launching TycoUpdateUl.exe. Once 

launched 1/41 will display in the system tray. Double click to relaunch the Tyco Update Utility. 

Note: 
In order to download and install updates using the Tyco Update Utility, you must have Windows administrator rights. 

victor 
victor client checks for available updates: 

• Daily (automatically) if run for more than 24 hours without a restart 

• Automatically on client startup 

• Automatically when the client connects to a new victor Application Server 

You can also check manually from the 'About' page 

Note: 
Update checks can only be carried out if the current victor user has the 'Administrator role in victor. 
The ability to check for updates can be added to roles other than 'Administrator by using the Type Exception 
Workstation • Update victor client. 

Only victor client users who have the Administrator or Power User role are allowed to perform updates to the victor 
client. If the current victor user does not have one of these roles then the update options will be disabled. 

Windows administrator rights are required to install victor unified client updates. 

Note: 
It is good practice to acknowledge and clear all active Events before upgrading. 

American Dynamics 6 

EFTA01223815



Updating victor Client 

Automatic Updates 

If an update is available, launching victor unified client, the client being open for 24 hours or connecting to a new victor 
Application Server will display a dialog stating: 

-The victor Application Server you are connected to has an update available. Installing this update will cause 
victor client to be closed. Would you like to automatically download and install this update?" 

Follow the procedure below to install the update. To skip the update, select Remind Me Later. 

Procedure 1 Install Automatic Update 

Step Action 

1 Select Install. The victor unified client license agreement dialog opens 

2 Read the license carefully and select Accept or Decline as applicable 

3 If Accept is selected, victor client will close and a dialog will display showing progress of downloading and 
installing updates. The update can be canceled by selecting Cancel during the download of update files. 

Note: 
During the upgrade, if the Tyco Update application is running, the user is informed of progress via a 
system tray status display. 

4 Once update is complete, select OK 

- End - 

Manual Updates 
Users with appropriate permissions can manually check for and install updates from within victor unified client. 

Procedure 2 Install Manual Update 

Step Action 

1 Select then About. The about tab opens. 

2 Select Check for Updates. 

3 If no update is available, dialog will display 'Software is up to date". If there is an update available, dialog will 
display: 

-The victor Application Server you are connected to has an update available. Installing this update will cause 
victor client to be closed. Would you like to automatically download and install this update?" 

4 Select Install. The victor unified client license agreement dialog opens. 

5 Read the license carefully and select Accept or Decline as applicable. 

6 If Accept is selected, victor client will close and a dialog will display showing progress of downloading and 
installing updates. The update can be canceled by selecting Cancel during the download of update files. 

Note: 
1. Progress dialog will not display if User Account Control (UAC) is enabled. 
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2. During the upgrade, if the Tyco Update application is running, the user is informed of progress via a 
system tray status display. 

7 Once update is complete, select OK. 

- End - 

VideoEdge NVR 
Updates can be applied to VideoEdge NVRs from the client via the recorders context menu. 

Before performing the update, the NVR checks the current version installed against the version to be installed. If it is 
not a higher version, an alert is posted to the client, informing it that the update failed and the reason for failure. 

If security is enabled on the NVR, the user is prompted for credentials before the update is applied. 

After successful update and restart of NVR services, an alert is sent to the victor client indicating to it that the 
installation was a success. 

A Caution 
1. When a software update is applied either via a push update or applied manually using the Administration Interface, 
NVR services will restart. Temporary NVR service outage should therefore be expected when an update is applied. 
2. It is recommended that you should schedule when NVR upgrades are applied and expect a loss of video when 
services restart. When upgrading NVRs which are being monitored by a secondary (Failover) NVR you need to stop 
Server Monitoring to prevent the secondary NVR taking over when the upgraded primary NVR's services stop. 

Note: 
VideoEdge NVR updates can only be carried out if the current user has 'Edit' permissions on the applicable VideoEdge 
NVR recorder. 

Update VideoEdge NVR 
VideoEdge NVR software update bundles can be hosted on the site server update repository and pushed down to 
individual recorders via the client GUI. 

Procedure 3 Update VideoEdge NVR 

Step Action 

1 Right click the recorder to be updated. 

2 Select Check for Updates.lf updates are available, Do you want to install upgrade dialog displays. 

Note: 
If no updates are available, dialog displays - No Update available 

3 Select Yes. Dialog advises that the recorder will be offline for a period of time. 

4 Accept EULA. Recorder goes offline during upgrade. 

Note: 
During upgrade, any alerts related to success or failure of updating display in victors activity list. 
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- End - 
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Getting Started 

Introduction 
This section describes the basic steps on involved in how to start victor services (victor Professional only), launch the 
client after installation and provides an overview of the main Graphical User Interface (GUI). 

It is important to read this section as it provides useful user information on a number of basic/common tasks which are 
not repeated throughout the manual and are not related to specific object types or scenarios. 

Server Configuration Application (victor Professional) 
The Server Configuration Application provides a management interface for administration of various server settings. It 
is accessible directly from the desktop via the Server Configuration Application icon or via the Windows Start Menu 
(All Programs > Tyco > victor > Server Configuration) 

The Application comprises the following tabs: 

• Services -Allows Framework and Extension services to be manually started and stopped 

• Server Components -Allows manual starUstop of Bidirectional server components 

• Database - Displays database connections 

• Settings -Allows Enable/Disable of Application and Network settings 

• Backup/Restore -Allows you to backup and restore your SQL database 

Restarting services (victor Professional) 
After initial installation, all applicable services will be running. However, victor services may need to be restarted when 
new licenses are added to ensure full functionality is available. 

Note: 
Crossfire Framework Services must be started first to allow Extension services to run 

Procedure 4 Restarting victor Services 

Step Action 

1 Double click the Server Configuration Application Icon on the desktop. The Server Configuration 
Application displays. 

Note: 
Depending on security settings, you may need to right click the icon and select Run as 
Administrator. 

2 Select the Services tab. 

3 Select Stop for all Framework Services. Status changes to Stopped. 
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4 Select Stop for Extension services as required. 

5 Select Start Service for Crossfire Framework Service in the Framework Services section. Wait until 
Status:Running displays in Green. 

6 Select Start Service for Crossfire Server Component Framework Service in the Framework Services 
section. Wait until Status:Running displays in Green. 

Note: 
All extension services should start automatically. If you need to manually start them, continue to 
Step 7. 

7 Select Start checkbox for all required extension services. 

8 Select Start Service for all required extension services. The status changes to Running. 

9 Confirm that all Services have changed state to Running. 

10 Exit the Server Configuration Application. 

- End - 

Launch the Client 

Note: 
1. Before starting the client, ensure all victor services are running (victor Professional only) 
2. Initial sign-in must be from the windows user account under which the client was installed. (During installation, a 
client user is created called Installer Account. Because this is the only user which exists at this time and victor uses 
Windows authentication, it is important that this user is logged in to Windows.) 

Procedure 5 Starting the client 

tep Action 

1 Double click the victor unified client icon on the desktop. The client sign in dialog displays (Unless this is 
the first sign on in which case the client will connect automatically). 

2 Select Authentication Method the operator uses from the dropdown - Windows or Basic 

3 Enter Username (Windows Usemame of the installer account if this is the first login) 

4 Enter Password (Password of the Installer Account) 

Note: 
Blank Password are not accepted 

5 Select Domain and victor Application Server as required 

6 Select OK to Login or Cancel to Exit 

- End - 
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Exploring the Default Workspace 
The default layout for the client is made up of a ribbon control comprising Home, Build and Setup tabs. The tools and 
buttons available on each tab is dependent on the components installed, licenses applied and the role of the logged in 
user. 

Below the Ribbon, The Device List, Surveillance window and status bar make up the rest of the default layout. 

Home Tab - User Controls 
The Home tab contains typical user/viewer controls. No configuration or setup options are available 
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Build Tab - Configuration Tools 
The Build tab contains administrative tools to configure non hardware objects e.g. Operators, Roles, Video Actions 
and Events 
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Setup Tab - Configuration Tools 
The Setup tab contains administrative tools to configure system hardware e.g. General Purpose Devices, Recorders 
and Keyboards 
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Status Bar 

The Status bar is a static display of System level Information which includes: 

• Number of Active Alerts 

• Server Name (victor Application Server) 

• Client Messages 

• Active Operator 

• Active Layout 

• Bandwidth Configuration (Configurable from the status bar) 

• Name of the Active Virtual Matrix 

• Workstation Status (CPU Usage/Memory Free/Disk Space Free) 

• Current Date and Time 

• Any Error Messages detected by the client will also be displayed. For example 'Recorder has reached its 
maximum number of clients' 

Alert • ( 11) BELIWKD000 I Client connected. Default , LAN Connection I anaeltee) = BEL1WKL169 \ADMINISTRATOR 12/06/2012. 11:03 

Device List 

The Device list displays a list of all hardware configured in the system in a single window. It is primarily used to 
interact with hardware via object icons' context menus. 

The device list forms part of the default layout. 

Save and Close Options 

Save and Close options are displayed and used in all object editors when creating or editing any object types. It is 
important to understand the differences between the various options as proper use can save time and effort when 
configuring objects. 

Save and Close 
the editor 

fl ri
Apply 

Close editor -
Do not save 

Save and create 
new object type 
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Switch Language/Culture 
You can change the language/culture of the text displayed on the application Graphical User Interface (GUI) 

Procedure 6 Switch Language/Culture 

Step Action 

1 Select the victor menu button on top left of the main victor unified client window. Dropdown menu dis-
plays. 

2 Select Languages 4' button. Language Selection dialog displays. 

3 Select the Dropdown menu in the language dialog. 

4 Select the required language. 

5 Click Select. Dialog displays informing you the next time you run the program, the User Interface will be in 
the selected language. 

6 Close the victor program. 

7 Launch victor. GUI displays in the new language. 

- End - 

Logout/Switch Operator 

To logout, select in the top left of the main victor unified client window. The current operator will be logged out and 
the logon window will display. 

To switch operator, select in the top left of the main victor unified client window. The logon window will display but 
the current operator will remain logged in until a new operator is authenticated. 

Reposition the Quick Access Toolbar 
You can reposition the Quick Access Toolbar below or above the ribbon. 

Note: 
The ribbon is minimized by default 

Procedure 7 Reposition the Quick Access Toolbar 

tep Action 

1 Select from the top left of the client window. 

2 Select Show Below the Ribbon or Minimize the Ribbon as required. 

3 Select • to reverse the selection. 

- End - 
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Common Tasks 
There are certain tasks within the client which are identical for all object types and therefore are not repeated in each 
chapter. This section gives an overview of some of the tasks and explains how to perform them. 

• Show All (Dynamic Views) 

• Delete (Objects) 

• Refresh Hardware 

• Object Editors 

• Object Selector 

Show All Objects (Dynamic Views) 

Object lists (Dynamic Views) are generally displayed using the Show All option from an object type's dropdown 
menu. 

These lists will generally contain at a minimum Names and Descriptions of available objects. Depending on the type 
of object being displayed, more information may be available by right clicking the column headers and displaying extra 
detail. 

Procedure 8 Show All Objects (Dynamic Views) 

Step Action 

1 Select the Object Icon from the Build or Setup Tab. 

2 Select Show All from the dropdown menu. A List of all selected object types displays. 

- End - 

Delete Objects 

The procedure to delete objects is identical for all object types. 

Procedure 9 Delete Objects 

tep Action 

1 Select the Object Icon from the Build or Setup Tab. 

2 Select Show All from the dropdown menu. A List of all selected object types displays. 

3 Right Click on the object to be deleted. 

4 Select Delete. A warning dialog displays. 

5 Select Yes to Delete or No to Cancel. 

- End - 
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Refresh Hardware 

The procedure to refresh hardware is identical for all object types. 

Procedure 10 Refresh Hardware 

btep Action 

1 From the Device List, to refresh ALL objects of a single type: 

a Right Click the Parent object. 

b Select Refresh. All objects of that type refresh. 

2 To refresh individual objects: 

a Select I next to object type to expand the selection. 

b Right click the object to be refreshed. 

c Select Refresh. The object refreshes. 

- End - 

Object Editors 

Object editors are used to make changes to existing system objects. They are generally accessible from the Object's 
context menu. 

Procedure 11 Edit Objects (General) 

Step Action 

1 Select the object type from the Build or Setup tab. 

1 Select Show all to display object list. 

2 Right click the object. 

3 Select Edit to enter the object's editor page. 

4 Make changes as required. 

5 Select Save. 

- End - 
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Object Selector 

The Object Selector is used throughout the client to select objects or assign actions. It is mainly used for 
Administration E.G when selecting role exceptions or Event Actions. 

Procedure 12 Select an Object 

Step Action 

1 Select 

2 

3 

4 

0 Object Selector displays. 

Select the object type from the Type column. Object column will be filtered based on type. 

Select object from the Object column. 

Select OK. 

- End - 

Cycle Active Tool Windows and Files 

For easy navigation between open victor tabs, you can cycle between active tool windows and files. 

Hold CTRL and Press Tab to open a dialog displaying active Windows and files. Cycle the active items by pressing 
Tab until the required item has focus in the dialog. 

Release CTRL to focus on the required item. 
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Device List 

Introduction 
The Device list provides a means of displaying and controlling all hardware configured in the system in a single 
window. It is primarily used to interact with system hardware via object icon's context menus. 

Display/Navigate Device List 
The Device list displays a tree view of all hardware devices configured on the system which are available to the 
current user. 

Use Icons to filter 
by device type 
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Procedure 13 Display/Navigate Device List 

tep Action 

1 Select the Devices List tab. The device list displays. 

2 Use Object Icons to filter view and Context menus to interact. 

- End - 
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Recorder/Camera Configuration 

Recorders Introduction 
Recorders can be added to the system manually or multiple recorders may be added using the Recorder Import 
function. Recorders can be added from Local Area Networks (LANs) or from across Wide area Networks (WANs) 

victor can also be configured to auto-discover VideoEdge recorders. As and when new VideoEdge recorders are added 
to the network, victor automatically detects them and prompts the user to add them to the system. 

Supported Recorders 

Note: 
In order to avail of all victor functionality, you may be required to update your recorder its latest software version. 

Recorder Type Supported Version 

Intellex 3.2+ 

Intellex IP 3.2+ 

VideoEdge NVR 4.2+ 

VideoEdge Hybrid Appliance 4.21+ 

VideoEdge Micro Recorder 4.5.1+ 

American Dynamics HDVR/exacqVision 1.5+ 

American Dynamics TVR 2.2, 2.5,2.6 

ADT Matrix (victor 4.6+) All models 

A Caution 
Ensure time is synchronized between client machines and network recorders. Recorders which are out of time 
synchronization with client machines cause incorrect video retrieval. It is recommended that an NTP server is used to 
synchronize machines. 

Maximum Recorder Restrictions 
Recorders are restricted depending on your version of victor, the table below indicates the maximum number of 
recorder types which can be added to victor Express and victor Professional. 

Recorder 
Type 

Temporary License Permanent License 

victor 
Express 

victor 
Professional 

victor 
Express victor Professional 

Intellex 100 Unlimited 100 Unlimited 
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Recorder 
Type 

Temporary License Permanent License 

victor 
Express 

victor 
Professional 

victor 
Express victor Professional 

VideoEdge 30 Unlimited 30 Unlimited 

HDVR / Exacg Not Applicable Unlimited Not Applicable Unlimited 

TVR Not Applicable Unlimited Not Applicable Unlimited 

Any 3rd Party Not Applicable Not Applicable Not Applicable Variable depending on type of 3rd Party

Note - On a unified system no recorder count limits are applied 

Add new Recorder (LAN) 
You can add supported LAN recorders to the victor Application Server. 

Procedure 14 Add new Recorder 

step Action 

1 Select Recorders from the Setup Tab. 

2 Select New from the dropdown menu. Recorder editor displays. 

3 Enter the IP Address/Domain Name of the recorder. 

Note: 
1. If adding a VideoEdge NVR 4.4+ recorder with failover set up, enter the virtual IP address of the 
recorder. It is also recommended that the secondary (failover) NVR 4.4+ recorder is added to victor 
separately using its static IP address to ensure that all alerts are received. 
2. If using a domain name, then it is recommended that a DNS server is used to allow both the client 
and the victor Application Server to resolve the device name. It is not recommended to use local host 
files to resolve device names. 

4 Enter the Communication Port. This can be left blank of default ports have not been changed. 

5 Enter the User Name, if required. 

6 Enter the Password, if required. 

Note: 
1. A Usemame and Password is required when adding VideoEdge NVR units. 
2. If adding Intellex 5 recorders with Remote Access Authorization enabled, a Usemame and 
Password is required. 
3. It is recommended that an Administrator account is used when adding Recorders to ensure that 
full access is available via the client. 

7 [Optional] Enter the Communication Port.(Port used for HTTPS streaming) 

8 [Optional] Select the Secure Connection checkbox to enable HTTPS communication (VideoEdge NVR 
only). 

Note: 
1. SSL certificates can be created on VideoEdge 4.5+ recorders. These can then be installed on 
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victor client and victorApplication Server machines when adding HTTPS enabled recorders. 
2. If using HTTPS, the communication port should match the secure port defined on the VideoEdge 
NVR being added. 

9 Select Save. 

- End - 
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Add new Recorder (WAN) 
You can add supported WAN recorders to the victor Application Server. 

Procedure 15 Add new Recorder (WAN) 

tep Action 

1 Select Recorders from the Setup Tab. 

2 Select New from the dropdown menu. 

3 Enter the IP Address/Domain Name of the recorder. 

Note: 
1. If adding a VideoEdge NVR 4.4+ recorder with failover set up, enter the virtual IP address of the 
recorder. It is also recommended that the secondary (failover) NVR 4.4+ recorder is added to victor 
separately using its static IP address to ensure that all alerts are received. 
2. If using a domain name, it is recommended that a DNS server is used to allow both the client and 
the victor Application Server to resolve the device name. It is NOT recommended to use local host 
files to resolve device names. Enter the Communication Port (leave blank if default ports have not 
been changed). 

4 Enter the User Name, if required. 

5 Enter the Password, if required. 

Note: 
1. A Usemame and Password is required when adding VideoEdge NVR units. 
2. If adding Intellex 5 recorders with Remote Access Authorization enabled, a Usemame and 
Password is required. 
3. It is recommended that an Administrator account is used when adding Recorders to ensure that 
full access is available via the client. 

6 Enter the Streaming Port, if required. 

7 Expand the WAN Configuration section. 

8 Enter the Enter the IP Address/Domain Name of the recorder. 

9 [Optional] Enter the Communication Port.(Port used for HTTPS streaming). 

10 Enter the Streaming Port. 

11 [Optional] Select the Secure Connection checkbox to enable HTTPS communication (VideoEdge NVR 
only). 

Note: 
1. For secure connections, SSL certificates can be created on VideoEdge 4.5+ recorders. These can 
then be installed on victor client and victor Application Server machines when adding HTTPS 
enabled recorders. 
2. If using HTTPS, the communication port should match the secure port defined on the VideoEdge 
NVR being added. 

12 Select Save. 

• End - 
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Add new Recorder via Dynamic View 
A new recorder can be added directly from the recorders dynamic view. 

Procedure 16 Add new Recorder via Dynamic View 

tep Action 

1 Select Recorders from the Setup Tab. 

2 Select Show All. 

3 Select fUtf the Recorder editor displays. 

4 Refer to "Add new Recorder (LAN)" or "Add new Recorder (WAN)" for details on how to add the recorder. 

- End - 

Add Multiple Recorders 
You can add multiple recorders simultaneously using the Import Recorders function. This feature enables you to 
import recorder information (Minimum IP Address/Hostname) using information previously entered into a .txt or .csv 
file. See example below: 

r recordersArt - Notepad 

ft  Colt Ramat eat eleb 
192.168.188.41. . • admin. actnin. 
192.168.188.2 
192.168.188.50 
192.168.188.55 
63_Car par k 
1.13j.St_Fi0Or 
113_211d_f 100r 
192.168.188.56 
192.168.188.33 
192.168.188.52 
192.168.188.91 
192.168.188.77 
192.168.188.62 
192.168.188.28. . .adwIn.achin. 

Note: 
1. Lists are not case sensitive. 
2. Each Recorder must have a separate row on the list. 

Procedure 17 Add Multiple Recorders 

tep Action 

1 Create a .txt or .csv file, listing at a minimum the IP Addresses or Hostnames of each recorder to be impor-
ted. Create each new entry on a new line. Additional field information may be entered, separate information 
relating to each field with a comma. 
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.LAN Streaming Port 
IP AddressiDorneln Name (WAN) 
WAN Streaming Port 
WAN Communcabon Port 
WAN Seats Communication Pal 

2 Save the .txt or .csv file. 

3 Select Recorders from the Setup Tab. 

4 Select Import Recorders from the dropdown menu. Please select a file to import dialog displays. 

5 Navigate to the saved file. 

6 Select Open. Reading Recorders file dialog displays informing of progress. When complete, imported 
recorders display in device list. 

7 Select Close on the Reading Recorders file dialog. 

- End - 

Edit Recorders 
You can edit properties of existing recorders. 

Procedure 18 Edit Recorders 

Step Action 

1 Select Recorders from the Setup Tab. 

2 Select Show All. All recorders are listed. 

3 Right Click on the recorder to be edited. 

4 Select Edit. The Recorder editor displays. 

5 Make edits as required. 

Note: 
Properties which can be edited vary depending upon recorder type. 

6 Select Save. 

- End - 

Configure VideoEdge NVR 
victor client supports full configuration of VideoEdge NVR (4.2+). 

Procedure 19 Configure VideoEdge NVR 

Step Action 
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1 Select Recorders from the Setup Tab. 

2 Select Show All. All available recorders are listed. 

3 Right Click the recorder to be configured. 

4 Select Configure. The recorder's configuration page opens. 

5 Refer to the recorder's User/Administrator guide for configuration help. 

- End - 
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Device Discovery (Recorders) 
The Device Discovery tool can be used to discover American Dynamics recorders (and associated cameras) on the 
victor network. 

Note: 
Various network/security settings may affect this feature's functionality and performance. Should you encounter any 
problems relating to device discovery on your system, you should attempt to resolve them with your IT department 
prior to contacting American Dynamics technical support. 

System level device discovery settings are configured in System Values>Discovery Preferences. Here you can set 
separate preferences for each supported recorder type. 

Discovery mode is initiated by selecting Device Discovery on the Setup tab which displays the Device Discovery 
window. 

The Device Discovery window comprises two panes; one for discovered recorders (upper) and one for associated 
discovered cameras (lower). 
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Add/Ignore devices 
You can add discovered devices to victor by dragging and dropping directly from the device discovery window into 
victors device list. Alternatively you can use 'batch' actions by selecting checkboxes next to discovered devices and 

using 0 and § to add or ignore devices. 
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VideoEdge Recorders 

victor provides an auto-discovery service which can be used to detect newly added VideoEdge recorders. Newly 
discovered recorders can be added to victor by dragging and dropping from the client's discovered list. 

Recorders discovered in the last 24 hours are labeled as New 

Cameras 

The client displays a list of auto-discovered cameras which have not yet been associated with an NVR. Discovered 
cameras can be dragged from the discovered list directly into their respective NVR in the device list. 

Note: 
Newly discovered Illustra cameras can be assigned IP addresses directly from the discovered list, individually or as a 
batch. 

Remove Cameras 

VideoEdge cameras can be removed from NVRs. Removed cameras are automatically placed back on the discovered 
list. 

Change Camera IP Address (American Dynamics cameras only) 

You can change the IP address of American Dynamics cameras from the camera discovered pane using to 
access the Camera Address Configuration dialog. 

Use this dialog to define the IP address range to be assigned to selected cameras and to define Network Configuration 
settings. 

Note: 
The NVR will attempt to set the IP address on as many cameras as possible and will not stop assigning IP addresses 
in the event of a failure.ln the event of failure, gaps of unassigned IP addresses in the requested starUend IP address 
range may occur. 
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Recorders - General 

Alarm Persistence 
VideoEdge NVR constantly caches alarms from the previous 2 weeks data. This means if an NVR loses connection 
to the victor Application Server, alarms are resent upon reconnection in Recovery Mode. 

Upon Reconnection, notification is sent to victor that Alarm recovery is in progress and also informs whether it has 
been successful. 

Users must run a Video Alarm report to access the alarms triggered during the lost connection. 

Alarm Persistence can be disabled from the Server Configuration Application. 

Procedure 20 Disable Alarm Persistence 

Step Action 

1 Right Click the Server Configuration Application on the desktop 

2 Select Run as Administrator. Application opens 

3 Select the Settings Tab 

4 Select Skip Recovered Events Checkbox in the Application Settings section 

Note: 
If the status of the Skip Recovered Events is changed while the VideoEdge Driver service is 
running, it must be stopped and restarted before changes take effect. 

- End - 

Change Bandwidth Configuration Settings 
Current bandwidth and CPU usage is displayed on the status bar. 

You can configure bandwidth settings to reflect the capabilities of your network. 

Bandwidth is selected from a list of network types which define a maximum bit-rate value to be received from video 
servers. 

The client allocates a bandwidth limit to each individual active stream by intelligently distributing the total bandwidth 
limit associated with the chosen network type. 

The ability to change bandwidth type is based on the role allocated to the active user. 

Note: 
Bandwidth throttling may degrade video quality. 

Procedure 21 Change Bandwidth Configuration Settings 

btep Action 

1 Select the current Bandwidth Configuration from the Status Bar. Bandwidth settings display as a popup 
menu. 

2 Select the required Bandwidth Setting. 

The selected Bandwidth cap is applied and will display on the taskbar. 
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Note: 

1. When Bandwidth throttling is being applied, the symbol displays on the video stream for 5 seconds. 

2. When a stream has stopped due to client bandwidth configuration, the A symbol displays. 

- End - 

Virtual Private Network (VPN) 
When using a VPN connection, selecting the VPN option from the victor Status Bar changes two settings for 
VideoEdge: 

• The VideoEdge will obey the WAN Bitrate Cap set in its Network>General menu. 

• Stream communication is carried out in TCP mode (default is UDP). 
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Cameras Introduction 
After adding recorders, their associated cameras are automatically available to view and configure. Names and 
descriptions of cameras can be edited and alerts can be assigned to cameras from the client. Other camera attributes 
can generally be viewed but not edited. 

Edit Cameras 

Camera Names and Descriptions can be edited, and Alerts and Associations can be assigned. 

Procedure 22 Edit Cameras 

Step Action 

1 Select the Device List tab. The Device list displays. 

2 Navigate to the camera to be edited. 

3 Right click on the camera. 

4 Select Edit. Camera Editor displays. 

5 Expand the General Section. 

a Edit the name, if required in the Name textbox. 

Note: 
1. Selecting the Use same name as recorder checkbox changes the name of the camera in the 
client to that used in the recorder 
2. Deselecting Use same name as recorder checkbox offers the option to use a custom name 
which is used in the client only (recorder retains the original name) 
3. Camera names are restricted to 255 characters maximum. 

b Enter/Change the description, if required in the Description textbox. 

c Select the Enabled checkbox to enable or deselect to disable. Default is enabled. 

6 Expand the Associations section. You can use the Object selector to associate a camera with up to 5 
objects. 

7 Expand the Status section. This gives an overview of Alert and Storage status of the camera. 

8 Expand the Face Recognition section. You can adjust the values in the "Search Before Seconds" and 
"Search After Seconds" to take into account unsynchronized time between victor and recorder when carrying 
out a face recognition search. 

9 Select Save. 

- End - 

Reset Camera Names 

When a camera name is changed within the client, it can be reset back to the original name assigned at the recorder. 

Procedure 23 Reset Camera Name 

Step Action 

1 Select the Device List tab. The Device List displays. 
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2 Navigate to the camera to be reset. 

3 Right Click the camera. 

4 Select Reset Name. Name reverts to original. 

Note: 
All Camera names can be reset from the Setup Tab by selecting Reset All Name(s) under the 
Cameras Icon 

- End - 
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Surveillance and Playback Controls 

Introduction 
Surveillance allows users to view live video from recording devices. Video can be viewed by dragging cameras from 
the device list into surveillance panes or by using Call ups to display video from existing Tours and Salvos. 

victors video Playback Controls provide all the standard VCR operations as well as Jump forward, and Back by 
intervals and Date Selection options.. 

Dal 
Playback 

Jump 
Backward 

Toggle Jump Forward 
Play/Pause 

/ 

141:19191910JA- - 
I \ 

Select 
Date 

Play Forward 
Reverse (Fast) Play in 

Forw
Play Fast 

ard Reverse 

Note: 
1. Audio is disabled when in Playback mode unless the video stream is running at X1 forward. Only one source can be 
running at a time. For example, enabling audio on camera 2 will disable it on camera 
2. Live and streaming audio is unavailable on Intellex playback, it is only available on downloaded clips. 

3. To enable audio when playing back retrieved video, select on the surveillance pane. 
4. During playback, if there are gaps in the recorded video stream, Intellex will skip to the next available video. 
VideoEdge NVR will return blank frames at the requested framerate across the gap in recording. 
5. Instant Playback and Audio is not supported on HDVR units. 

Instant Playback 
When in Live mode, you can switch to Instant Playback mode, enabling user control of recorded video streams. 
Instant playback is supported on VideoEdge and Intellex 4.2+ recorders. 

Procedure 24 Switch between Live Video and Instant Playback 

Step Action 

1 From Live video mode, select a video pane. (Select multiple panes by clicking on more than one) The Play-
back controls become active. 

Note: 
When a surveillance pane is selected, a border displays around the pane: 
Yellow Dashed - Instant Playback is available 
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Yellow Solid - Video stream is in instant playback mode 
Blue Flashing - Instant Playback is not available on the selected stream 

2 Select the required function from playback controls. The selected pane(s) enter playback mode. 

3 Navigate video stream(s) as required. 

4 Select Exit Instant Playback to exit to revert to Live Video. 

- End - 

Mouse Control 
Depending on the current surveillance mode, the mouse can be used to navigate video streams and Pan, Tilt and 
Zoom cameras: 

• In playback mode you can instantly toggle between X1 forward and X1 reverse by scrolling up or down 

• In Live and Playback modes, you can use the scroll wheel to Zoom by clicking and scrolling the wheel 

• In Live and Playback modes, you can use the mouse for Pan and Tilt operation by locating the cursor 

centrally and clicking and dragging when the V symbol displays 

• In Paused mode, the mouse can be used to step forward and back frame by frame. 

Timeline Control 

Overview 
Selected media streams can be navigated using the timeline control, allowing you to: 

• Determine existence of recorded media 

• Navigate recorded media 

• View Events 

• View Preview Frames 

• Bookmark clips to Save and Export 

The Timeline control is accessible from any surveillance view using the button. Each media stream displayed in 
the surveillance windows displays as a corresponding data stream bar in the timeline control. 

The following provides details on timeline functionality. 

Timeline bar 

The Timeline bar is a navigation control divided into years, months, days, hours, minutes and seconds depending on 
the zoom level selected. A vertical bar in the centre of the timeline represents the current time. 

The visible time span can be increased by scrolling the mouse wheel back and decreased by scrolling mouse wheel 
forward. By clicking and dragging you can move the timeline bar to display video from the selected time and date. 
Using the quick zoom button allows you to quickly display by year, month, week, day, hour or minute. 
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Data Stream Bars 

One or more data stream bars can be displayed per control, each relating to the date/time data of specific media 
streams. Enabled Data Stream bars are constantly synchronized with the time in the timebar. These streams display 
a time orientated view of when events of selected type triggered. 

Bars can be overlaid on top of each other for example, a video steam can be overlaid on top of an audio stream, each 
overlaid by an event stream, giving a fuller, synchronized overview helping incident management capability. The data 
stream bars are contained in a vertically scrollable window into which you can drag, drop or remove streams as 
required. 

A toggle button to the left of the window allows you to enable/disable streams. Data bars that are disabled are blurred 
and will not be subject to any timeline control operations by default all data bars are disabled. Select the data bar name 
or the toggle data bar to enable the stream. You can change the label of the button as required for easier recognition of 
streams. 

Clicking any point on the data stream bar will display a popup window which has information about the values of the 
selected point. For example, a still image will display showing the current frame at that point in time. If an event is 
selected details will be displayed allowing the user to acknowledge or clear the event. 

Playhead 

The playhead allows the data stream to be played, paused, forwarded or rewound. When forward or rewind is selected 
the speed is determined by how far you move the mouse from the playhead. Speeds or lx, 2x, 4x, 8, or 16x are 
available for forward while rewind has -1x, -2x, -4x, -8x or -16x. 

Pause 

Rewind —  -AP — Forward 
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A Marker bar allows you to mark off specific sections of the stream for export or to bookmark. Markers set using the 
Marker bar apply to all 'enabled Data Stream bars in the Timeline control. Multiple markers can be set. 

Each marker is represented by an icon and after marking, these sections are highlighted to distinguish them from 
unmarked areas. 
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The calendar icon will display a calendar control that allows a specific date and time to be selected. 
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When the filter icon is selected the Display Filter dialog will display. This can be used to enable or disable the stream 
information displayed. 

Expand for further options 

Year Month Week Day (Hour) Minute it,D 

Display Filter 
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Search Result Event 
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Using the Timeline Control 
The following procedures provide information on how to use the various features of the timeline bar. 

Using the Timeline bar for Basic Navigation 

Procedure 25 Use the Timeline bar for basic navigation 

Step Action 

1 From Live video mode, select the required video feeds to display. 

2 Select the button. The timeline bar will display. 

3 Select the data stream bars name to enable or disable them as required. 

Note: 
All data stream bars are disabled by default. 

4 Navigate the timeline as required. 

5 Select GO LIVE to return to the live image. 

6 Select the button to hide the timeline bar. 

- End - 

Using the Timeline bar to Export a Clip 

Procedure 26 Use the Timeline bar to export a clip 

btep Action 

1 From Live video mode, select the required video feeds to display. 

2 Select the button. The timeline bar will display. 

3 Select the data stream bars name to enable or disable them as required. 

Note: 
All data stream bars are disabled by default. 

4 Navigate the timeline as required. 

5 Left click on the marker bar to set the starting position for the clip. 

6 Move to the end point for the clip and left click. 

7 
44 X 

will display. 

8 Select - • The Direct Clip Action window will display. 
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9 Select the required option: 

• Archive 

• Vault 

• Save 

• Export 

- End - 

Using the Timeline bar to Create a Bookmark 
Create bookmarks of clips. 

Note: 
Bookmarks are only retained while the timeline control is open. If the timeline control is closed bookmarks created will 
be lost. To export bookmarks once created refer to "Export Bookmarks from the Timeline". 

Procedure 27 Use the Timeline bar to create a bookmark 

step Action 

1 From Live video mode, select the required video feeds to display. 

2 Select the button. The timeline bar will display. 

3 Select the data stream bars name to enable or disable them as required. 

Note: 
All data stream bars are disabled by default. 

4 Navigate the timeline as required. 

5 Left click on the marker bar to set the starting position for the clip. 

6 Move to the end point for the clip and left click. 

7 will display. 

8 Select Add selected region window will display. 

9 Enter a Name for the bookmark in the text box. 

10 Select the required Camera from the drop down list. 

11 Select OK. The bookmark will now be displayed on the timeline. 

- End - 

Export Bookmarks from the Timeline 
Once bookmark/s have been created they can be exported and saved. 
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Note: 
Bookmarks are only retained while the timeline control is open. If the timeline control is closed all bookmarks will be 
lost. 

Procedure 28 Export saved bookmarks from the timeline 

Step Action 

1 Follow "Using the Timeline bar to Create a Bookmark" to create the bookmarlds. 

2 Select to display all available bookmarks. The Selected regions window will display. 

3 Select a bookmark/s from the list to mark it for export. Double-click to view the bookmark. 

4 Select . The Direct Clip Action window will display. 

5 Select the required option: 

• Archive 

• Vault 

• Save 

• Export 

- End - 
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Clear all pane selections 
When multiple panes are selected, you can quickly deselect them all with one action. 

Procedure 29 Clear all pane selections 

tep Action 

1 Right click a selected video pane. Context menu displays. 

2 Select Clear all pane selections. Borders are removed indicating they are no longer selected. 

- End - 

PTZ Control 
When viewing a video stream, Pan, Tilt and Zoom (PTZ) control is available using an on screen display (OSD) control. 

There are 2 types of PTZ command that the client will determine to use, depending on camera type: 

Real PTZ 

This can be used on live video streams to control supported dome cameras. 

Virtual PTZ 

This type is used with fixed cameras for live and recorded video. Virtual PTZ is achieved by capturing a specific area 
of the camera's view, cropping a smaller area and zooming that to a larger view. 

View video from all cameras on a recorder 
You can view live video from all cameras connected to a single recorder. 

Note: 
The maximum number of supported live video feeds is 16 H.264 @ 30 ips 

Procedure 30 View video from all cameras on a recorder 

tep Action 

1 Select the Device List tab. The device list displays. 

2 Select r next to recorders to expand the selection. 

3 Select r next to the recorders folder to expand the selection. 

4 Right click the recorder. 

5 Select View. A new surveillance tab opens displaying all available video streams. 

- End - 
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Display video from selected cameras 
As well as displaying all available video from a recorder, you can select specific cameras to view in the surveillance 
window. 

Procedure 31 Display video from selected cameras 

tep Action 

1 Select Surveillance from the Home tab. 

2 Selected appropriate Video Pane layout using the layout selector icon . Default view is 1X1. 

Note: 
You can configure which video layouts are available from System Values > Video Layout 
Preferences 

3 Select Devices from the Home tab. The device list window displays. 

4 Select I next to recorders to expand the selection. 

5 Expand recorders as required. Camera icons display. 

6 Drag and drop camera(s) from the device list into the surveillance pane(s). 

- End - 
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Change Surveillance Overlay Settings 
Video Overlay settings can be enabled or disabled within the video window. 
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Video overlays can be displayed or hidden as required: 

• Display Grid 

• Camera, Recorder, Names and Time 

• Dome Control 

• Region of Interest 

• Audio 

Note: 
Changes to overlay options affects the whole window in which the changes are made. Overlay options cannot be set 
for individual panes. 

Procedure 32 Change Surveillance Overlay Settings 

tep Action 

1 Select Surveillance from the Home Tab. The surveillance window displays. 

2 Right Click in the surveillance window. 

3 Select Overlay. 

4 Select or Deselect options overlay as required. 

Note: 
Dome Control overlay must be enabled to allow camera control from within specific panes. 

- End - 
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Using Virtual Controls (PTZ) 
You can use Virtual controls to crop and magnify the view of fixed cameras (virtual Zoom). Virtual controls also allows 
users to move and set Picture in Picture views and to set virtual presets. 

Note: 
Virtual Control overlay must be enabled to allow camera control from within specific panes. 

Procedure 33 Using Virtual Controls 

tep Action 

1 Select Surveillance from the Home Tab. 

2 Select the Camera Control symbol 0 within the video pane of the fixed camera you want to control. Virtual 
PTZ controls display. 

3 Use the controls by selecting the areas of the controls as required. When in use, a picture in picture view is 
displayed in the main video pane. Use the Move Picture in Picture icon to reposition the view. 

Note: 
Picture in Picture behavior can be configured in System Values > Surveillance Preferences 

4 Select Close to close the controls. 

- End - 
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Virtual Controls (Presets) 
You can set virtual presets on a fixed camera. This allows you to view multiple areas of interest quickly without the 
need to manually control the camera's PTZ. 

Note: 
The maximum number of presets that can be configured is 255 

Procedure 34 Virtual Presets (Presets) 

tep Action 

1 Select the Camera Control symbol * within the video pane. 

2 Use Virtual PTZ to display the view to be added as a preset. 

3 Select Preset It Preset controls display. 

4 Select next sequential preset number from the dropdown. 

5 Select to add preset. 

6 Select to exit back to PTZ controls. 

7 Repeat as required for further presets. 

Note: 

To view presets, select the preset number and click Go to Preset. 

- End - 
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Dome Camera Controls 
Where available, you can use real Pan Tilt and Zoom controls from within the client surveillance windows. 

Procedure 35 Dome Camera Controls 

tep Action 

1 Select Surveillance form the Home tab. The surveillance window displays. 

2 Select g  within the video pane of the dome camera to be controlled. Dome Controls display. 

3 Use the controls by selecting the areas of the controls as required. 

Note: 
Depending upon the type of dome and recorder being used, the available controls may vary. For 
example, the sequence function is not available when using I ntellex. 

- End - 

Mouse Control 
Depending on the current surveillance mode, the mouse can be used to navigate video streams and Pan, Tilt and 
Zoom cameras: 

• In playback mode you can instantly toggle between X1 forward and X1 reverse by scrolling up or down 

• In Live and Playback modes, you can use the scroll wheel to Zoom by clicking and scrolling the wheel 

• In Live and Playback modes, you can use the mouse for Pan and Tilt operation by locating the cursor 

centrally and clicking and dragging when the" symbol displays 

• In Paused mode, the mouse can be used to step forward and back frame by frame. 

• In Live and Playback modes, holding down the mouse wheel while scrolling zooms the camera view in 
or out (Both in vPTZ or Real Dome control) 
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Clear Video 
You can clear video from surveillance windows and panes. 

Procedure 36 Clear Video 

tep Action 

1 Right Click on the Surveillance Pane 

2 Select Clear. Then select from: 

a Clear Video -To clear video from that pane only 

b Clear All Videos -To Clear video from all panes within the window 

c Clear all Pane Selections - To clear all selected panes 

d Clear Region of Interest 

- End - 

Change Video Layout 
Video Layouts can be changed to accommodate different video pane configurations. The video layouts available from 
the surveillance window can be controlled from System Values. 

Procedure 37 Change Video Layout 

tep Action 

1 Select Surveillance from the Home tab. Surveillance window displays. 

2 Select . A list of available layouts displays. The Layouts are split into sections: 

• Standard 

• Widescreen 

• Portrait 

3 Select Layout as required. Video window switches to the selected configuration. 

Note: 
When changing layouts, the three most recently used layouts are displayed in a recently used list 
next to the pulldown list for convenient retrieval. 

- End - 
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Still Image Capture 
You can capture all or part of a paused video stream as a still image in .bmp or .jpg format. After capture, various 
options are available including Save, Email, Print or Copy to clipboard. You can also launch a third party application for 
image editing. 

Still Image capture is available from any surveillance mode, the method for capture is identical in all modes. 

Procedure 38 Still Image Capture 

tep Action 

1 Right Click the surveillance pane. 

2 Select Still Image. A new floating window displays with the following options available: 

• Select 'SI' to browse to a storage location and Save the still image 

• Select   to Email the still image (Requires Email to be configured in System Values) 

is  

• Select I  / 1  I to open the image in a third party application (Requires third party application 
to be configured in System values) 

• Select I   —! to copy the image to clipboard 

• Select -11"-I to print still image (Requires Windows Printer to be configured) 

- End - 

Fisheye Cameras 
Fisheye cameras use very wide angle lenses to capture hemispherical images - 180° panoramic view (wall mount) or 
360° surround view (ceiling/floor/wall mount) without blind spots. 

victor allows hemispherical images captured from fisheye cameras to be converted into conventional rectilinear or 
panoramic projections for viewing and analysis. This process is known as De-Warping. 

De-Warping 
The option to De-warp is available via the context menu of supported fisheye camera views. This can be done in 
Playback and Live modes as well as from within victor Player. It is also available in Video Search Results player and 
Investigator windows. 

It is worth noting that sending an image to another display or InstantView etc. will open the Fisheye camera in 
whichever view is set by default in Setup -System Values- Video Preferences. 

Note: 
Exported video can be de-warped within victor player but if exported footage is played back in alternative players, 
there is no option to de-warp the video. 

De-Warping preferences are available in System Values. Here you can configure the default de-warp mode from the 
following: 
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Warped View Default View from a fisheye camera displaying a 
hemispherical image with barrel distortion. 

Rectilinear View 
De-Warped view of a fisheye stream. This view is 
designed to display a section of the fisheye view 
with minimal barrel distortion. 

Panoramic View 
De-Warped view of a fisheye stream. This view is 
designed to display the full fisheye view in a single 
elongated pane. 

Recorders can also offer the option of selecting a default camera mounting for fisheye cameras, this is applicable to 
VideoEdge NVR 4.4+ and HDVR/exacqVision only. 

Procedure 39 Warp/De-Warp images 

Step Action 

1 Right Click a video stream from a fisheye camera. 

2 Select De-Warp Options De-warping options display. 

3 Select from: 

• Warped - Maintains Fisheye view 

• Rectilinear 

• Panoramic 

Note: 
It is important to select the appropriate mounting option. Each option uses a different algorithm, 
designed to give optimal de-warped views depending on camera orientation. 

- End - 

Fisheye Camera Controls (Warped) 
Fisheye camera views have various click and drag OSD controls you can use to manipulate camera views. 

Note: 
Virtual presets created on a Fisheye camera will also store the warped or de-warped view which was being viewed at 
the time of creation 

Warped View Mouse Control 

in warped views, pressing Shift displays a target box on screen. This box can be moved by dragging the mouse 
around the warped view. Clicking the mouse on a particular area displays a new rectilinear (de-warped) view of that 
area. 

Rectilinear View Mouse Control 

In Rectilinear views, hovering the mouse in the centre of the view displays a 14° symbol. You can Click and Drag the 
symbol in any direction to effectively enable Pan and Tilt control. (PTZ control must be open) 

Panoramic View Mouse Control 
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In Panoramic views, similar to Rectilinear, you can use .'to Pan and Tilt the camera view. (Zoom mode only) 
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InstantView 
InstantView enables users to view video in instant playback (paused) mode alongside the live view. 

You can launch instant playback from any surveillance view from the video context menu or by selecting the 
InstantView Icon. 

Procedure 40 Launch InstantView 

step Action 

1 From Live video mode, select a video pane. Selected pane highlights dashed yellow. 

2 Select ° Dropdown menu displays. 

3 Select from: 

• Side By Side - to open the new paused view beside the live view 

• Send To - to send the paused view to a separate display 

- End - 

Audio Devices 

General 
Audio devices are exposed in victor client only via VideoEdge 4.4+ NVRs where all audio object settings are 
configured. Refer to VideoEdge User Manual for more details. 

Within victor, audio devices generally mirror the behavior of cameras; they are standard victor hardware objects which 
are displayed as child objects of NVRs and can be interacted with via the device list. 

Audio device editor 
As with cameras, victors Audio device editor allows you to add alerts and associations, assign descriptions and 
rename devices. Associating devices within victor client pushes the changes back to the NVR only if the new 
association is with an object within that NVR. 

Search and Retrieve 
You can drag audio devices into the Search and Retrieve object selection alongside cameras to return audio and video 
streams which are not necessarily associated outside of the wizard. 

You can also perform Search and Retrieve on audio devices only, this return audio only streams for the parameters 
selected. 
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Audio Associations 

General 

Audio associations are limited to one per device. each association made in victor client is automatically replicated on 
the NVR, likewise each association made on NVR is mirrored within victor (when the audio device and camera are 
connected to the same recorder). 

If multiple audio associations are attempted, only the first selected will be added, the other selections are ignored. 

Clip Export and Retrieval 

There are some considerations which should be noted concerning clip export and audio associations: 

Clips with default audio 

Clip and audio are exported together and playback as separate streams within a single clip 

Clips with default audio and audio associations 

Clip and default audio are exported as a single clip, the associated audio is exported as a separate clip 
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Call Up Configuration 

Introduction 
'Call up' is the collective name for Tours, Salvos and Saved Views. 

Tours 
A tour is a collection of different camera views, displayed in predefined sequences for specified durations. 

Salvos 
A Salvo is a display of multiple, simultaneous video streams which provides an effective way to monitor multiple areas 
of interest. 

Saved Views 
A Saved View is a standard Salvo which is associated with a specific video layout E.G Guard layout. 

View Switch 
A View Switch is collection of Saved Views, switching between each Saved View after a specified time. 

Create Tours 
You can define criteria for a new tour and add it to the system. 

Procedure 41 Create Tours 

tep Action 

1 Select Tours from the Build tab. 

2 Select New from the dropdown menu. 

3 Enter a Name for the tour in the Name textbox. 

4 Enter a description for the tour in the Description textbox. 

5 The Enabled checkbox is selected by default. To deactivate the tour, deselect the checkbox. 

6 If required change the Default dwell time in the Defaults section. This is the dwell time used for each 
camera added. 

Note: 
Dwell times may be changed for individual cameras within a tour by changing the dwell time in the 
Tour section. 
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7 Select the tab in which the cameras to be added are located. 

Note: 
Cameras can be added from the Device list, the Site list or from dynamic views of recorders or 
cameras. 

8 Select the camera to be added. 

9 Drag the camera to be added into the Tour section of the page. 

10 Repeat steps 8-9 as required. 

11 Modify dwell times as required for individual cameras by double clicking the dwell value and changing it. 

Note: 
Presets and Patterns are only available to add if they are already configured on the Recorder. They 
cannot be configured via the client. If available, they can be added by selecting them from the Pattern 
or Preset textboxes and selecting from the dropdown list. 

12 If required, use L  to remove items from the camera list. 

13 If required, use and t to change the step position of cameras. 

14 Click NI)or fra)
- End - 

Edit Tours 
You can edit the properties of existing tours. 

Procedure 42 Edit Tours 

Step Action 

1 Select Tours from the Build tab. 

2 Select Show all from the dropdown menu. 

3 Right Click the Tour to be edited. 

4 Select Edit. Tour editor displays. 

5 Edit Name and Description in the General section. 

6 The Enabled checkbox is selected by default., To deactivate the tour, clear the checkbox. 

7 If required change the Default dwell time in the Defaults section. This is the dwell time used for each 
camera added. 

8 Within the Tour section, use to remove cameras, and use and t to change the step position of 
cameras. 

9 Edit existing camera's attributes by changing Preset, Pattern or dwell settings for each camera. 

10 Add more cameras by dragging them from the Sites or Recorders list as required. 

11 Click ®or® 
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- End - 
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Create Salvos/Saved Views 
Tours, Cameras and Recorders can all be added to Salvos. Presets and Patterns may be assigned to cameras if they 
have already been defined on the recorder. 

Procedure 43 Create Salvo/Saved View 

tep Action 

1 Select Salvos from the Build tab. 

2 Select New from the dropdown menu. 

3 Enter a Name in the Name textbox. 

4 Enter a description in the Description textbox. 

5 The Enabled checkbox is selected by default, to deactivate the tour, deselect the checkbox. 

6 Select a Layout from the Layout dropdown if the Salvo is to be a Saved View. 

Note: 
1. The selected layout must contain enough video panes to accommodate the number of video 
streams you intend to add to the Salvo. 
2. Saved view can also be created directly from current surveillance views by selecting Save as 

Saved View M 

7 Navigate to the required objects to be added to the salvo. 

Note: 
Objects can be added to the salvo from the Device list, the Site list, or from dynamic views of 
recorders or cameras. 

8 Select and drag Recorders/Cameras/Tours into the right hand pane. 

9 If required, use to remove items from the camera list. 

10 If required, use 4. and t to change the step position of cameras. 

Note: 
Presets and Patterns are only available to add if they are already configured on the Recorder. They 
cannot be configured via the client. If available, they can be added by selecting them from the Pattern 
or Preset textboxes and selecting from the dropdown list. 

11 Change the default Pane number by selecting the Pane dropdown for each Camera/Tour. 

12 Click or ED 

- End - 
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Edit Salvos/Saved Views 
You can make various changes to salvos and Saved Views. They can be edited to change attributes including Name, 
Description, Dwell Times, Add/Remove objects and Layouts (Saved Views only). 

Procedure 44 Edit Salvos/Saved Views 

Step Action 

1 Select Salvos from the Build tab. 

2 Select Show All from the dropdown menu. 

3 Right click the Salvo/Saved view to be edited. 

4 Select Edit. The Salvos editor displays. 

5 Edit the Name and Description in the General Section. 

Note: 
The Enabled checkbox is selected by default, to deactivate the tour, deselect the checkbox. 

6 Edit Cameras and Layouts as required in the Salvo section. 

7 Click fm or 

- End - 

Create View Switch 
Saved Views can be added to a View Switch and displayed for a set time before displaying another Saved View. 

Procedure 45 Create View Switch 

Step Action 

1 Select View Switch from the Build tab. 

2 Select New from the dropdown menu. 

3 Enter a Name in the Name textbox. 

4 Enter a description in the Description textbox. 

5 The Enabled checkbox is selected by default, to deactivate the View Switch, deselect the checkbox. 

6 Enter a default dwell time in seconds in the Default Dwell field. This default value will be applied to all Saved 
Views added to the View Switch but can be edited for each individually. 

7 Navigate to the required Saved Views to be added to the View Switch. 

8 Select and drag Saved Views into the right hand pane. 

9 If required, use VI to remove items from the camera list. 

10 If required, use .1 and t to change the step position of cameras. 

11 If required, edit the dwell time for each Saved View by double clicking on the Dwell field and entering a value 
in seconds. 
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12 Click iMlorini 

- End - 

Edit View Switch 
A View Switch can be edited at any time. 

Procedure 46 Edit View Switch 

Step Action 

1 Select View Switch from the Build tab. 

2 Select Show All from the dropdown menu. 

3 Right click the View Switch to be edited. 

4 Select Edit. The View Switch editor displays. 

5 Edit the Name and Description in the General Section. 

Note: 
The Enabled checkbox is selected by default, to deactivate the View Switch, deselect the checkbox. 

6 Edit Saved Views and Dwell times as required in the View Switch section as required. 

7 Click ®or® 

- End - 

Launch Call ups 
Tours, Salvos and Saved views can be launched from any surveillance window. 

Procedure 47 Launch Call ups 

btep Action 

1 Right click on any surveillance window. 

2 Select Salvo/Saved View/TourNiew Switch as required. 

3 Select the required Call up. Call up displays. 

- End - 
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Search and Retrieve 

Introduction 
The Search and Retrieve feature allows users to search a recorder's stored video or metadata using time or motion 
criteria to filter results. Search results can be reviewed, vaulted, saved as clips, stored on the client workstation or 
exported to remote storage. 

A Caution 
Ensure time is synchronized between client machines and network recorders. Recorders which are out of time 
synchronization with client machines cause incorrect video retrieval. 

Supported Search Types 
All searches are performed using the Video Search and Retrieval Wizard. The wizard comprises of a maximum of 3 
screens, through which the user defines search criteria. 

Four main search types are supported: 

Basic Search 

Basic search covers the following options in the Type of Search dropdown menu: 

• Date and Time • Searches specific time ranges using only time related parameters. 

• Thumbnail Search -A date and time search which displays results as thumbnail images. 

All basic searches allow searching by date and time and enable the user to define the search period (Start and End 
Date/Time) and streams to retrieve (Video or Video and Audio). 

Thumbnail Search 

Thumbnail Searches display results in the form of 16 images representative of the selected time range. 

Selecting '+' on a single image opens a new set of thumbnails at an increased granularity with the time range 
determined by the timestamp of the thumbnails adjacent to the original '+' selected. 

Thumbnail search is supported on VideoEdge NVR 4.4+, Intellex and HDVR/exacqVision recorders only. 
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Motion Detection Search 
Motion detection search allows users to search for motion in a specific cameras field of view. This allows the user to 
skip directly to areas that may be of interest, rather than having to search through hours of video in order to search for a 
particular event. 

Note: 
1. Motion detection based searches and motion based alarms are handled differently within the client. Motion 
detection based searches are independent of motion alarm regions set up on a recorder. 
2. Motion detection based searches performed on VideoEdge NVR's do not search actual video footage, but rather 
metadata generated by the NVR. Search results are therefore dependent on the sensitivity level settings when the 
video was processed. If no motion metadata is generated for a particular time period, no results will be returned when 
searching on that time period. 
3. Motion detection searches performed on the client from Intellex units search actual video footage so results depend 
on sensitivity settings set in the client. 
4. Motion detection searches are not available on HDVR/exacqVision or ADTVR units. 
5. Edge based motion detection searches can be executed on supported American Dynamics Cameras. 

Video Intelligence Search 
Video Intelligence Search is supported on VideoEdge NVR 4.2+ recorders. This gives users the ability to detect, track 
and analyze moving objects using a variety of criteria. The Video Intelligence engine is licensable on a per-channel 
basis. 

Supported Video Intelligence searches are: 

• Object Detection 

• Direction 

• Linger 

• Enter 

• Exit 

• Abandoned/Removed 

• Dwell 

• Queue Length 

• Crowd Formation 

Edge Based Face Detection 
VideoEdge NVR recorders support edge based analytics, allowing Face Detection alarms and searches on supported 
American Dynamics Cameras. 

Using edge based analytics reduces the impact on the NVR's CPU resources. 

Server Based Face Detection / Face Recognition 
VideoEdge NVR 4.7+ recorders supports server based facial recognition and detection, allowing searches and alarms 
based on this analytic type when an appropriate license is applied. 

To execute a face recognition search users must be enrolled in the NVR's Face Enrollment database. 
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Text Stream Search 
victor text stream search provides a means of searching text from configured NVRs devices (V4.5+). 

Two types of text stream searches are supported: 

• Date and Time: Used to return all text values within a defined time period. 

• Advanced: Used to search for specific text values within defined parameters and filters set on the 
VideoEdge NVR and victor. 
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Perform Searches 

Perform a Basic Search 
You can use the Search and Retrieve Wizard to specify parameters in order to perform a Basic Search. Basic 
Searches only consider Time and Date parameters. 

Procedure 48 Perform a Basic Search 

Step Action 

1 Select Search and Retrieve from the Home tab. 

2 Select Execute Search Wizard. The Search and Retrieval Wizard launches. 

3 Select the search type required from the Type of Search drop down menu. Available options are: 

• Date and Time 

• Thumbnail Search 

• Motion Detection 

Note: 
On VideoEdge NVR 4.2+ recorders, available options will vary if Video Intelligence is enabled on the 
camera selected. Refer to Perform a Video Intelligence Search (Analytics). 

4 If required, select the Download Audio button to download associated audio stream(s). 

5 Drag and drop camera(s) from the Device, Site or Vault list onto the Camera Selector Pane. 

Note: 
If selecting cameras from the Vault List, Date and Time parameters are automatically populated. 

6 Specify Date and Time parameters in the Date and Time Pane. 

Note: 
Selecting Specific Range also allows selection of Time Filter options. Time Filter options can be 
used to specify a sub-set of time to search. For example, only search between 9am and 5pm. Select 
the Time Filter checkbox to enable. 

7 Select Next. The Confirmation screen displays. Confirm your search criteria are correct. Select Previous 
to return to the previous screen to make changes. Select Finish to execute the search. 

8 Search and Retrieval Wizard closes and the Date and Time Based Search Results tab opens displaying 
search results. Double click on a search result to view associated video 

- End - 

Perform a Thumbnail Search 
You can use the Search and Retrieval Wizard to search video footage and display results in Thumbnail view. 
Thumbnail search results are represented graphically as a series of snapshots representing the duration of the search 
period. 

Note: 
Thumbnail Search is available for VideoEdge NVR 4.4+, Intellex and HDVR/exacqVision recorders only. 
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Procedure 49 Perform a Thumbnail Search 

Step Action 

1 Select Search and Retrieve from the Home tab. 

2 Select Execute Search Wizard. The Search and Retrieval Wizard launches. 

3 Select Thumbnail Search from the Type of Search drop down menu. 

4 Drag and drop a camera from the Device, Site or Vault list onto the Camera Selector Pane. 

Note: 
If selecting a camera from the Vault List, Date and Time parameters are automatically populated. 

5 Specify Date and Time parameters in the Date and Time Pane. 

Note: 
Specific Time Filter options cannot be used with Thumbnail Search. 

6 Select Next. The Confirmation screen displays. Confirm your search criteria are correct. Select Previous 
to return to the previous screen to make changes. Select Finish to execute the search. 

7 Search and Retrieval Wizard closes and Video Thumbnail Search window opens displaying search result 
as 16 thumbnails 
Selecting a thumbnail image will zoom in the time period to create 16 new thumbnail images using the 
thumbnails adjacent to the (+) thumbnail as the time range for the next 16 images. Selecting a thumbnail will 
zoom out to the previous 16 thumbnails. 

Double clicking a thumbnail will open that section of video in Investigator Mode. 

Toolbar buttons, as outlined below, can also be used to manipulate thumbnail search results: 

I Save image - select a thumbnail then 
select this button to save the image 

Email image - select a thumbnail 
then select this button to email the 
image 

.• 1 

Open in third party application -
Select a thumbnail then select this 
button to open the image in a third 
party application. A third party 
application must be configured in 
System Values 

_ 
Copy to Clipboard - Select a 
thumbnail then select this button to 
copy the image to your clipboard 

Al Print - Select a thumbnail then select 
this button to print 

Lk 

Investigator mode - select a 
thumbnail then select this button to 
open associated video in investigator 
mode 
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Clip creation tools - select a 
thumbnail to be the start time of a 
clip, then select Clip Start Time. 
Select a thumbnail to be the end time 
of a clip, then select Clip End Time. 
Select Clip Export to export or vault 
the clip 

a al_ cio
dace 

avo I cet 
iMP 

N 

Open Search and Retrieval Wizard - 
Select to reopen Video Search and 
Retrieval Wizard 

- End - 

Perform a Motion Detection Search 
You can use the Search and Retrieval Wizard to search video footage using a motion filter to look for movement in 
specific areas within a camera view. Specific areas may also be searched by exception. This applies to Edge and 
Server based motion detection searches. 

Note: 
When searching on VideoEdge NVR 4.2+ recorders, motion detection search is only enabled when Motion 
Detection is enabled in the camera setup. For cameras with Video Intelligence enabled, refer to Perform a 
Video Intelligence Search (Analytics). 

Procedure 50 Perform a Motion Detection Search 

Step Action/ 

1 Select Search and Retrieve from the Home tab. 

2 Select Execute Search Wizard. The Search and Retrieval Wizard launches. 

3 Drag and drop a camera from the Device, Site or Vault list onto the Camera Selector Pane. 

4 Select Motion Detection from the Type of Search drop down menu. 

5 Specify Date and Time parameters in the Date and Time pane. 

Note: 
Selecting Specific Range also allows selection of Time Filter options. Time Filter options can be 
used to specify a sub-set of time to search. For example, only search between 9am and 5pm. Select 
the Time Filter checkbox to enable 

6 Select Next. The Search Parameters screen displays. 

Note: 

The video stream reverts to the start time selected for the search. To view live video, select  . 

7 Select the required Draw Style and draw a Region of Interest (ROI): 

• Polygon: Draw a polygon by clicking once on the image and dragging the cursor to form 
a line. Complete a line by clicking again. Repeat to form the ROI. 
Double click when the shape is complete to finalize the search area. Use Clear to 
restart drawing and Erase to correct errors. 

• Rectangle: Highlight the ROI by clicking and dragging the cursor over the camera view 
to form a rectangle. Use Clear to restart drawing and Erase to correct errors. 
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• Free Draw: Draw the ROI freehand on the camera view. Use Clear to restart drawing 
and Erase to correct errors. 

Note: 
1. By default the ROI drawn is the Active Region, this can be inverted by selecting Invert 
Selection. 
2. The full camera view can be selected as the Active Region by selecting Select All. 
3. Load Alarm Rule allows you to load a previously configured rule from a VideoEdge NVR 4.2+ 
recorder. victor uses information from the NVR rule to apply search criteria to the victor client search. 
Search parameters are populated from the rule but can be edited if required. Refer to Alarm Rules for 
more information on alarm rules. 

8 Adjust Parameters as required to suit your search type. Available Parameters are dependent on recorder and 
camera type. 

9 Select Next. The Confirmation screen displays. Confirm your search criteria are correct. Select Previous 
to return to the previous screen to make changes. Select Finish to execute the search. 

10 Search and Retrieval Wizard closes and the Advanced Search Results tab opens displaying search 
results. Double click on a search result to view associated video. 

- End - 
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Perform a Video Intelligence Search (Analytics) 
VideoEdge NVR recorders support Search Analytics. This gives users the ability to detect, track and analyze moving 
objects using a variety of criteria. Refer to the table below for further information on the various types of Video 
Intelligence searches and which versions of VideoEdge NVR support them. 

In order to perform Video Intelligence searches,the feature must be enabled on the recorder and in some cases, on the 
specific camera required. Refer to the VideoEdge NVR User Manual for further information. 

Advanced Search 
Type Description 

Search Parameter 
(s) 

VideoEdge
Version 

Supported 

Object Detection 

Find objects that move into a 
region of interest. This is 
similar to a normal motion 
detection search except that 
it only finds objects the first 
time they enter the region. 
If the objects leave the 
camera view and return, the 
search will find them again. 
Draw a region that covers the 
area to be searched for 
objects. 
Use a higher overlap setting 
to find objects that are mostly 
within the region, use a lower 
setting to find objects that just 
brush the edge of the region. 

Overlap (Sensitivity 
Level) - A lower value 
will return more results. 

4.2+ 

Direction 

Find objects moving in a 
certain direction through a 
region of interest. 
Set the general direction of 
motion to search for, and the 
maximum amount of time the 
object can take to traverse 
most of the region (this 
excludes objects which move 
too slowly). 
Draw a thin region in the 
direction of motion required. 
Use a lower overlap setting 
to find objects moving in the 
general direction but not 
necessarily in the region. 

Overlap (Sensitivity 
level) - A lower value 
will return more results. 

Traversal Time -
Maximum time an 
object can take to 
traverse the region. 

Direction of Motion -
The direction, North, 
South, East or West 
which the object is 
moving. 

Color Fitters - Define a 
Color Filter to further 
refine search results. 

4.2+ 

Linger 

Detect objects lingering in a 
region of interest. An object is 
lingering if it remains in the 
ROI. Set the minimum 
amount of time an object 
must linger before being 
included in the results. Draw 
a region in the area where 
you want to detect objects 
lingering. Use a higher 
Overlap setting to avoid 
detecting objects lingering 

Overlap (Sensitivity 
level) - A lower value 
will return more results 

Linger Time - Minimum 
amount of time an 
object lingers before 
being included in 
results. 

Color Fitters - Define a 
Color Filter to further 

4.2+ 
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Advanced Search 
Type Description Search Parameter 

(s) 

VideoEdge
Version 

Supported 

nearby. refine search results. 

Enter 

Find objects entering a 
camera view through a 
doorway or threshold. 
Draw a region containing the 
doorway or threshold and 
any area around it through 
which objects can be seen 
(like glass). Also include any 
area through which the door 
(if there is one) might move. 
This search excludes objects 
that can be seen through the 
doorway or threshold but do 
not pass through it. 

Overlap (Sensitivity 
level) - Use a higher 
overlap setting for best 
results. 

Color Filters - Define a 
Color Filter to further 
refine search results. 

4.2+ 

Exit 

Find objects exiting a camera 
view through a doorway or 
threshold. 
Draw a region containing the 
doorway or threshold and 
any area around it through 
which objects can be seen 
(like glass). Also include any 
area through which the door 
(if there is one) might move. 
This search excludes objects 
that walk up to the doorway 
but do not pass through it. 

Overlap (Sensitivity 
level) - Use a higher 
setting to avoid finding 
nearby changes or 
changes which are not 
completely within the 
region 

Color Filters - Define a 
Color Filter to further 
refine search results. 

4.2+ 

Abandoned/Removed 

Use this search to find when 
a stationary object was a
placed, moved or removed. 
The amount changed lets 
you search for larger or 
smaller changes in the 
region. 
The within setting specifies 
over what time period 
changes can occur (0 
seconds = instantaneous 
change). 
Draw a region that contains 
all of the area that you wish 
to search for changes, and 
use a higher overlap setting 
to avoid finding nearby 
changes or changes that are 
not completely in the region. 

Overlap (Sensitivity 
Use a higher 

overlap to avoid finding 
nearby changes or 
changes that are not 
completely in the 
region 

Amount Changed -
Adjust to look for a 

or smaller 
change in the region. 

Within - Timeframe 
within which the 
change occurs. 

Color Filters - Define a 
Color Filter to further 
refine search results. 

4.2+larger 

Dwell 

Detect objects dwelling in a 
region of interest. An object is 
dwelling if it is mostly 
stationary. Set the minimum 
amount of time an object 
must dwell before being 
included in the results. Draw 
a region in the area where 

Overlap (Sensitivity 
level) - A lower value 
will return more results 

Dwell Time - Minimum 
amount of time an 
object lingers before 
being included in 

4.5+ 
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Advanced Search 
Type Description Search Parameter 

(s) 

VideoEdge
Version 

Supported 

you want to detect objects 
dwelling. Use a higher 
Overlap setting to avoid 
detecting objects dwelling 
nearby. 

results. 

Color Filters - Define a 
Color Filter to further 
refine search results. 

Queue Length 

Search for times when a 
queue is a certain length. 
Draw three regions of interest 
to indicate the area occupied 
when the queue is short, 
medium or long, then set the 
minimum and maximum 
zones to define the length of 
the queue you are looking 
for. 

Overlap (Sensitivity 
level) -A lower value 
will return more results 

Search for when the 
Queue is - select which 
criteria to use for queue 
search, Empty, Short, 
Medium, Long or Not 
Empty. 

4.6+ 

Crowd Formation 

Search for times when more 
than a certain number of 
people or objects are in a 
region of interest. Draw a 
region in the area that you 
want to find objects forming a 
crowd. Use a higher overlap 
setting to avoid objects near 
the region. Set the Minimum 
Crowd Size to the number of 
objects that make a crowd. 

Overlap 
(Sensitivity level) - Use
a higher overlap setting
to avoid objects near
the region. 

Minimum Crowd Size -
Minimum number of 
objects that determine 
a crowd. 

4.6+ 

Procedure 51 Perform a Video Intelligence Search 

Step Action 

1 Select Search and Retrieve from the Home tab. 

2 Select Execute Search Wizard. The Search and Retrieval Wizard launches. 

3 Select required Video Intelligence search type from the Type of Search drop down menu. 

4 Drag and drop camera(s) from the Device, Site or Vault list onto the Camera Selector Pane. 

Note: 
If selecting cameras from the Vault List, Date and Time parameters are automatically populated. 

5 Specify Date and Time parameters in the Date and Time Pane. 

Note: 
Selecting Specific Range also allows selection of Time Filter options. Time Filter options can be 
used to specify a sub-set of time to search. For example, only search between 9am and 5pm. Select 
the Time Filter checkbox to enable. 

6 Select Next. The Search Parameters screen displays. 
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Note: 

The video stream reverts to the start time selected for the search. To view live video, select  . 

7 Select the required Draw Style and draw a Region of Interest (ROI): 

• Polygon: Draw a polygon by clicking once on the image and dragging the cursor to form 
a line. Complete a line by clicking again. Repeat to form the ROI. 
Double click when the shape is complete to finalize the search area. Use Clear to 
restart drawing and Erase to correct errors. 

• Rectangle: Highlight the ROI by clicking and dragging the cursor over the camera view 
to form a rectangle. Use Clear to restart drawing and Erase to correct errors. 

• Freehand: Draw the ROI freehand on the camera view. Use Clear All to restart draw-
ing and Erase to correct errors. 

Note: 
1. By default the ROI drawn is the Active Region, this can be inverted by selecting Invert Selection. 
2. The full camera view can be selected as the Active Region by selecting Select All. 
3. Load Alarm Rule allows you to load a previously configured rule from a VideoEdge NVR 4.2+ 
recorder (Not available on Face detection and edge analytics searches). victor uses information from 
the NVR rule to apply search criteria to the victor client search. Search parameters are populated 
from the rule but can be edited if required. Refer to Alarm Rules for more information on alarm rules. 

8 Adjust Parameters as required to suit your search type. Available Parameters are dependent on Video 
Intelligence search type selected. 

9 Select Next. The Confirmation screen displays. Confirm your search criteria are correct. Select Previous 
to return to the previous screen to make changes. Select Finish to execute the search. 

10 Search and Retrieval Wizard closes and the Advanced Search Results tab opens displaying search 
results. Double click on a search result to view associated video. 

- End - 

Perform Edge Based Face Detection Search 
VideoEdge NVR recorders support edge based analytics, allowing Face Detection alarms and searches on supported 
American Dynamics Cameras. 

Advanced 
Search Type Description Search Parameter(s) 

VideoEdge 
Version 

Supported 

Face Detection 
(Edge Based) 

Use this search to find when 
a face is present in video. 
Draw a region that contains 
all of the area that you wish 
to search for faces and use 
higher overlap settings to 
avoid finding faces nearby. 

Overlap (Sensitivity 
level) - Use a higher 
overlap to avoid finding 
nearby faces or faces 
that are not completely in 
the region 

4.4+ 

Procedure 52 Perform an Edge Based Face Detection Search 

Step Action 

1 Select Search and Retrieve from the Home tab. 
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2 Select Execute Search Wizard. The Search and Retrieval Wizard launches. 

3 Select Face Detection from the drop down menu. 

4 Drag and drop camera(s) from the Device, Site or Vault list onto the Camera Selector Pane. 

Note: 
If selecting cameras from the Vault List, Date and Time parameters are automatically populated. 

5 Specify Date and Time parameters in the Date and Time Pane. 

Note: 
Selecting Specific Range also allows selection of Time Filter options. Time Filter options can be 
used to specify a sub-set of time to search. For example, only search between 9am and 5pm. Select 
the Time Filter checkbox to enable. 

6 Select Next. The Search Parameters screen displays. 

Note: 

The video stream reverts to the start time selected for the search. To view live video, select o  . 

7 Select the required Draw Style and draw a Region of Interest (ROI): 

• Polygon: Draw a polygon by clicking once on the image and dragging the cursor to form 
a line. Complete a line by clicking again. Repeat to form the ROI. 
Double click when the shape is complete to finalize the search area. Use Clear to 
restart drawing and Erase to correct errors. 

• Rectangle: Highlight the ROI by clicking and dragging the cursor over the camera view 
to form a rectangle. Use Clear to restart drawing and Erase to correct errors. 

• Freehand: Draw the ROI freehand on the camera view. Use Clear All to restart draw-
ing and Erase to correct errors. 

Note: 
1. By default the ROI drawn is the Active Region, this can be inverted by selecting Invert Selection. 
2. The full camera view can be selected as the Active Region by selecting Select All. 
3. Load Alarm Rule allows you to load a previously configured rule from a VideoEdge NVR 4.2+ 
recorder (Not available on Face detection and edge analytics searches). victor uses information from 
the NVR rule to apply search criteria to the victor client search. Search parameters are populated 
from the rule but can be edited if required. Refer to Alarm Rules for more information on alarm rules. 

8 Select the required Overlap percentage. 

9 Select Next. The Confirmation screen displays. Confirm your search criteria are correct. Select Previous 
to return to the previous screen to make changes. Select Finish to execute the search. 

10 Search and Retrieval Wizard closes and the Advanced Search Results tab opens displaying search 
results. Double click on a search result to view associated video. 

- End - 

Perform Server Based Face Detection / Face Recognition 
VideoEdge NVR recorders supports server based facial recognition and detection, allowing searches and alarms 
based on this analytic type when an appropriate license is applied. 

To execute a face recognition search users must be enrolled in the NVR's Face Enrollment database. 
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Procedure 53 Perform a Server Based Face Detection Search 

Step Action 

1 Select Search and Retrieve from the Home tab. 

2 Select Execute Search Wizard. The Search and Retrieval Wizard launches. 

3 Select Face Detection from the drop down menu. 

4 Drag and drop camera(s) from the Device, Site or Vault list onto the Camera Selector Pane. 

Note: 
If selecting cameras from the Vault List, Date and Time parameters are automatically populated. 

5 Specify Date and Time parameters in the Date and Time Pane. 

Note: 
Selecting Specific Range also allows selection of Time Filter options. Time Filter options can be 
used to specify a sub-set of time to search. For example, only search between 9am and 5pm. Select 
the Time Filter checkbox to enable. 

6 Select Next. The Search Parameters screen displays. 

Note: 

The video stream reverts to the start time selected for the search. To view live video, select 0  . 

7 Select the required Draw Style and draw a Region of Interest (ROI): 

• Polygon: Draw a polygon by clicking once on the image and dragging the cursor to form 
a line. Complete a line by clicking again. Repeat to form the ROI. 
Double click when the shape is complete to finalize the search area. Use Clear to 
restart drawing and Erase to correct errors. 

• Rectangle: Highlight the ROI by clicking and dragging the cursor over the camera view 
to form a rectangle. Use Clear to restart drawing and Erase to correct errors. 

• Freehand: Draw the ROI freehand on the camera view. Use Clear All to restart draw-
ing and Erase to correct errors. 

Note: 
1. By default the ROI drawn is the Active Region, this can be inverted by selecting Invert Selection. 
2. The full camera view can be selected as the Active Region by selecting Select All. 
3. Load Alarm Rule allows you to load a previously configured rule from a VideoEdge NVR 4.2+ 
recorder (Not available on Face detection and edge analytics searches). victor uses information from 
the NVR rule to apply search criteria to the victor client search. Search parameters are populated 
from the rule but can be edited if required. Refer to Alarm Rules for more information on alarm rules. 

8 Select the required Overlap percentage. 

9 Select Next. The Confirmation screen displays. Confirm your search criteria are correct. Select Previous 
to return to the previous screen to make changes. Select Finish to execute the search. 

10 Search and Retrieval Wizard closes and the Advanced Search Results tab opens displaying search 
results. Double click on a search result to view associated video. 

- End - 

Procedure 54 Perform a Server Based Face Recognition Search 

American Dynamics 71 

EFTA01223880



Step Action 

1 Select Search and Retrieve from the Home tab. 

2 Select Execute Search Wizard. The Search and Retrieval Wizard launches. 

3 Select Face Recognition from the drop down menu. 

4 Drag and drop camera(s) from the Device, Site or Vault list onto the Camera Selector Pane. 

Note: 
If selecting cameras from the Vault List, Date and Time parameters are automatically populated. 

5 Specify Date and Time parameters in the Date and Time Pane. 

Note: 
Selecting Specific Range also allows selection of Time Filter options. Time Filter options can be 
used to specify a sub-set of time to search. For example, only search between 9am and 5pm. Select 
the Time Filter checkbox to enable. 

6 Select Next. The Search Parameters screen displays. 

Note: 

The video stream reverts to the start time selected for the search. To view live video, select  . 

7 Select the required Draw Style and draw a Region of Interest (ROI): 

• Polygon: Draw a polygon by clicking once on the image and dragging the cursor to form 
a line. Complete a line by clicking again. Repeat to form the ROI. 
Double click when the shape is complete to finalize the search area. Use Clear to 
restart drawing and Erase to correct errors. 

• Rectangle: Highlight the ROI by clicking and dragging the cursor over the camera view 
to form a rectangle. Use Clear to restart drawing and Erase to correct errors. 

• Freehand: Draw the ROI freehand on the camera view. Use Clear All to restart draw-
ing and Erase to correct errors. 

Note: 
1. By default the ROI drawn is the Active Region, this can be inverted by selecting Invert Selection. 
2. The full camera view can be selected as the Active Region by selecting Select All. 
3. Load Alarm Rule allows you to load a previously configured rule from a VideoEdge NVR 4.2+ 
recorder (Not available on Face detection and edge analytics searches). victor uses information from 
the NVR rule to apply search criteria to the victor client search. Search parameters are populated 
from the rule but can be edited if required. Refer to Alarm Rules for more information on alarm rules. 

8 Select the required Overlap percentage. 

9 Use the ~ and to move users into/out of the search list (right hand pane). 

10 Select Exclude or Include from the Face Search List Type drop down. 

Note: 
Exclude - This will search for matches against all enrolled users in the enrollment database, with the 
exception of the users in the search list. 
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Include-This will search for matches against users in the enrollment database, which have been 
added to the search list only. 

11 Select Next. The Confirmation screen displays. Confirm your search criteria are correct. Select Previous 
to return to the previous screen to make changes. Select Finish to execute the search. 

12 Search and Retrieval Wizard closes and the Advanced Search Results tab opens displaying search 
results. Double click on a search result to view associated video. 

- End - 
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Perform a Text stream search 
Text stream searches allow you to return results from all text streams within a defined time period for up to four 
devices. Searches can be fine tuned using custom rules to filter unwanted results. 

Text stream searches can be performed using the search and retrieve wizard. 

Text stream rules 

Text Stream Rules allow you to fine tune a Text Stream search. User defined rules may be used to filter search results 
and you can add multiple rules or use no rules for searches. 

Rules which have been defined on VideoEdge recorders can be selected via victors search and retrieve wizard to 
enable the rules to be applied in victor searches, alternatively you can define and apply text stream rules in victor client 
as part of the victor search process. 

Rule Groups are used to define a set of rules such that all would have to be true to trigger an alarm. Rules are either 
'OR' or 'AND'. So when you perform a text stream search, you can identify 'AND' or 'OR'. If you selected 'AND', this 
implies 'RuleGroup', such that all rules would need to be satisfied for the search result to return true. 

Text stream rules can also be used to configure alarms. For example, if you always wanted to know when cash sales 
were over $50 or when there was a void, you could define a rule as such. 

Procedure 55 Perform a text stream search 

Step Action 

1 Select Search and Retrieve from the Home tab. 

2 Select Execute Search Wizard. The Search and Retrieve Wizard launches. 

3 Drag a text stream device from the device list into the device selector pane. 

4 Specify Date and Time parameters in the Date and Time Pane. 

Note: 
Selecting Specific Range also allows selection of Time Filter options. Time Filter options can be 
used to specify a sub-set of time to search. For example, only search between 9am and 5pm. Select 
the Time Filter checkbox to enable. 

5 Select Next. Text stream rules window displays 

6 Select rule checkboxes to apply existing VideoEdge rules to the search (if applicable). Use And/Or operators 
as required to filter your results. 

To define custom rules: 

a Select 0. Rule edit dialog displays 

b Enter a name for the rule in the Rule Name textbox 

c Enter a value for the text match in the Text Match textbox. This is the primary value associated with the 
rule which is used by the search wizard. 

d Enter the Search Direction associated with the rule (Forward or reverse) 

e Enter Jump n Results value (numbers of characters ahead of the search term to include in results) 

f Enter Criteria (operator for the rule) 

g Select Preview (optional) to test the rule and gain a preview of the results 

7 Select Next. The Confirmation screen displays. Confirm your search criteria are correct. Select Previous 
to return to the previous screen to make changes. Select Finish to execute the search. 
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8 Search and Retrieval Wizard closes and the Text stream based Search Results tab opens displaying 
search results. Double click on a search result to view associated video and text stream. 

- End - 

it American Dynamics 75 

EFTA01223884



Analytic Heat Maps 
A camera heatmap based on analytics data provides a visual representation of analytic activity over time. A still image 
of the camera is overlaid with translucent colored pixels that indicate how much activity each pixel 'saw' in a given 
time frame. 

Note: 
Motion Detection or Video Analytics must be configured for the camera on the VideoEdge recorder for at least the 
duration of the time range you are mapping. 

Procedure 56 Generate Analytic Heat Map 

Step Action 

1 Right Click the required video stream in surveillance mode. 

2 Select Analytic Heat Map. 

3 Select the time range in which to search using the date and time pickers. 

Note: 
The start and end times relate to the total time range searched (not a daily interval) 

4 Select Generate Heat map. A still image is displayed, overlaid with translucent colored pixels. A Key is 
displayed to the right of the image indicating the colors used. Colors range from Dark Blue (least activity) to 
Red (most activity) 

Standard surveillance tools are available for the heatmap image including Save As, Email, Open in third party 
application and Print. 

- End - 
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Alarm Rules 
Alarm Rules allow users to load previously configured searches into victor Search and Retrieval Wizard. When 
loaded, Alarm Rules will automatically populate the Region of Interest along with additional Search Parameters. This 
feature enables users to store commonly used searches in order to speed up repeated searching. 

Alarm Rules are only supported on VideoEdge 4.2+ recorders. 

Save Search as Alarm Rule 
As well as using alarm rules defined within the NVR, you can also create new alarm rules using criteria defined in 
specific victor searches. These alarm rules display in the Load from Alert Rules list in the Search and Retrieval 
wizard when the camera they have been saved against is selected. 

Procedure 57 Save Search as Alarm Rule 

tep Action 

1 Perform a Motion Detection or Video Intelligence search. 

2 Select . Save Search as Alert dialog displays. 

3 Enter a name for the saved search in the Alert Name textbox. 

4 Select OK. The search is saved as an alarm rule and will be available for selection on Motion Detection or 
Video Intelligence searches. 

- End - 

Load Alarm Rule 
Load Alarm Rule allows you to load a previously configured alarm rule from a VideoEdge NVR 4.2+ recorder. victor 
uses information from the NVR rule to apply search criteria to the victor client search. Search parameters are 
populated from the rule but can be edited if required. 

Note: 
Load Alarm Rule feature is not available on Face Detection or Edge Analytic searches 

Procedure 58 Load Alarm Rule 

Step Action 

1 Select Search and Retrieve from the Home tab. 

2 Select Execute Search Wizard. The Search and Retrieval Wizard launches. 

3 Select Motion Detection or required Video Intelligence search type from the Type of Search drop down 
menu. 

4 Drag and drop camera(s) from the Device, Site or Vault list onto the Camera Selector Pane. 

Note: 
If selecting cameras from the Vault List, Date and Time parameters are automatically populated. 

5 Specify Date and Time parameters in the Date and Time Pane. 
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Note: 
Selecting Specific Range also allows selection of Time Filter options. Time Filter options can be 
used to specify a sub-set of time to search. For example, only search between 9am and 5pm. Select 
the Time Filter checkbox to enable. 

6 Select Next. The Search Parameters screen displays. 

7 Select required Alarm Rule from the Load from Alert Rules list. 

8 Search parameters are populated with Alarm Rule parameters. If required, edit search parameters. 

9 Select Next. The Confirmation screen displays. Confirm your search criteria are correct. Select Previous 
to return to the previous screen to make changes. Select Finish to execute the search. 

10 Search and Retrieval Wizard closes and the Advanced Search Results tab opens displaying search 
results. Double click on a search result to view associated video. 

- End - 

Investigator Mode 
Launching Investigator Mode opens a new Guard window with the selected, main video stream in paused mode 
occupying the upper left pane. 

This mode allows you to drag in up to 5 other streams, each will automatically pause at the same time as the selected 
stream, enabling a time synchronized view of all cameras. 

Note: 
Investigator mode can be launched from any surveillance view and is also available from the Search Results window. 

Procedure 59 Launch Investigator Mode 

tep Action 

1 Select the main video stream from which to launch Investigator mode. Yellow border displays around pane 
indicating instant playback is available. 

2 Select = . Investigator mode launches in a new window. 

3 Drag in other cameras as required. These video streams are paused at the same point as the main video 
stream. 

4 Select Playback controls as required to navigate the video streams simultaneously. 

- End - 
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Export Search Results 
You can export search results as a grid in Microsoft Excel (.xlsx) or .xps formats. 

Procedure 60 Export Search Results 

tep Action 

1 Perform a search using the Search and Retrieve Wizard. Results display in the Search Results window. 

2 To export the search results: 

• In Excel format select H. 

• In .xps format select l= 

3 Navigate to the Save in folder as required. 

4 Select Save. 

- End - 

Quick Search and Retrieve 
Quick Search and Retrieve can be used to retrieve recent footage from a single camera. Quick Search and Retrieve 
can jump backwards 30 seconds, 1, 5, 10, 30 or 60 minutes. To perform a search with more defined time parameters, 
refer to Perform a Basic Search. 

Procedure 61 Quick Search and Retrieve 

tep Action 

1 Navigate to the camera on the device list and right click. 
Or 
Right click the surveillance pane for that camera. 

2 Select Search and Retrieve. Available time intervals display. 

3 Select required time interval. Search results window displays. 

4 Search result displays when download is complete. 

- End - 

Early Clip Playback 
During clip retrieval on supported recorders it is possible to view the video footage while it downloads by selecting the 

search result then 
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Jump to Next/Previous Alerts or Results 
The Jump to Next/Previous results buttons allow for navigating alerts and video search results. 

This feature is available for alerts when in instant playback mode, the required alert types are enabled and alerts are 
available. It is available for search results whenever there are multiple results available. 

Search results and Alert types are selectable via the combo box 

Search results are only enabled when results of a previous advanced search are available. 

If viewing multiple video streams and alarms are triggered on more than one camera, Jump To actions mirror the order 
of alarms in the journal. 

tr, 

Procedure 62 Jump to Next/Previous Alerts or Results 

Step Action 

1 If viewing Alerts, Use to select the Alert type. 

2 Select 11± to Jump to the Next Result/Alert. 

3 Select :Jim to Jump to the Previous Result/Alert. 

- End - 
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Clips 

Introduction 
Clips are segments of video and audio that are stored remotely from their original recorder. 

Clip Creation/Saving 
Clip creation tools can be used to define start and end times for video clips from any surveillance window. After 
creation, you can then choose to Export (locally or remotely), Save, Archive or Vault the video clip. 

Clip start time — 

Clip stop time 

—Clip export 

Procedure 63 Create/Save clips using Clip Creation Tools 

Note: 
If using a recorder which does not support Instant Playback (supported on VideoEdge and Intellex 4.2+), it is 
recommended to use the Search and Retrieve wizard to create clips rather than Clip Creation Tools. 

Step Action 

1 Select the video pane from which to create the clip. 

2 Navigate to the start time from which to create the clip. 

3 Select . Clip Start time is set. 

4 Navigate to or wait until video stream reaches the appropriate end time then select . 

5 Select "1" . Direct Clip Action dialog displays showing camera options summary. From the Direct Clip 
Action dialog, the clip can be vaulted, saved or exported. For more information, refer to Clip Actions 

Note: 

If required, you can select AS  beside the camera name to remove it from the clip. 

6 Select Save. Saving Location options display. 

7 Edit the clip name by double clicking the Clip Name textbox and entering text as required. 

8 Select the Audio checkbox to save associated audio. 

9 Select Clip Saving Location (Remote or victor unified client). 
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10 Select a clip folder to save to. 

Note: 
You can use right click to Rename, Refresh, Delete, Export or Add a new folder. 

11 Select Save. Dialog displays informing whether the save was successful. 

Note: 
If the clip was from a VideoEdge NVR or HDVR/exacqVision recorder, you will be prompted to enter 
a passphrase for validation purposes. Enter and confirm the passphrase and select OK. 

- End - 

Clip Actions 
Once a clip has been created, it can then be vaulted, saved, exported or archived from the Direct Clip Action dialog. 
For more information on creating a clip, refer to Clip Creation/Saving. Additionally, clips that have previously been 
created and saved can then be exported. 

Vault Clips 

Vaulting a clip tags it as protected, preventing it from data culling. 

Note: 
Vaulting is only supported on VideoEdge NVR 4.2+ recorders. 

Procedure 64 Vaulting a Clip 

Step Action 

1 Create a clip using Clip Creation/Saving. Direct Clip Action dialog displays. 

2 Select Vault. Progress bar displays showing progress of vaulting. 

3 Vaulting Complete message displays. 

- End - 
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Exporting saved Clips 

Clips can be exported to external media. Clips can be exported in Native (.img, .iso - playable using victorPlayer) as 
well as.avii.mp4 formats. Clips can be exported directly as part of the clip creation process or they can be exported 
from the clip list. 

Note: 
Exporting Clips is only available in Live Mode for HDVR/exacqVision recorders 

Procedure 65 Exporting saved clips 

Step Action 

1 Select the Clips tab. 

2 Right click the clip to be exported. 

3 Select Export Clips. Direct Clip Action dialog displays. From this dialog you can use calendar controls to 
edit start and end times by clicking the starUend time values. 

4 Select Export. New dialog displays from where you can define Export locations, Passphrases, Export 
Options and Notes 

5 Select Export Location(s) textbox: 

• Select "-"-r to add export location(s). 

• Select to select the export location(s). 

• Select to remove export location(s). 

6 If prompted, enter and confirm a Passphrase. 

7 Select export options. 

8 If required, select the Download Audio checkbox. 

9 If required, select the Export victorPlayer checkbox. For more information on victorPlayer, refer to 
victorPlayer 

10 If required, select the Specify Filenames checkbox. This allows you to enter user friendly filenames for the 
clips. 

11 Select Native or AVI/MP4 as file format. 

Note: 
1. Watermarking is not supported in Native format clips 
2. Selecting AVIIMP4 format offers a slider bar, use this to control clip output quality 
3. If the clip is a text stream export, an additional Export Text Stream check box will be available 

12 If required, select Watermarking Video checkbox. 

Note: 
Watermarking clips is a role governed feature which allows you to add user defined graphics or text 
to exported media. Refer to "Watermarks" for information on configuring watermark graphics. 

13 If required, select Display overlay (includes video overlay in export) 

14 If required, select the Notes tab and add text as required. 
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15 Select Export. If Specify Filenames was previously selected, proceed to Step 16. If Specify Filenames 
was not selected, export begins. 

16 Enter filename as required in the Filename textbox. 

17 Select Export. Progress bar displays showing progress of export. 

18 Select Finish. 

- End - 

Archive Clips 
Clips from VideoEdge NVR 4.4+ recorders can be archived for long term storage. For more information on archiving 
and how to set it up on your VideoEdge NVR recorder, refer to the VideoEdge NVR 4.4 Installation and User Manual. 

Procedure 66 Archiving a Clip 

Step Action 

1 Create a clip using Clip Creation/Saving. Direct Clip Action dialog displays. 

2 Select Archive. Progress bar displays showing progress of archiving. 

3 Archiving Complete message displays. 

- End - 

Clip Storage 
Saved Clips are displayed and selectable from the Clips window. 

Procedure 67 Organize Clip Folders 

You can create, rename and build folder structures for clip storage. This allows you to meaningfully organize local clip 
storage 

Step Action 

1 Select the Clips in device list tab group, displaying all saved clips. 

2 The following right click options are available: 

• Refresh Folder 

• Rename Folder 

• Delete Folder 

• Export Folder 

• New Folder 

3 Use right click options as required to organize folders. 

- End - 

Procedure 68 View/Edit Saved Clip Notes 
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Notes can be stored against clips when they are saved or exported. These notes can be viewed and/or edited from the 
Clips window for saved clips. 

victorPlayer supports note viewing for exported clips. 

Step Action 

1 Select the Clips tab. 

2 Select required clip. Notes for selected clip are displayed in the Notes textbox. 

3 If required, select Notes textbox and edit notes. 

4 Select M to save. 

- End - 

View and Delete Saved Clips 
Saved clips can be viewed and deleted as required. 

View Saved Clips 

Procedure 69 View Saved Clips 

Step Action 

1 Select the Clips tab 

2 Right click the clip to be played 

3 Select Playback Clips. The clip displays in a new window 

4 Select 0  to enable audio. Use playback controls to navigate clip 

- End - 
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Delete Saved Clips 
When saved clips are no longer required, they can be deleted. 

Procedure 70 Delete Saved Clips 

Step Action 

1 Select the Clips tab. 

2 Expand the required clip folder. 

3 Right click the folder to be deleted. 

4 Select Delete Clips. A Warning dialog displays. Select Yes to delete the clip or No to cancel. 

- End - 

Sorting the Clip List 

Procedure 71 Sorting the Clip List 

Step Action 

1 Select the Clips tab from the Home tab. 

2 Select Clip List from the dropdown menu. 
The Clip List opens. 

3 Click LI 
The order menu appears. 

4 Select the order criteria: 

a Select Name, Size or Creation Date. 

b Select Ascending Order or Descending Order. 

c Select Show Local Clips, or select Show Remote Clips, or select both. 

Note: 
Order preferences are stored between sessions. 

- End - 

victorPlayer 
victorPlayer is a proprietary media player developed by American Dynamics. It is a portable application and is 
required to play .img files from Intellex recorders. victorPlayer can also be used to playback clips in the following 
formats: 

• .ISO (from VideoEdge NVR recorders) 

• .ZIP (from HDVR/exacqVision recorders) 

• .IMG (From Intellex Recorders) 

victorPlayer can also be included with exported clips. 
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Playing Clips 
The primary purpose of victorPlayer is to facilitate clip playback. 

Note: 
victorPlayer has various options during clip playback. In addition to the standard surveillance playback controls, you 
can also: Toggle Full Screen, Clear Video, Restart Playback, Verify Clips (Standard and using Key files) and 
perform Still Image Capture by right clicking the playback window. 

Procedure 72 Play Saved Clip with victorPlayer 

The following steps assume that victorPlayer is available on the local machine. If it is not available, it can be exported 
as part of victors clip export feature. For more information on exporting clips, refer to Exporting saved Clips. 

Step Action 

1 Launch victorPlayer, select required language then select OK. 

2 Saved clips are displayed in the clip list. 

3 Drag and drop the required clip into the surveillance window. The clip will begin playback. 

Note: 
To view more than one clip at one time, select View Surveillance from the View menu to open 
additional surveillance panes 

- End - 

Procedure 73 Play External Clips with victorPlayer 

In addition to using victorPlayer to play clips from the clip list, victorPlayer can also play external video clips. 

Step Action 

1 Launch victorPlayer select required language then select OK. 

2 Select File. 

3 Select Open. Select clip file to open dialog displays. 

4 Browse to the clip to be opened. 

5 Select Open. 

6 Drag and drop the required clip into the surveillance window. Clip will begin playback. 

Note: 
To view more than one clip at one time, select View Surveillance from the View menu to open an 
additional surveillance pane. 

- End - 

Configuring victorPlayer 
victorPlayer's Overlay and Layout settings can be configured as required. 

Overlay settings can be configured by selecting Overlay Settings from the View menu, selecting required elements 
then selecting OK. 
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To save your current layout, select M  then choose a location and select Save. To load a previously saved layout 
select Load from the Layout menu, locate the saved layout and select Open. 
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Verifying Clips 
Exported clips can be checked for authenticity by using the Verify Clip tool. The tool checks whether the clip has 
been tampered with. In addition to verifying exported clips in victor client, clips can also be verified in victorPlayer. 

Note: 
Only exported clips can be verified. 

Procedure 74 Verify Exported Clip 

Step Action 

1 Select Clips from the Home tab. 

2 Select Verify. Browse dialog displays. 

3 Browse for and select the clip to be validated. 

4 Select Open. 

5 If prompted, enter the passphrase associated with the clip. This is the passphrase entered at the time the clip 
was initially created. 

6 Select Validate. Clip Validator displays informing whether clip is valid. 

Note: 
The clip validator also offers the ability to Validate with Key File (NVR Only) 
This verification method checks for integrity using a key file generated on the NVR to verify exported and archived 
clips which were signed using a private key 

- End - 

Procedure 75 Verify Clips in victorPlayer 

Step Action 

1 Launch victorPlayer. 

2 Drag and drop the clip to be verified into the Surveillance window. 

3 Right click on the video pane. 

4 Select Verify Clip. 

Note: 
If the clip has been exported from an HDVR/exacqVision or NVR unit, you will be prompted to enter a 
Passphrase 

5 The Clip Validator dialog displays informing whether clip is valid 

Note: 
Right clicking the video pane also offers the ability to Verify Clip Using key File (NVR Only) 
This verification method checks for integrity using a key file generated on the NVR to verify exported 
and archived clips which were signed using a private key 

- End - 
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Maps 

Introduction 
The Maps feature provides a dynamic view of physical security objects within a visual representation of their 
environment. 

Physical objects are represented by icons to form an integrated, unified view allowing monitoring and reaction to state 
changes in real time. 

Real-time visualization of event activity can be achieved by linking Map actions to Events. 

Supported Image files are: 

• a.dwg a.dxf (Vector) 

• a.png a.jpg (Raster) 

Note:: 
1. victor automatically converts vector graphics to .jpg and stores them in the database. 
2. CAD Layers: Only CAD Layers visible at the time of import are visible within the image in victor. However, once 
imported, new layers can be added to the converted CAD image and used to configure icons. The actual CAD layers 
do not exist in victor. 
3. Map Image files can be updated without disassociating the icons which were previously placed on the map. 
4. victor supports image files up to 20 MB 

Importing Map Images 
To store an image file on the database, you need to import and save the image file. These procedures describes the 
basic steps to import and save an image file as a Map. The map then needs to be configured. 

Procedure 76 Import a Map Image 

btep Action 

1 Select Maps from the Build tab. 

2 Select New from the dropdown menu. New Map editor displays. 

3 Enter a name for the map in the Name textbox. 

4 Enter a description for the map in the Description textbox. 

5 The Enabled checkbox is selected by default, deselect to disable the map. 

6 Select   Select Drawing File dialog displays. 

7 Select . Browse window displays. 

8 Browse to and select the required image file. 

9 Select Open. 
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10 If you are importing a CAD (.dxftdwg) file the level of compression can be set by entering a Height and Width 
in the corresponding text boxes. 

11 Select Import. File imports and displays in map editor. 

12 Click [NJor In

- End - 

Procedure 77 Export CAD File 

A CAD file (.dwg or .dxf) can be exported from victor as a .jpg file. This enables CAD files to be exported, edited as 
required then imported for use as a map. 

Step Action 

1 Select Maps from the Build tab. 

2 Select New from the dropdown menu. New Map editor displays. 

3 Enter a name for the map in the Name textbox. 

4 Enter a description for the map in the Description textbox. 

5 The Enabled checkbox is selected by default, deselect to disable the map. 

6 Select [SI. Select Drawing File dialog displays. 

7 Select  . Browse window displays. 

8 Browse to and select the required CAD file. 

9 Select Open 

10 Select Export to File. Save As dialog opens 

11 Navigate to the location you want to export to and enter a File Name 

12 Select Save. 

- End - 

Procedure 78 Remove Blank Space from CAD Drawing 

While importing a CAD file (.dwg or .dxf), victor can remove any vertical blank space surrounding your image. 

Step Action 

1 Select Maps from the Build tab. 

2 Select New from the dropdown menu. New Map editor displays. 

3 Enter a name for the map in the Name textbox. 

4 Enter a description for the map in the Description textbox. 

5 The Enabled checkbox is selected by default, deselect to disable the map. 

6 [aSsi} Select Select Drawing File dialog displays. 

7 Select  . Browse window displays. 

8 Browse to and select the required CAD file. 

9 Select Open. 
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10 Hover over the imported CAD drawing, reduce the size of the window (horizontally) then click refresh. 

11 Click Refresh 

12 Select Import. File imports, preserving removed blank space and displays in map editor. 

13 Click ID orE) 

- End - 

Configure Maps 
Once an image has been imported to create a map, the map can then be configured for use by adding map layers and 
icons. 

Layers 
victor Maps make use of layers - enabling users to manage various object types on different 'levels' within one map. 

Procedure 79 Add and Configure Map Layer 

Step Action 

1 From the Map editor select [I  Map Layers editor displays. 

Note: 
The Map editor can be accessed by selecting Maps from the Build tab, then selecting Show All. 
Right click on the map to be edited and select Edit. 

2 Select Add. A new layer will be added to the Map Layers 

3 To rename the new layer, select the Layer textbox and edit as required. 

4 Use the Show in map checkbox to select if the layer is displayed on the map. 

5 Select OK. 

- End - 
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Add/Configure Map Icons 

Icons are added to maps to represent victor objects. Various icon properties can be configured depending on the object 
type they represent. 

Procedure 80 Add and Configure Icons 

Step Action: 

1 Open the map in edit mode. 

2 Select O The icon selector will display. 

3 Select the required icon it will be added to the map. 

4 Move the icon to the required position on the map and right-click, select Drop on Map. The Icon Editor will 
display. 

5 Select Select Object. The Object Selector will display. 

6 Select the object to link to the icon and select OK. 

Note: 
If Not in map is selected in the Object Selector only items which have not yet been added to the 
map will be displayed. Uncheck this box to display all items. 

7 Select OK. 

8 Assign characteristics in the Icon Editor if required. 

Note: 
If a template icon has been configured for that icon type, the annunciation and alert color settings 
from the template icon are configured. 

9 (Optional) Click Reset to default value to restore the default annunciation and color settings for the object. 

10 Select OK. 

11 Click ful or 

- End - 
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Add/Configure Map Icons Using Drag and Drop 
Icons are added to maps to represent victor objects. Various icon properties can be configured depending on the object 
type they represent. 

Procedure 81 Add and Configure Icons using drag and drop 

Step Action: 

1 Drag and drop victor objects from Device List into the Map editor. An icon will be added to the map, linked to 
the victor object. 

Note: 
Objects can also be dragged onto maps from Site, Call ups and Object lists 

2 To configure an icon's characteristics: 

a Right click the icon. 

b Select Edit. 

c Assign characteristics in the Icon Editor 

d (Optional) Click Reset to default value to restore the default annunciation and color settings for the 
object. 

e Select OK. 

3 Click E or h 

- End - 

Clone Icons 
You can use an existing icon as a template from which to configure a new icon. 

Procedure 82 Clone Icon Configuration 

Step Action 

1 From the map editor, select the icon you want to clone from. 

2 Drag and drop a victor object from Device List. The icon (with original icons configuration) will be added to the 
map. 

3 Right click the new icon and edit as required. 

- End - 
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Configuring areas 

Procedure 83 Configure an Area 

victor Maps allows for the configuration of areas in order to group icons. Should any icons related to an area go into 
Alert status, the entire area will highlight (this applies to icons where annunciation is set to Strobe, Pulse, Blink, Fade, 
Ripple, Wave or Flash). 

Step Action 

1 From the Map editor, hold the Shift key and draw the required area using your mouse. 

Note: 
The Map editor can be accessed by selecting Maps from the Build tab, then selecting Show All. 
Right click on the map to be edited and select Edit 

2 The area can be manipulated by using the grab handles. 

3 To add a new grab handle, right click on an existing grab handle, and select Add new point. 

4 The drawn area can be further manipulated by right clicking and selecting from: 

• Select all related icons 

• Clear all related icons 

• Hide this shape drawing 

• Remove this shape drawing 

• Send to back 

• Bring to front 

• Display automatically when in view mode 

- End - 

Configure areas related to other maps 
You can also configure areas on maps which relate to regions assigned on other maps. This can be useful as you can 
then click on a map region to view a more detailed map relating to an area you are particularly interested in. 

For example, You may have a map representing a full campus view and several related maps representing buildings 
within the campus. 

When you see an alarm annunciating when monitoring the full campus map, this feature allows you to navigate directly 
to the more detailed building maps for an enhanced view of the alarm area. 

Procedure 84 Configure areas related to other maps 

Step Action 

1 Open target map. This is typically the overview of the whole area you are monitoring, in this case the 
'campus' map. 

2 

3 

4 

Select Icon selector displays. 

Select the Map icon. Icon displays on map. Reposition/resize icon as required. 

Right click the icon. 
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5 Select Drop on Map. Icon editor displays. 

6 Select Select Object. 

7 Select the required map. (This is typically the detailed map - in this case the 'building' map) 

8 Select OK. Icon editor displays. 

9 Assign icon attributes as required. 

10 Select OK. 

11 Right click the map icon. 

12 Select Polygon Shape. 

13 Select Add. Triangle displays. 

14 The area can be manipulated by using the grab handles. Move and resize the triangle as required to represent 
the area covered by the detailed (building) map. Various right click options are available for the shape 
including: 

• Hide this shape drawing 

• Remove this shape drawing 

• Send to back 

• Bring to front 

• Display automatically when in view mode 

15 Click or h 

- End - 

Map Template 
Use the Map Template to create and configure template icons. Any icon created in the Map Template becomes a 
template for icons of the same type. The annunciation and alert color settings from the template icon replace the 
default annunciation and alert color settings for new icons of that type for all new maps. 

Procedure 85 Configure a Template Icon 

Step Action 

1 Select Maps from the Build tab. 

2 Click Show All. 

3 Right click the Map Template. 

4 Click Edit. 

The Map editor opens. 

5 Click a 
The Icon Selector opens. 

6 Click an object icon to add that object to the map. 

7 Right click the icon. 

8 Select Drop on Map. 

The Template Icon Editor opens. 
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9 Click Select Object. 

10 Select an object from the list and click OK. 

11 In the Assign Alert section, configure the annunciation settings as required. 

a Select the Annunciation type for an alert. 
Available options are: None, Strobe, Pulse, Blink, Fade, Solid, Wave, Ripple and Template. 

b In the Color cell, select Custom... from the dropdown menu. 

c Select an alert color from the menu. 
Or 
Select Advanced to choose a color from the advanced color menu. Click OK to confirm color selection. 

Note: 
Object annunciation and color settings are applied to new icons of the same type for all new maps. 
Other template settings are not applied to new icons. 

12 (Optional) Click Reset to default value to restore the default annunciation and color settings for the object. 

13 Click OK. 

14 Click ®or® 
- End - 
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Viewing Maps 
Once a map has been created and saved, it can be viewed directly from the Home tab. 

Procedure 86 View Maps 

Step Action 

1 Select Maps from the Home Tab. 

2 Select the map you wish to view from the dropdown menu. Map opens. 

3 The map can be manipulated using toolbar buttons, as detailed below: 

Element Details 

4••••46-Irri•: rl- k I Zoom controls - displays current zoom level 
percentage along with Fit to Window and 
Zoom Out/In buttons 

Hide Icon Types - opens the Hide Type 
editor which allows selection of icon types 
to hide, e.g. Cameras or Recorders 

I 1 

Show All Icons from All Layers - shows 
and highlights all icons from all visible 
layers. 

Note: icons that are on layers that have 
been hidden using the Map Layers editor 
will not be displayed 

I * 

Show All Shapes from All Layers - shows 
all configured areas from all visible layers. 
Right-click to display FoV or Shapes only. 

Note: areas that are on layers that have 
been hidden using the Map Layers editor 
will not be displayed 

C IC I

Activity List - opens a map specific Activity 
List that displays the 100 most recent 
activities relating to objects on the map. 
Icon will display with a red border when 
there are unread items in the Activity List. 
Right click and select Clear to clear the 
activity list. Select the padlock icon to freeze 
the Activity List for 30 seconds 

..
i 

. 

Layers - opens Map Layers editor allowing 
selection of map layers to show/hide 

Hover Mode - select to enable hover mode. 
When enabled, hovering over objects will 
display additional information. For example, 
hovering over a camera will open a pop-up 
surveillance pane within the map view, 
displaying live video from the camera. Other 
cameras can be dragged and dropped into 
the pop-up windows 

Da ligWerl
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Auto close - this works in conjunction with 
Hover Mode. When auto close is enabled 
the surveillance pane will close 
automatically when the mouse is moved off 
the icon that initiated surveillance pane. If 
hover mode is disabled, auto close cannot 
be selected. This works in both edit and 
view mode. 

Clitutorelose! 

Health Mode - select to enable health 
mode. When enabled, icons will be 
highlighted with their health status. When 
enabled with hover mode, hovering over 
icons will display the objects health 
dashboard within the map view 

Dilieitlet 

Show Text shapes - select to show all text
s on the map. This option is selected 
by default. 

Clulieltei 

Note: 
1. When viewing a map, the toolbar will display green. If the toolbar displays orange, this means that 

the map has been edited and saved since it was opened. Select El to update. 
2. When viewing a map, drag any icon onto any surveillance pane to view its associated video. 

Monitors on Maps 
Monitors can be added as icons to maps either from the device list or from the icon editor within the map. 

Monitor icons are sensitive to dragging and dropping of all objects with a 'view' mode (e.g., cameras} any object 
supporting a 'view' mode can be dropped onto a monitor icon and the associated views will be displayed on the 
physically associated monitor. 

Virtual Matrix and Maps 
A new region located at the top of the map will expand to reveal the active virtual matrix configuration. This 
configuration of monitors will detect mouse movement over the individual panes. When a camera is dropped onto a 
pane, the actual pane in the video wall will render video from that camera. 

Note: 
Virtual Matrix needs to be enabled to use this feature. 

Select III • to display the virtual matrix when in map view. 
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Editing Maps 
Once a map has been created and saved, its properties can be edited. 

Procedure 87 Edit Maps (General) 

tep Action 

1 Select Maps from the Build tab. 

2 Select Show All. 

3 Right Click the map to be edited. 

4 Select Edit. Map editor opens. 

5 Change Name, Description, Enabled status in General section as required. 

6 Select Save. 

- End - 

Procedure 88 Edit Maps (Map) 

tep Action 

1 Select Maps from the Build tab. 

2 Select Show All. 

3 Right Click the map to be edited. 

4 Select Edit. Map editor opens. The map can be manipulated using the toolbar buttons, as detailed below: 

Element Details 

[SI 
Import a map - re import the map 
image 

( : -a

Increase/Decrease height of map 
window 

Fill image in window -fit map to 
window [ I 

J Eli, on load Fill on load -when the map loads, fit 
map to window 

il3 I 
Add Object Icon -add an object icon 
to the map 

n Copy Icon to Active Layer -copy an 
icon to the current active map layer 

O displays 
Show all icons from all layers -

all icons from all layers of the 
map 

-m Show all shapes from all layers -
displays all shapes from all layers of 
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the map. Right-click to display FoV or 
Shapes only 

Active layer - the current active map 
layer 

lei • r Layer° 

Add Text - Displays a field enabling 
free text input. Font size/color/type can 
be changed as required. Text boxes 
can be copied to other areas of the 
map. 

A 

.,-, 
Layers - Show/Hide or Add/Remove 
layers 

likliolte 
Hover - Enable/Disable hover in the 
map editor 

5 Edit map elements as required 

6 Select Save. 

- End - 

Procedure 89 Edit Maps (Map Icons) 

Once an icon has been added to a map, its properties can be edited or copied to create a new map icon. Available 
options vary depending on map icon type. 

Step Action 

1 Select Maps from the Build tab. 

2 Select Show All. 

3 Right Click the map to be edited. 

4 Select Edit. Map editor opens. 

5 Right click on the icon you wish to edit. 

6 Select required option from the right click menu. 

7 Make changes as required. 

Note: 
Selecting Copy from the right click menu will copy both the icon and all its properties (e.g. assigned 
object and assigned left click action) 

8 Select Save. 

- End - 

Display Maps within maps on the same tab 
When a map icon is selected within a map it can be displayed on the same tab. When a second map is navigated to 
within a tab, navigation controls will display on the toolbar. These controls allow navigation between all maps opened 
in the current tab. 
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Procedure 90 Display maps within maps on the same tab 

Step Action 

1 From the map editor, select the map icon you want display on the same tab when selected via left click. 

2 Right click and select Edit 

3 In the Assign left-click action section enable the Open in the same tab checkbox. 

4 Select OK. 

5 Select Save. 

- End - 

Enroll in Health Monitoring 

Procedure 91 Enroll in Health Monitoring 

When enrolled the icon will display health monitoring information when the Health checkbox is selected in view mode. 

Step Action 

1 Select Maps from the Build tab. 

2 Select Show All. 

3 Right Click the map to be edited. 

4 Select Edit. Map editor opens. 

5 Right click on the icon you wish to edit. 

6 Select Enroll in health monitoring to enable or disable the feature. 

7 Select Save. 

- End - 

Field of View 
A Field of View (FoV) can be attached to a camera icon on a map. FoV gives an indication of the area covered by a 
camera. 

Procedure 92 Attach Field of View to Camera Icon 

tep Action 

1 Select Maps from the Build tab. 

2 Select Show All. 

3 Right Click the map to be edited. 

4 Select Edit. Map editor opens. 

5 Right click on the camera icon you wish to attach a FoV to. 

6 Select Field of View (FoV). 
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7 Select Add. The FoV editor opens. 

8 Edit FoV Angle value by selecting El to increase or E to decrease. You can also free type in the Angle 
field. 

9 Edit FoV Rotation value by selecting El to increase or E to decrease. You can also free type in the 
Rotation field. 

10 Edit FoV Scale value by selecting El to increase or E to decrease. You can also free type in the Scale field. 

Note: 
Right clicking the Field of view in edit mode presents various options which can be toggled on/off as 
required 
1. Show FOV control Window 
2. Annunciate with active alert 
3. Hide/remove field of view drawing 
4. Send to back/bring to front 
5. Move shape when icon is moved 
6. Display automatically in view mode 

11 Select OK to apply. 

12 The FoV can be further manipulated by right clicking and selecting from: 

• Show FoV Control Window 

• Annunciate with active alert (this applies to icons where annunciation is set to Strobe, 
Pulse, Blink, Fade, Ripple, Wave or Flash) 

• Hide this FoV drawing 

• Remove this FoV drawing 

• Send to back 

• Bring to front 

• Move shape when icon is moved 

• Display automatically when in view mode 

13 Select Save. 

- End - 

Copy Maps 
An existing map can be copied to create a new map. The new map will be named 'Original Map Name_Copy'. All map 
properties and object icons will also be copied. 

Procedure 93 Copy a Map 

tep Action 

1 Select Maps from the Build tab. 

2 Select Show All. 

3 Right Click the map to be copied. 
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4 Select Save As. A confirmation dialog opens. 

5 Select Yes. 

6 A new map will be created in the object list. 

- End - 
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Object Association 

Introduction 
The concept of Object Association refers to linking together otherwise unrelated objects with the intent of enhancing 
incident building capability. 

The feature enables a 'RevieW option on the context menu of associated objects. Selecting Review opens a guard 
surveillance view displaying the source object and up to 5 associated objects. 

After associations are made, the Review feature is exposed in 3 areas of the client; Reports, Event Viewer and 
Activity List. 

Note: 
1. Objects can reference other objects of the same type but cannot reference themselves. 
2. Certain supported objects E.G., doors, which do not display video, will not display the Guard surveillance view. In 
these cases, a Map view will open displaying the object's location (if configured on Maps). 
3. If a source object has no associations, selecting Review will return a view of the type. 
4. If the source object is a non-video object and has no associations, the review feature will not be available for any 
related events or alerts. 
5. For the feature to function properly, it is recommended all associated objects are synchronized to a common NTP 
server. 

Typical Use Cases 
1 Motion Alarm has been triggered and the associated Event Acknowledged. The user still needs to view video 

associated with the Alarm. 
Without Object Association, reporting capabilities only show you the time of the alarm. The user must open a 
surveillance window, drag in the camera that caused the alarm and navigate back to the time of the alarm 
using the report data. 
With Object Association, the user simply selects the Review option from the report item to perform all the 
above functionality automatically. 

2 Building on Use Case 1, if there are more cameras associated with the alarm. 
Without Object Association the user must find them and drag each camera individually into a surveillance 
window and navigate to the time of the alarm. 
With Object Association, the Review feature launches investigator mode and displays all associated camera 
views. 

3 Similar to 1 and 2 but related to Non Video devices E.G., Doors. If a door is forced and an event activated, 
the feature can be used to view video from associated cameras in the door's vicinity. 
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Review Feature 
The Review option is exposed in 3 areas of the client: 

• Reports: When associations are configured, the source can be accessed from report items by selecting 
Review in the item's context menu. 

• Event Viewer: When associations are configured, behavior is similar to that of Reports but the source is 
the cause of the event. The source can be accessed by selecting Review in the context menu of the 
Event Viewer item. 

• Activity List: When associations are configured, the source of the activity list items can be accessed 
by selecting Review from the context menu of Activity list items. 

Create Object Associations 
You can associate a maximum of 5 objects with any of the classes listed: 

Video Cameras DSC Partition/Zone 

Doors MZX Panel/Point 

Inputs/Outputs Simplex 4100 Panel/Point 

Readers Salvos 

This procedure describes how to associate a video camera with other video cameras. 

Procedure 94 Create Object Associations 

tep Action 

1 Select Device List. 

2 Select next to Recorders to expand the selection. 

3 Select next to the specific recorder. 

4 Right click the camera to be edited. 

5 Select Edit. Camera editor displays. 

6 Expand the Associations section. 

7 Select 0. Object selector displays. 

8 Select the object to associate using the object selector. 

9 Select OK. 

10 Select Save. 

- End - 
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Dynamic Views 

Introduction 
Dynamic Views are generally displayed using the Show All option from an object type's dropdown menu. 

These lists will generally contain at a minimum Names and Descriptions of available objects. Depending on the type 
of object being displayed, more information may be available by right clicking the column headers and displaying extra 
detail. 

Sort/Filter Objects within Dynamic Views 
You can sort objects within Dynamic Views by selecting field names. 

Procedure 95 Sort/Filter Objects within Dynamic Views 

tep Action 

1 Select the required object type from the Setup or Build tab. 

2 Select Show All. Dynamic View displays. 

3 To Sort objects: 

• Select a Column Header to sort by. Objects sort alphabetically. 

4 To Filter Objects: 

a Select the filter icon O  from the required column header for which the data is to be filtered. 

b Select the filter criteria from the dropdown menu. Dynamic View updates to reflect the selected filter. 

- End - 

Custom Filters 
You can apply custom filters to Dynamic Views to help find specific information or limit the scope of a list. 

Procedure 96 Apply Custom Filters 

Step Action 

1 Display the Dynamic View. 

2 Select the filter icon O  from the required column header for which the data is to be filtered. Dropdown menu 
displays 

3 Select Custom. Custom Filter Selection window displays. 

4 Select Add Condition. 

5 Select the operator from the Operator dropdown menu. 

6 Select the operand from the Operand dropdown menu. 

7 Select OK. The Dynamic View updates to reflect the filter criteria. 
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- End - 

Object List - Group by Field 
You can group Dynamic Views by field names using the Group By Area. 

Procedure 97 Object List - Group by Field 

Step Action 

1 Display the Dynamic View. 

2 Select the Group By Area. This is the solid bar under the Dynamic View Controls. Group By Area displays. 

3 Drag column headers into the area. The Dynamic View updates to reflect the grouping. 

4 Use the controls in the Group By Area to manipulate the view. 

- End - 

Export Lists 
You can export Dynamic Views in .XPS and Excel format. 

Procedure 98 Export Object Lists 

Step Action 

1 Display the Dynamic View. Sort and Filter as required. 

2 To export as a .xps document: 

a Select l= Export the Grid. Save As dialog displays. 

b Navigate to the Save in folder. 

c Change name of file as required in the File name textbox. 

d Select Save. .xps file saves in selected location. 

3 To export as an Excel document: 

a Select El Export the Grid to Excel. If Excel is installed, it automatically loads the file. If Excel is not 
installed, a Windows dialog displays - select from the options displayed. 

- End - 
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Create/Save Dynamic Views 
After configuring a Dynamic View to display as required, you can save the view for later retrieval. 

Procedure 99 Create/Save Dynamic Views 

tep Action 

1 Configure the Dynamic View as required. 

2 Select Save the current grid configuration. Create/Save dialog displays. 

3 Enter a name for the view in the Name textbox (Mandatory). 

4 Enter a description for the view in the Description textbox (Optional). 

5 Select the Default checkbox if you require this view to be the default for displaying the dynamic views of this 
object type. 

Note: 
To display a dynamic view which is not set as default, select Dynamic View on the Build tab and 
select Show All. Right click on the view and select Show the view. 

- End - 
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Additional Functions 
Additional functions can be accessed via dynamics views depending on the objects that are being displayed. This 
includes the option to create a new object or assign properties to an object selected in the dynamic view. 

By selecting multiple instances in the dynamic view you can batch edit shared properties. The properties displayed 
will be dictated by the dynamic view in use. 

Procedure 100 Dynamic Views - Set Properties 

step Action 

1 Display the Dynamic View. Sort and Filter as required. 

2 Holding CTRL select the required instances from the dynamic view. 

3 Click the Set Properties icon. 

4 The Set Properties window opens. 

5 Edit the properties as required. 

6 Click M 

- End - 
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Operators 

Introduction 
Operators are users of the client. Each operator is assigned a role which describes their capabilities and privileges. 

Operators are authenticated in one of two ways: 

• Windows Authentication - requires an assigned Windows principal (domain/workstation name and 
usemame) which relates to a Windows OS account. 

• Basic Authentication -The victor Application Server manages users accounts without the need for an 
assigned Windows principal or Windows OS account. 

Two basic authenticated operators, victor guard and victor administrator are preconfigured in the system. 

• victor guard - usemame: GUARD, password: guard, role: Guard. 

• victor administrator - usemame: ADMIN, password: admin, role: Administrator. 

Create a New Operator 
New operators can be added to the system. 

Note: 
In addition to the two basic authenticated accounts, a Windows authenticated installer account is also created. This is 
the Windows principal account which uses the credentials of the logged in user who performed the initial install. 

Procedure 101 Create a New Operator (Windows Authentication) 

When using Windows to authenticate operator accounts, Windows credentials are checked when the operator logs in 
to the client. As such, operators will only be able to log in if they have been assigned a user account on both the client 
and victor Application Server machines. If a domain controller is not being used, these accounts must be created 
manually and be logged into to activate them. 

Note: 
Windows Authentication is not available when using victor Express. 

It is recommended that the role level assigned to the operator account, mirrors somewhat the role level assigned to the 
Windows user account. 

I\ Caution 
Operators created in victor standalone systems with 'non administrator' roles may lack the privileges required to make 
similar changes in unified systems. 

Step Action 

1 Select Operator from the Build tab. 

2 Select New from the dropdown menu. 

3 Enter a name for the Operator in the Name textbox. 
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4 Enter a description in the Description textbox. 

5 The Enabled checkbox is selected by default, to deactivate the operator profile, deselect the checkbox. 

6 Enter Username. 

Note: 
Usemame should correspond to a Windows usemame and should not be the same as the name of 
the PC. 

7 Enter the operator's Email address. 

8 Select Enable Windows Authentication. 

9 Enter Domain/victor Application Server. 

10 Select a Role from the Roles section. 

Note: 
Multiple roles can be assigned to an Operator. Where conflicts occur within the role the lesser 
exception will always take precedent. For example, Role One allows access to Recorder X however 
Role Two denies access to Recorder X. If Role One and Role Two are assigned to the same operator 
access to Recorder X will be denied as per Role Two. 

11 Expand the Layouts section. 

a Select to display the Object Selector. 

b Select a Layout then select OK. 

12 Select Save. 

- End - 

Procedure 102 Create a New Operator (Basic Authentication) 

When using basic authentication to authenticate operator accounts, victor Application Server manages user accounts 
without the need for corresponding Windows user accounts. 

Step Action 

1 Select Operator from the Build tab. 

2 Select New from the dropdown menu. 

3 Enter a name for the Operator in the Name textbox. 

4 Enter a description in the Description textbox. 

5 The Enabled checkbox is selected by default, to deactivate the operator profile, deselect the checkbox. 

6 Select Basic Authentication. 

7 Enter Username. 

8 Enter Password. 

9 Select a Role from the Roles section. 

Note: 
Multiple roles can be assigned to an Operator. Where conflicts occur within the role the lesser 
exception will always take precedent. For example, Role One allows access to Recorder X however 
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Role Two denies access to Recorder X. If Role One and Role Two are assigned to the same operator 
access to Recorder X will be denied as per Role Two. 

10 Expand the Layouts section. 

a Select Q to display the Object Selector. 

b Select a Layout then select OK. 

11 Select Save. 

- End - 

Remotely Log Operator Out of Workstation 
Operators can be remotely logged out of particular workstations on the network. 

Procedure 103 Remotely Log Operator Out of Workstation 

tep Action 

1 Select r next to Workstations in the Device List to expand the selection. 

2 Right click the workstation you wish to log the operator out of. 

3 Select Log Operator [operator username] Out. Warning dialog opens, prompting confirmation of the 
logout. 

4 Select Yes to log the operator out, or No to cancel. 

- End - 

Change Single Sign-on Value 
The log-in window will display at client start up only when the Single Sign-on option is set to 'False'; with Single Sign-
on set to 'True', the Login window is bypassed and the server will rely on the current windows identity credentials from 
the Windows OS to establish a client connection. 
This procedure describes how to change single sign-on values between 'true' and lalse'. 

Note: 
Depending on your UAC settings on Windows 7 the following procedure may vary slightly, you may be notified or 
asked for permission to continue before making changes to the file. 

Procedure 104 Change Single Sign-on Value 

tep Action 

1 Navigate to ACVS.Enterprise.Client.Core.Host.exe.config file on the client machine. The default location 
for this file is CAProgram Files1TycolvictorClient. 

2 Right click the ACVS.Enterprise.Client.Core.Host.exe.config file. 

3 Select Open. Message displays informing Windows cannot open this file. 

4 Select Select a program from a list of installed programs. 
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5 Select OK. Open with...dialog box displays. 

6 Select WordPad from the program list. 

7 Select OK. File opens as a text document. 

8 Change single signon value to 'True or 'False as applicable 

<setting name="StartupAddIns" serializeAs="String"> 

<value /> 

</setting> 

<setting name="SingleSignOn" serializeAs="String"> 

<value Ian /value> 

</setting> 

</ACVS.Enterprise.Client.Core.Host.Properties.Settings> 

</userSettings> 

<system.serviceModel> 

<bindings> 

9 Select Save. 

10 Close Windows. 

- End - 
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Lightweight Directory Access Protocol (LDAP) Support 
LDAP is a protocol used to search Active Directories over IP networks providing extremely fast read/query 
performance for large scale datasets. 

In the victor system it provides a means of managing victor users through Windows (Active Directory) by linking 
Windows user profiles to the victor system automatically. This association means changes made to users and user 
groups in windows are reflected automatically in victor operator profiles and roles. 

LDAP Integration 

victor's LDAP integration is capable of connecting to different LDAP servers (including Active Directory). The 
integration allows victor to simultaneously communicate with different and multiple domains and subdomains inside 
corporate networks for importing LDAP users and groups. 

The integration can import LDAP groups and users from different paths at various hierarchy levels in the directory 
structure and also from individual organizational units created in a LDAP server. 

victor LDAP Server Configuration 

The victor LDAP interface is used to manage operator/user roles and profiles. It is accessible from the Build tab within 
the victor GUI. The interface enables system administrators to configure LDAP servers using a standard victor editor. 
All LDAP configurations are listed in the object's dynamic view- accessed from the LDAP>Show All option in the 
victor Build tab. 

From this list you can use the LDAP configurations context menu to Edit, Delete or Save As: 

Edit 
Opens LDAP Server Configuration and loads the 
corresponding configuration details for editing. 

Delete Deletes the LDAP Server configuration entry 

Save As 
Creates a copy of the existing LDAP Server con-
figuration entry with a '_Copy' suffix 

victor Operator/Role management 

LDAP Users are imported into victor as Operators and LDAP Groups are imported as roles, therefore: 

The User/Group relationship existing in LDAP equates to the Operator/Role relationship in victor. 

victor role/LDAP user relationships: 

Group added/edited/removed Role added/edited/removed 

User added/removed from LDAP group 
Operator associated/disassociated from victor 
role 

Usemame update in LDAP 
Operator name change in victor (this is one way, 
name changes for operator profiles controlled by 
LDAP cannot be changed in victor) 
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User assigned to multiple groups Operator assigned multiple roles 

Roles 

In victors dynamic views of roles, imported LDAP groups are displayed alongside existing corresponding victor roles 
and can be identified by the description text 'Imported role'. 

Note: 
Imported roles are disabled by default. Use the role editor to enable. 

Imported roles do not have Type Exceptions or Object Exceptions assigned, these need to be manually assigned by 
right clicking the Role and editing type exceptions as required. Refer to "Roles". 

Operators 

In victors dynamic views of operators, imported LDAP users are displayed alongside existing corresponding victor 
operators and can be identified by the description text 'Imported User. 

Imported operators do not have roles assigned, these need to be assigned manually by right clicking the operator 
object and editing to assign roles as required. 

Create an LDAP Server Connection 
Setup the LDAP Server connection within victor to allow users and groups to be imported. 
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Procedure 105 
Create an LDAP Server Connection 

tep Action 

1 Select LDAP Server from the Build tab. 

2 Select New from the dropdown menu. 

3 Enter a name for the LDAP Server in the Name textbox. 

4 Enter a description if required in the Description textbox. 

5 The Enabled checkbox is deselected by default, to active the LDAP Server Connection, select the 
checkbox. 

6 Expand the Server Details section. 

a Enter the LDAP Server Name/IP Address in the text box. 

b Enter the Port # in the text box. The default port is 389. 

c Select the Authentication Type from the dropdown list: 

• Anonymous 

• Basic 

If Basic has been selected enter a LDAP User Name and Password in the text boxes. 

d Select the Connection uses SSL Authentication checkbox to enable or disable SSL authentication. 

e Select Connect and verify Authentication to test the LDAP server settings entered. 

7 Expand the Search Configuration section. 

a Enter the Base DN in the text box. This should be the root for the LDAP Server where the search will ini-
tiate. 

b Enter the Search Filter criteria if required in the text box. 

c Select the Search all sublevels below starting point checkbox to enable or disable. 

d Select the Follow referral to other LDAP Servers checkbox to enable or disable. If enabled other 
LDAP Servers are consulted during search operations if needed. 

e Enter a figure for the Maximum number of records per page that will be fetched per . LDAP Server. 

f Enter a figure for the Maximum number of sample records that will be fetched per LDAP Server to dis-
play as a sample. 

g Select Preview sample records to view sample records retrieved from the LDAP Server. 

8 Expand the Scanning and Polling section. 

a Select the required Method to scan changes in LDAP records from the drop-down list: 

• FullScan 

• ActiveDirectoryTimestamp 

b Enter a figure for the Polling Interval in minutes and seconds. 

c Enter a figure for the Wait time between retries in seconds. 

d Enter a figure for the Number of retries in seconds. 

e Select Force sending all records on next cycle to retrieve and overwrite all previously retrieved 
records. 

f Select Fetch updates from LDAP Server now to retrieve records using the supplied settings. 
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9 Expand the Import Settings section. 

a Select the Import LDAP Users checkbox to allow LDAP users to be imported. 

• When selected the Enable Imported Users checkbox can be activated; select this to 
allow the imported LDAP users accounts to be enabled within victor. 

b Select the Import LDAP Groups checkbox to allow LDAP groups to be imported. 

• When selected Assign privileges to Imported Roles from the following Role can be 
used. If required select the corresponding role to associate with the imported 
LDAP Groups. 

10 Expand the LDAPServerlmportResultsHeader_Label section. 

a Select Refresh to update the displayed import information. 

11 Select Save. 

- End - 

View LDAP Server Connections 
To view current LDAP Server Connections . 

Procedure 106 View LDAP Server Connection 

tep Action 

1 Select LDAP Server from the Build tab. 

2 Select Show All from the dropdown menu. Current LDAP Server Connections will be displayed. Status 
displays the current state. 

- End - 

Edit an LDAP Server Connection 
Edit existing LDAP Server connection details. 

Procedure 107 Edit an LDAP Server Connection 

tep Action 

1 Select LDAP Server from the Build tab. 

2 Select Show All from the dropdown menu. 

3 Right click on the LDAP Server and select Edit. The LDAP Server pane will display. 

4 Edit the information required. 

5 Select Save. 

- End - 
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Roles 

Introduction 
A Role is a set of access rules which is assigned to an operator to govern their authorization and permission levels 
within victor. Effective role management enables complete control over the resources and features users can access. 

Be careful of the roles you give users on your system. If you add a user as an administrator, you are granting them full 
system permissions. 

Note: 
Before deleting roles, ensure they are not assigned to operators 

Role Types 

Canned Roles 
There are five predefined (canned) roles, ready for assignment to users. Each of these roles, apart from Administrator 
can be edited to refine them further. Canned roles are as follows (Descending permission level): 

• Administrator 

• Power User 

• Investigator 

• Basic Operator 

• Guard 

• Viewer 

Custom Roles 
As well as using canned roles, you can create custom roles. This can be done using the 'Save As' feature which 
allows a current role to be used as a template to build a new role, or you can build a completely new role manually. 

Each new role created is available for selection when creating or editing operator profiles. 

Type/Object Exceptions 
The level of permissions assigned to a role is controlled by exceptions. 

It is important to understand the difference between Type and Object Type exceptions. 

• Type relates to general groups of objects , e.g. Recorders, Events. 

• Object Exceptions relate to specific objects, e.g.Recorder 'X' or Event T. 
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When a custom role is initially created, full administrative access is granted by default, the role can then be edited to 
define type and object exceptions as required. 

Create Roles 
If a canned role does not meet your requirements, you can create new customized roles. 

Procedure 108 Create a Role 

Step Action 

1 Select Role from the Build tab. 

2 Select New from the dropdown menu. Role editor displays. 

3 Enter a name for the role in the Name textbox. 

4 Enter a description for the role in the Description textbox. 

Note: 
The Enabled checkbox is selected by default, deselect to disable the role. 

5 Expand the Role Access Setup section. 

a Select Consolidate ribbon buttons in one tab to enable or disable the feature. 
When enabled only the buttons/devices made available to the role will be displayed in the Home tab. 

Note: 
Consolidation will only occur if the number of selected functions allows. 

b Select Lock Window from closing to enable or disable the feature. 
When enabled the user cannot close the victor unified client window. 

6 Enable or disable System Access (applies to all devices and buttons): 

Note: 
This option allows you to perform a batch select on all items with one click. However, if for example, 
View All is enabled but you still wish to restrict view access to an individual device, i.e a Recorder 
then it can be restricted within Device Access. 

a Expand the System Access section. 

b Select the associated checkbox to enable or disable access for the role to the following: 

Note: 
Toggling the checkboxes for Allow View All, Allow Edit All, Allow Delete All and Review will remove 
all settings for the role, i.e. types and objects, etc. 

• Allow View All - Enable or disable View access to all objects and types. This will 
remove all menu buttons, tabs and lists apart from Operator, Role and Layout buttons. 

• Allow Edit All - Enable or disable Edit privileges from all objects and types. 

• Allow Delete All - Enable or disable Delete privileges from all objects and types. 

• Review - Enable or disable Review privileges from all objects and types. 

• Still Image Capture - Enable or disable the ability to capture a still image. 
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• Throttle Bandwidth - Enable or disable the ability to throttle bandwidth. 

7 To assign Config Button Access: 

a Expand the Config Button Access section. 

• Select the Select All checkbox to enable or disable view access to all buttons in the 
Config Button Access table. 

• To select multiple items hold Ctrl and left click on the required item. Selecting the Allow 
checkbox will clear the object exceptions for the selected items. 

• Select the Allow View checkbox of the individual item to enable or disable access to 
the button. The item will be removed from the ribbon or menu. 

8 To assign Device Access: 

a Expand the Device Access section. 

• Select the Select All checkbox to enable or disable access to all devices with one click. 

• Select the corresponding Allow View checkbox of the device to allow or deny access to 
the device. 
The exceptions pane title will update with Allow or Denied according to the Allow View 
selection made for the device. 

9 To assign Type Exceptions to a device: 

a Select of the corresponding device. Actions dialog displays. 

b Select the action items checkbox as required to enable or disable the action or Select All. 

c Select OK. 

10 To assign Object Exceptions to a device: 

a Select of the corresponding device. Object Selector dialog displays. 

b Select the required object from the list, the actions available for the device will display. 

c Select the required device in the Name pane. The associated Actions available will display in the Actions 
pane. 

• The list can be sorted by selecting the headings or by entering search criteria in the filter 
textbox. 

• Ctrl + A can be used to select all items. 

• To select multiple items hold Ctrl and left click on the required item. 

d Select the action item checkbox to enable or disable the action. 

• An edited object will have displayed in the modified column. 

e When complete select Close. 

11 Select Save. 

- End - 

Copy Roles 
Existing roles can be used as templates to create new roles which can then be edited. This is useful if you need to 
create a role which is similar to but not identical to an existing role. 
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Procedure 109 Copy a Role 

tep Action 

1 Select Role from the Build tab. 

2 Select Show all from the dropdown menu. 

3 Right click the role to be copied 

4 Select Save As. Really save a copy of the specified object? dialog displays. 

5 Select Yes. A copy of the role is created and displays on the object list. The copied role is identifiable as it 
has the original role name appended with _Copy. 

6 Right click the new role. 

7 Select Edit. 

8 Edit the role as required. 

9 Select Save. 

- End - 

Roles Dynamic View 
The Roles Dynamic View allows you to display the items that are allowed or denied within the role. These are split 
between Type Exceptions and Object Exceptions. Multiple roles can be assigned to an Operator. Where conflicts 
occur within the role, the lesser exception will always take precedent. 

Procedure 110 Role Dynamic View 

tep Action 

1 Select Role from the Build tab. 

2 Select Show all from the dropdown menu. 

3 Right click the role to view. 

4 Select Viewer. View Roles tab displays. 

5 Select El to expand the role properties. 

• Select [I] to expand the Type Exceptions. 

• Select ID to expand the Object Exceptions. 

- End - 
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Events 

Introduction 

General 

An event can be considered as anything significant that happens within your victor system. 

Creating and implementing system events allows you to detect, monitor and record specific activity on the system. 

A typical use may be to use a map action to alert a user of motion detection on a camera covering a sensitive area. 

In this scenario, an event could be configured to: 

• Alert the user by visually triggering a Video Action associated with the event displaying video from other 
cameras in the area 

• Trigger a map action showing the location of the of the camera in alarm state 

• Create a high priority entry in the Journal requiring operator acknowledgment 

Configuration within victor 
Typically an event's triggers and responses rely on the creation of object dependencies within the system which are 
configured using two editors: 

• "Event/Action Pairing Editor" 

• "Events Setup" 

Event Processing 
From a system perspective, event processing can be considered in three stages: 

• Event Source: Emit events into the processing system (e.g., a motion detection alert sent from a camera) 

• Event Processing: Capture, routing and any further processing of emitted events — victor can be configured 
to process events in various ways e.g., according to priority, date/time or source. 

• Event Result: The system reaction to the event. In the case of victor this could be a video action configured 
to display a salvo 
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Conceptual workflow/victor workflow 
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Event Types 
Within the victor environment, there are two main event types: Sensor based and Health based. 

Sensor Based Events 
These events, when triggered typically display predefined Event Actions. These are system actions, tied to events 
which are set to display when events are triggered. Examples of Event Actions can be video Salvos or Map actions. 

The following general steps are involved in configuring a Sensor based event: 

1 Add a trigger to the sensor device (e.g., Set motion detection on a camera) 

2 Create the Event Action to be executed when the Event triggers 

3 Create the Event 

4 Associate the Event Action with the Event 

5 Associate the Event with the Trigger 

Health Based Events 
System Health events do not typically involve video actions as their primary use is not security based. Instead they 
are used to warn users of potential issues with system failure. A typical use may be to inform a user that an alarm has 
been received warning of CPU overheating. 

Acknowledge and Clear Options 
Acknowledge and Clear options can be configured for individual events. Configuring these settings determines 
whether an event requires extra user information to be entered in order to acknowledge or clear the event. 

Options are: 

• Require a Log Message to be entered when acknowledged 

• Require a Log Message to be entered when Cleared 

• Usemame and password required to acknowledge 

• Usemame an password required to clear 

Note: 
These credentials can be from any user who has permission to acknowledge and clear the event. 

Event Templates 
A number of Event Templates are predefined within victor, these can be used as a basis for configuring events of the 
type they relate to. 
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Log Messages 
Log messages are typically used to clear and acknowledge events but can be entered manually written to the joumal 
at any time. 

Log messages can also be selected from a Predefined Message Log which can contain up to 3000 user defined 
messages. 

Event Priority Window 
The Event Priority Window is a surveillance window which is used to view camera Call Up Actions associated with 
Events. The surrounding red border distinguishes the Event Priority Window from standard surveillance views. 

It is a 2X2 configuration. Call up video is displayed according to the priority of the event it is associated with. Highest 
priority displays in the top left pane of the window, descending in priority to Top right, Bottom left and Bottom right. 

New events having a higher priority than those already displayed on will 'Bump' the lower priority windows. This will 
lead to lowest priorities dropping off when more than four streams attempt to display. 

Video streams cannot be viewed in the Event Priority window unless triggered by an event. 

The window must be open when the event triggers in order to view the camera call up; the event does not cause the 
window to open. 

Create Event Actions (Video) 
Event actions are the actions triggered by victor in response to specific events. These can be video actions or Map 
actions. Video actions include: Preset, Clip Retrieval, Salvos, Call ups, External Camera Alarms and Send to Matrix 
Monitor. 

Clip Retrieval 
A video action can be configured resulting in the creation of a clip to be scheduled for download. The clip duration, 
saving location and expiry can all be defined by the user. When a clip retrieval action is activated, it will queue a video 
clip for download. Queued video downloads appear in the Clips list as download tasks. 

To use the Clip Retrieval action, the Media Management Service must be running . 

Procedure 111 Create Event Actions (Video) 

tep Action 

1 Select Video Actions from the Build tab. 

2 Select Video Action type from the dropdown menu. 

3 Select New. Video Action editor opens. 

4 Enter a Name and Description for the video action as required. 

5 Select objects as required from the left pane and drag to the right. 

Note: 
If creating a Salvo video action, choose from Select from Existing or Create New Salvo. 
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6 Click Event Video action is created. 

- End - 

Procedure 112 Create a Clip Retrieval Action 

Note: 
1. Before creating a clip retrieval action, you must configure a Remote Directory from System Values (System 
Values>Clip Preferences>Remote Directory). 
2. In order for clips to successfully download, the 'American Dynamics Media Management Driver Service' must be 
running. This service must also have permissions to write to the directory specified. 

Step Action 

1 Select Video Actions from the Build menu. 

2 Hover over Clip Retrieval. 

3 Select New. 

4 Enter a Name. 

5 (Optional) Enter a Description. 

6 Select a Camera. 

a Click Select. 

b Choose a camera from the Object Selector window. 

c Click OK. 

7 Select clip Duration from the dropdown list. 

8 Select Clip Saving Location from the dropdown list. 

9 (Optional) Set an expiry date for the clip. 

a Select the Enabled checkbox. 

b Click t5 to select an expiry date. 

c Set the expiry time: 
Click on the hours and minutes sections to manually enter time. 
OR 

Use CI and 0 to increment the time value. 

Note: 
If an expiry date is set, the clip will be deleted after the specified time period. 

10 Select the Clip Folder. 

11 (Optional) Create a new clip folder. 

a Right-click on the Clips folder. 

b Select New Folder. 

c Enter a Name for the new folder. 

d Click Ok. 

American Dynamics 127 

EFTA01223936



12 Click to save the action and close the editor. 

- End - 

Procedure 113 Edit a Clip Retrieval Action 

Step Action 

1 Select Video Actions from the Build menu. 

2 Hover over Clip Retrieval . 

3 Select Show All. 

4 Right-click on the clip you want to edit. 

5 Select Edit. 

6 (Optional) Edit the Name. 

7 (Optional) Edit the Description. 

8 (Optional) Select a Camera 

a Click Select. 

b Choose a camera from the Object Selector window. 

c Click OK. 

9 (Optional) Select clip Duration from the dropdown list. 

10 (Optional) Select Clip Saving Location from the dropdown list. 

11 (Optional) Set an expiry date for the clip. 

a Select the Enabled checkbox. 

b Click is to select an expiry date. 

c Set the expiry time: 
Click on the hours and minutes sections to manually enter time. 
OR 

Use CI and 0 to increment the time value. 

Note: 
If an expiry date is set, the clip will be deleted after the specified time period. 

12 Select the Clip Folder. 

13 (Optional) Create a new clip folder. 

a Right-click on the Clips folder. 

b Select New Folder. 

c Enter a Name for the new folder. 

d Click Ok. 

14 Click to save the action and close the editor. 

- End - 
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Procedure 114 Delete a Clip Retrieval Action 

Step Action 

1 Select Video Actions from the Build menu. 

2 Hover over Clip Retrieval. 

3 Select Show All. 

4 Right-click the clip to be deleted. 

5 Select Delete. 

6 Click Yes to delete the action. 

- End 

Clip Download Tasks 

When a clip retrieval is scheduled, a download task appears in the Clips list. Download tasks remain queued in the 
Clips list until the scheduled clip download completes. Clips are downloaded sequentially. Clip downloads that are 
scheduled, or that are in-progress can be cancelled from the clips list. 

Procedure 115 Cancel a Scheduled Clip Download 

Step Action 

1 Open the Clips list. 

2 Right-click on a download task. 

3 Click Cancel Download. 
The download task is deleted. 

- End - 

Create Event Actions (Maps) 
Event actions are the actions triggered by victor in response to specific events. These can be video actions or Map 
actions. 

Map actions can be configured to display when an event triggers to show a map of the event location and highlight the 
alarming object. 

Procedure 116 Create Event Actions (Maps) 

Step Action 

1 Select Display Actions from the Build tab. 

2 Select New from the dropdown menu. Display Map Action editor opens. 

3 Enter a Name and Description for the Map action as required. 

4 Select a Map. 

a Select 'Alt to select from existing maps. Object Selector Displays. 

Or 
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b Select Al to create a new map. Refer to Maps Chapter for further information. 

5 Selec the required map from the object column. 

6 Select OK to confirm the selection or Cancel to Exit. 

7 Selec —I to select Monitor. Object Selector displays. 

8 Select the monitor to display the Map Action. 

9 Click Li

- End - 
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Create Events 
Events can be created and configured from within the client. 

Procedure 117 Create Events 

tep Action 

1 Select Events from the Build tab. 

2 Select New from the dropdown menu. Event editor displays. 

3 Enter a name for the event in the Name textbox. 

4 Enter a description for the event in the Description textbox. 

5 The Enabled checkbox is checked by default, uncheck to disable the event. 

6 Expand the Properties section. 

7 Select the priority of the event from the Priority Dropdown menu. 

Note: 
Each priority level is associated with a color which is made prominent in the Event viewer when the 
event is triggered. 

8 Select Event Breakthrough if required. The default setting is disabled, enabling Event Breakthrough assigns 
priority to the event viewer when the event is triggered so over rides anything else the user is viewing. 

9 Expand the Text Section. 

a Enter Activate Text in the text box. This text will display in the event viewer, If you have the activity list 
open, this text displays as the event triggers. 

b Enter Instructions for the user in the Instructions text box. These will be conveyed to the user when the 
event triggers. 

10 Expand the Sounds section. 

a Select the Play Sound When Active checkbox if an audible alarm is required when the event triggers. 

b Select  I. The Select Sound dialog displays. Navigate to and select the required .wav file. 

c Select Open. The sound is associated with the event and will play when the event triggers. 

d Select OK. 

Note: 
1. Only .wav sound files are supported. 
2. The files must be located in the ...11WINDOWSWIedia folder. If a custom .wav file is required, 
copy it to this location. 

11 Expand the Acknowledge and Clear Options section. Select or deselect checkboxes depending on how 
you require the event to be acknowledged and cleared. 

12 Select Save. 

- End - 
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Events - Save As 
Existing Events can be used as templates to create new events. This is useful if you need to create an event which is 
similar to but not identical to an existing one. The copy of the original event keeps all properties. 

Procedure 118 Events - Save as 

Step Action 

1 Select Events from the Home tab 

2 Select Show All 

3 Right click the event to be copied 

4 Select Save As. The new Event is saved with the original name appended with'-Copy'. The event can be 
edited as required. 

- End - 

Event Configuration 
Using the Event/Action pairing editor and the Event Setup editor, you can build multiple event configurations quicker 
and easier than building single event configurations one at a time. 

Event/Action Pairing Editor 
The Event/Action pairing editor is used to tie together system events with actions you wish to trigger. 

Note: 
Event/Action association can only be made in this editor. 
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Procedure 119 Events/Action Pairing 

tep Action 

1 Select Event/Schedule Setup from the Build tab. 

2 Select Event/Action Pairing from the dropdown. Editor opens. 

3 Click the Events node and use the Object Selector to select events as required. 

4 Select   in the Event node and use the Object Selector to assign event Actions. 

5 Repeat as required. Use  and to add and remove objects. 

6 Select Save. 

- End - 

Events Setup 
The Events/Schedule setup editor provides a dynamic, visual method of batch linking Devices, Alerts and Actions as 
well as to set up event scheduling. 
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Procedure 120 Events/Schedule Setup Editor 

Step Action 

1 Select Event/Schedule Setup from the Build tab. 

American Dynamics 133 

EFTA01223942



2 Select Events/Schedule Setup from the dropdown. Events Setup editor displays. 

3 Double click the Devices node and use the object selector to select the device (Or drag and drop from the 
device list). 

4 

5 

6 Select 

Select At in node of the device added and use the checkboxes in the dropdown to assign alerts as required. 

Select Add Alerts. Selected alerts are displayed under the Alerts node. 

4 in the Alerts node and use the Object Selector to assign Actions. 

7 Repeat as required. Use 4  and [)(  to add and remove objects. 

8 Use merge and clone options as required to copy configurations: 

Merge and clone target configuration 

Duplicate source configuration to all targets 

Remove configuration on source and target 

9 Use [Eisi to add/remove schedules as required. refer to "Scheduling" for more information on using and 
configuring event schedules. 

10 Select Save. 

Note: 
You can configure all system objects of a single type by using the 'Search for Event 
Configurations' and filtering by the required type. 

- End - 

Cloning existing configurations 
Cloning provides a quick and easy way of assigning the Event Setup configuration properties of existing configured 
devices to new devices. 

Note: 
As well as cloning event configurations, the duplicate and merge options offer the ability to clone Alerts and Actions 
only or Alerts and Actions with Schedules. 

In Event Setup, assign existing configurations to new devices by double clicking the device to be cloned and 
selecting from: 

Merge and clone target configuration 

Duplicate source configuration to all targets 

Remove configuration on source and target JX

• Clone (Merge) - Applies the source's device configuration to newly selected devices, keeping any 
existing event configurations 
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• Clone (Duplicate) - Replicates the configuration of the source device and applies it to the new device, 
deleting any existing event configurations. 

• Clone (Remove) - Deletes the source device's event configuration 

Use the Clone Schedules checkbox to include schedules in the cloning operation. 
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Scheduling 
Scheduling is used to manage the execution of events or joumal triggers which are to be activated only during 
specified time ranges. 

Note: 
1. Schedules should be assigned meaningful names to allow for easy identification when assigning them to events. 
2. Schedules are set on a weekly basis by default i.e., a schedule set from 1200 to 1300 on a Tuesday, recurs every 
Tuesday. 

The schedule editors calendar control allows you to select and build schedules by Day, Week (Sunday to-Saturday), 
Work Week (Monday to Friday) and Month. 

Creating Schedules 

Procedure 121 Create a Schedule 

Step Action 

1 Select Schedules from the Setup tab. 

2 Select New from the dropdown menu. Scheduling editor displays. 

3 Enter a name and description for the schedule. 

4 Select the required view (choose the view most suitable for the schedule being created, e.g., if you are 
creating a Monday-Friday schedule, select Work Week. 

5 Build the schedule by clicking and dragging across the required ranges, selecting hours/days as required. 

Click y after each selection to add to the schedule. You can change selected ranges using the grab handles 

to increase or decrease as required. Use X to remove selected intervals. 

6 Select Save. 

- End - 

Applying Schedules 
victor supports assigning schedules to actions through the Event/Schedule Setup editor. Refer to "Events Setup" for 
further information on event configuration. 

Step Action 

1 Select Event/Schedule Setup from the Build tab. 

2 Select Event/Schedule Setup. Event Setup editor displays. 

3 Drag in required device(s) to display event configurations. 

4 Select   on the Action node. A popup displays all available schedules. 

5 Select the required schedules and time zones to apply to the event configuration (Use Add, Remove 
schedules as required). 

6 Select Save. 

Note: 
1. By default an action will trigger at all times. Each Action object will have an 'always on' schedule attached to it. 
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When an action is edited to add a new schedule, the 'always' schedule link attached to the object is removed and the 
specific schedule is linked. 
2. You can assign schedules to all objects in a view by selecting the schedule icon on the column header node. 
3. You can also drag schedules into the event setup editor. This allows you to configure when event configurations are 
Active or Inactive. 

- End - 

Edit Schedules 
The Schedules Show All page allows you to view all existing schedules. From within this page you can edit any given 
schedule's daily occurrences or you can enter each schedule's own editor to change details such as starUend times, 
intervals and ranges. 

Procedure 122 Edit Schedules 

Step Action 

1 Select Schedules from the Setup tab. 

2 Select Show All. All available schedules display with intervals detailed. 

3 To change daily occurrences of schedules: 

a Select '+' next to the schedule 

b Check/uncheck the weekdays as required to change the daily occurrences of the schedule intervals 

4 To edit schedules: 

a Right click on the schedule 

b Select Edit. Schedule editor displays 

c Change Name and Description in the General section 

d Make changes to schedule timings in the calendar section e.g.: 

• Click and Drag time intervals to move them to different times/days 

• Change the schedule scope by selecting DayNVeekNVorkweek/Month 

• Use grab handles on schedules to increase or decrease ranges as required 

• Delete time intervals by selecting and pressing Delete (Option is to delete the single 
occurrence or the whole series) 

• Make schedule ranges 'all day' intervals by selecting and dragging to the top of the cal-
endar 

- End - 

Active/Inactive Schedules 
Whenever a schedule is active i.e., current time is inside its assigned time interval, associated events will be 
triggered, outside of the schedule's time interval, events will not trigger. 

Alerts will continue whether or not the schedule is active. 

The Schedules Show All page allows you to view all schedules by status: Active or Inactive. The page updates 
dynamically as the schedules displayed start and end their assigned time intervals. 
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Event Viewer - (General Information) 
The Event Viewer is a dynamic display of system event activity, accessible from the Home tab. It is a real time list 
displaying active and acknowledged events. 

From the event viewer you can: 

• Acknowledge system events 

• Clear system events 

• Sort events according to priority 

• View event details including instructions, causes and activation time 

• Review associated video 

• Group events by type 
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Note: 
1. When there are 2000+ events in either the Active or Acknowledged panes, paging buttons are displayed 
2. When paging buttons are in use, Acknowledge All and Clear All buttons work on a per page basis 
3. By default, 2000 events per page are displayed, this can be changed to 500 or 100 by selecting the Page Size 
dropdown 
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Event Viewer - Sorting and Grouping 
Using the grouping area of the event viewer, you can 'Multi Level Group' on any of the columns displayed. This means 
you can sort groups by more than one priority. 

Procedure 123 Event Viewer - Sorting and Grouping 

tep Action 

1 Select Event Viewer on the Home tab. Event Viewer displays. 

2 Select the Group By area. Area expands enabling column headers to be dragged into it. 
The Group By area is the solid divider under the object list controls. 

..... 

, 1-.al I. 
• -, i - —•—•.--, 

Group by area 
.fir

3 Click and drag a column header into the Group By area. Groupings update accordingly. 

4 Multi Group the items by adding more column headers. 

Note: 
By default, events are sorted by Name. 

- End - 

Event Viewer - Review Associated Video 
If an active or acknowledged Event has associated video, this can be reviewed by right clicking on the Event and 
selecting Review. An Investigator Mode pane will open displaying associated video. 

• 2.2 \hew x Event Viewer x 
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Event Viewer - Acknowledge/Clear Events 
From the Event Viewer, depending upon role permissions, you can acknowledge and clear events individually or by 
group. 

Depending upon Event settings, you may be required to enter usemame and password or log a message to 
acknowledge and clear events. 

Actions relating to various buttons on the Event viewer are detailed below. 

Button Event Viewer Area Action 

./ Top Level List (Active Pane) Acknowledge all events 

1/4IX Top Level List (Active Pane) Acknowledge and clear all events 

I Top Level List (Active Pane) Freeze/Unfreeze pane 

XI Top Level List (Acknowledge Pane) Clear all events 

Top Level List (Active and Acknowledged 
Panes) Print 

Event Group (Active Pane) Acknowledge all activations in event group 

Event Group (Active Pane) Acknowledge and Clear all activations in 
event group 

x Event Group (Acknowledged Pane) Clear all activations in event group 

ki I Event (Active Pane) Acknowledge individual event 

4X1 Event (Active Pane) Acknowledge and clear individual event 

x Event (Acknowledged Pane) Clear individual event 
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Manually Activate Events 
An Event can be activated manually rather than be activated by a trigger. 

Procedure 124 Manually Activate Events 

tep Action 

1 Select Events from the Build tab. 

2 Select Show all from the dropdown menu. All events display. 

3 Right Click on the event to be activated. 

4 Select Activate. The event will activate and trigger any associated actions. 

- End - 

Predefined Message Log 
Predefined Log Messages can be created which can then be used when required to acknowledge or clear an event 
without needing to type text. 

Messages are identifiable by their labels which are assigned when they are created. 

Labels and message fields are mandatory for every message created. Labels can be up to 100 characters in length 
and messages up to 3000. 

The language for each message can also be assigned, this means when a user logs a message, the messages 
available are filtered to provide current language messages only. To log a message in a different language, you must 
switch language in the client. 

Procedure 125 Create a Predefined Log Message 

tep Action 

1 Select Predefined Message Log from the Build tab. 

2 Select New from the dropdown menu. New Predefined Message editor displays. 

3 Select the Language dropdown. 

4 Select the language in which the message is to be displayed. 

5 Double click the Label textbox. 

6 Enter Label text as required. Double click the Message textbox. 

7 Enter message text as required. 

8 Select O) to add additional messages or "Pl to remove selected messages. 

9 Select Save. 

- End - 
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Layout Templates 
Layout templates are custom layouts which can be opened from Event Viewer to aid Event investigation. 

Procedure 126 Create Layout Template 

Step Action 

1 Select Layout Template from the Build tab. 

2 Select New from the dropdown menu. New Layout Template editor displays. 

3 Enter a Name and optionally a Description for the Layout Template. 

4 Configure Layout Template as required by dragging and dropping layout elements from the left hand pane. 
Layout panes can be closed and moved as required. Add additional layout panes by selecting Add Pane. 

5 Select Save and Close. 

- End - 

Procedure 127 Use Layout Templates 

Once created, layout templates can be opened from the Event Viewer right click menu. This enables easy 
investigation of an incident by opening all required layout components from one click. 

Step Action 

1 Right click on an Active or Acknowledged event in the Event Viewer. 

2 Select the Layout Template to load and the monitor to display it on. Layout Template will load. 

V Medium (1 item) 

Action Name Activation Time Cause 

Mlustra-flex 800 
X layout template event trwr 7174001S T51-71 PM 

Clear 1 ection alert 'Full View' begun for VideoEdge IP Camera 

Move To Active 

Guard 1 Layout Template 

Review 

Add to Sites-

. la Send To cE5 MAIN MONITOR 

la DISPLAY: 

- End - 
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External Applications 

Introduction 
The Add External Applications feature allows users to add shortcuts to the Home tab so external executable files can 
be launched from within victor client. 

A maximum of six external applications can be added. 

Add External Applications 
You can add a new button to the Home tab which launches any external application already installed on the client. 

Note: 
External applications are not retained unless saved as part of a layout. If they are not saved as part of a layout, they 
will not be available if the client is restarted or another layout is selected. 

Procedure 128 Add External Applications 

tep Action 

1 Select Add on the Setup tab. Selector displays. 

2 Navigate to the .exe file of the application to be added. 

3 Select the .exe file. 

4 Select Open. The applications icon displays on the Home tab and the program will launch when the icon is 
selected (Role dependent) 

- End - 

Edit Application Name 
You can change the default name of an external application. 

Procedure 129 Edit Application Name 

tep Action 

1 Right click on the application icon on the Home tab. 

2 Select Edit Properties. Name textbox displays. 

3 Edit the name of the application. 

4 Select OK. 

- End - 
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Remove External Applications 
You can remove external application icons from the Home tab. 

Procedure 130 Remove External Applications 

tep Action 

1 Right Click the Icon on the Home tab. 

2 Select Remove. Icon disappears from the Home tab. 

- End - 
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System Values 

Introduction 
System Values allows you to configure of a range of system wide settings from a single editor. System Values is 
available from the Setup tab. 

Bandwidth Configuration 
victor Client may be deployed in a limited-bandwidth WAN, or on workstations with limited rendering resources. It is 
therefore desirable to minimize the CPU usage on the client PC. 

Bandwidth limits can be assigned to operator and role objects. You can change bandwidth limits for operators and 
roles by double clicking the Bandwidth Limit text boxes and selecting required values from the dropdown. 

You can also choose to preserve either Framerate or Resolution by selecting the appropriate radio button. 

If you choose to Prefer Frame Rate, then the stream of the highest rate in the offered palette that most closely 
matches the desired resolution will be selected. If you choose to Prefer Resolution, then the stream that most 
closely matches the resolution displayed is selected and allow lower frame-rate streams are picked from the palette. 

You can select Always use NVR Preferred Live Stream when no bandwidth cap is set to enable or disable this 
feature. When enabled it will utilize the settings configured on the VideoEdge NVR. 

Clip Preferences 

Edit Default Clip Duration 
Open System Values from the Setup tab, then select Clip Preferences. Set Default Clip Duration from the 
dropdown menu. Available options are: 30 seconds, 1 minute, 5 minutes, 10 minutes, 30 minutes and 60 minutes. 

Edit Clip Saving Locations (Local & Remote Directories) 
Open System Values from the Setup tab, in General, select Clip Preferences. Default Local Directory can be set. 
Default Remote Directory can be set against each role. 

Note: 
Default remote directory can be entered as a mapped drive path, it will be automatically converted into UNC 
(Universal Naming Convention) format. 

Watermarks 
Watermarking allows custom images to be overlaid on clips exported from victor. 

Select System Values from the Setup tab, then select Clip Preferences. 
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Use its' and to load or delete watermark images. Supported image file types: .bmp, .jpg, .gif, .png 

Use the Transparency slider to set watermark transparency (0=Transparent, 100=Opaque) 

Select the Enable Watermarking checkbox to enable watermarking (system wide value) 

Select the Enable Native Support checkbox to allow users to export clips in native format. 

Note: 
1. Clips exported in native format will not have watermark applied. Watermarks can only be applied to AVUMP4 clips 
2. Watermarks images should be created on a transparent background 

Surveillance Record Temporary File Location 
Open System Values from the Setup tab, then select Clip Preferences. Enter the desired file directory for temporary 
files to be created during Surveillance Window Recording, alternatively you can browse for the desired directory by 

clicking Set the Frame Rate from the dropdown menu. 

Clip Builder 
The Clip Builder settings apply to any video clips created, combined or edited through the Clip Builder tool. 

Open System Values from the Setup tab, the select Clip Preferences. 
Select the Show Overlay checkbox to include the camera overlay information in the exported video feed. 

Set Frame Rate from the dropdown menu. Available options are: Low, Autol, 1 FPS, 5 FPS, 10 FPS, 15 FPS, 20 
FPS, 25 FPS, 30 FPS. 
Set Video Resolution from the dropdown menu. Available options are: Auto2, 320 x 200, 640 x 480, 704 x 576, 1920 
x 1080. 

Note: 
1 Set Frame Rate to Auto to maintain the frame rate of the original clip during clip building. 
2 Set Resolution to Auto to maintain the resolution of the original clip during clip building. If a clip contains video 
segments with different resolutions, all video segments are upscaled to match the highest resolution in the clip. 

Media Management Service 
Set the Maximum download queue size for scheduled clip downloads. The default queue size is unlimited. Other 
available queue sizes are: 10, 100, or 1000 downloads. 

Custom Icons 
Using the custom icons feature, you can assign non-default images as object icons. The icons can be assigned at 
both Type and Object level enabling specific objects to have a different icon to the object type. 

Supported file types: JPG and PNG. 

Maximum supported file size: 2MB 

Procedure 131 Assign Custom Icons 
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Step Action 

1 Select System Values from the Setup tab. System Values editor displays 

2 Select Custom Icons. Type and object selectors display. 

3 To assign custom icons at type level: 

a Select the type from the Type dropdown. Default icons display. Multiple icons may display for each 
object type as the icons reflect object state. 

b Select Change for the relevant icon. Open dialog displays. 

c Navigate to and select New icon graphic. 

d Select Open. New icon displays next to the object type. 

e Select Save. 

4 To assign custom icons at object level: 

a Select off. Object Selector displays. 

b Navigate to the object. 

c Select OK. New icon displays next to the object type. 

d Select Save. 

Note: 
Once Custom Icons have been applied, all client areas displaying object states (device list, site list, 
maps, etc.) should be refreshed to show updated icons. 

- End - 

Database Settings 
Various database archive settings can be configured using System Values database settings editor. These settings 
are applied to the victor Application Server Microsoft SQL database. 

Database Settings - Archive 
Apply settings relating to archiving of your Microsoft SQL databases. 

Note: 
1. Archive threshold size can only be edited when using SQL Server Express 
2. UNC (Universal Naming Convention) should be used when entering Archive directory backup path, e.g. 
Ilservemamelfolder) 

Database Settings - Editor Properties 
By default, editors in victor display with 'expanders' dividing different sections of the editor. These can be hidden 
completely or replaced with tabs. 
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Database Settings - Events 
Set the maximum number of uncleared events permitted for the system as a whole or an individual event. 

Note: 
System wide event settings do not apply across upgrades. All active Events should be acknowledged and cleared 
before upgrading. 

Database Settings - Swipe and Show 
Apply settings relating to Swipe and Show in a Unified environment. 

The number of seconds before a card swipe to start video rewind for facial recognition and The number of 
seconds before a card swipe to stop video rewind for facial recognition allow assigning of a value in seconds to 
account for camera placement should the individuals face not be captured when the card swipe is registered. 

Discovery Preferences 
Use this editor to configure victor Autodiscovery settings. 

Device Discovery values are used to configure general system device discovery behavior 

• Discovery Enabled - Select to enable/disable discovery mode 

• Startup Delay - Time interval the client waits after startup before entering discover mode 

• Poll Frequency -Time interval defining how often victor polls for discoverable devices 

For each device type you can configure: 

• Discovery Enabled - Select Enable to have victor display discovered devices of that type. Select 
Disable to prevent victor discovering devices of that type 

• Dynamic Discovery Ranges -Used for every device type except VideoEdge, if this is unchecked you 
should provide an IP and Port range in which to search 

• IP Address Range • Address range in which victor will search for that device type 

• Port Range • Port range in which victor will search for that device type 

• Edge Device Discovery Enabled • Check to enable discovery of Edge cameras 

• Multicast Address • Used for passive listening (VideoEdge only) 

• Multicast Port • Used for passive listening (VideoEdge only) 

Double Password Protection 
Double password protection adds an additional level of security across selected victor global functions, or selected 
individual objects. When attempting to access functions or objects that have double password protection enabled, the 
user will be prompted for the Usemame and Password of a second operator. 

Open System Values from the Setup tab, then select Double Password Protection. Check required features to 
globally protect or select objects using the Object Selector to protect individual objects. 
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Note: 
In the case of conflict, object protection will override global function protection. 

Email Preferences 
Email settings can be configured in order to use the send still images feature. 

Open System Values from the Setup tab, then select Email Preferences. Enter required information and save. 

Note: 
1. SMTP - Simple Mail Transfer Protocol 
2. FQDN - Fully Qualified Domain Name 

Health Monitoring Preferences 
Color coding for Health Alerts displayed on the Health Dashboard can be edited as required, you can determine the 
severity level by selecting the corresponding color code. 

The dashboard uses color coding to indicate the health status of devices, the default settings are: 

• Green - Normal 

• Yellow -At Risk 

• Orange - Pre-Failure (Also applies to failover VideoEdge NVRs not currently in use) 

• Red - Device Alert 

• Gray - Unknown State 

Procedure 132 Change Color coding for Heath Dashboard Alerts 

tep Action 

1 Select System Values from the Setup Toolbar. 

2 Select Health Monitoring Preferences. The Alert Preferences editor displays. 

3 Select the device to display the corresponding Alerts. 

4 The Severity can be edited by selecting a different color option from the drop-down list for the corresponding. 
This will be displayed on the Health Dashboard. 

5 Select Save. 

- End - 

Journal Filter 
The Journal Filter is used to regulate the amount of data being persisted to the victor Application Server database by 
blocking/unblocking specific alert types. 

Video Camera, Recorder Unit and Storage alerts can be blocked/unblocked, everything else will always be written to 
the database. 
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Procedure 133 Using the Journal Filter 

tep Action 

1 Select System Values from the Setup Toolbar. 

2 Select Journal Filter. The Journal Filter editor displays. 

To Add Type Exceptions: 

a Select O in the Type Exceptions section. The Type selector dialog displays. 

b Select the Device Type to be filtered. 

c Select OK. 

d Select the Type Exception. The row highlights blue. 

e Select the Alert Category. 

f Block or Unblock Alerts as required. 

To Add Object Exceptions: 

a Select O1in the Object Exceptions section. The Object selector dialog displays. 

b Select the Object type as required. The type's objects display to the right. 

c Select the Object(s). Use Select All/Clear All as required for multiple selections. 

d Select OK. 

e Select the Object Exception. The row highlights blue. 

f Select the Alert Category. 

g Block or Unblock Alerts as required. 

Note: 

1. You can use to Remove Type/Object exceptions as required. 
2. To edit exceptions, select the exception and block/unblock alert types as required. 

3 Select Save. 

- End - 

POS Settings 
When POS is installed, POS Settings are available and allow for configuration of default search settings and database 
management. 

Open System Values from the Setup tab, then select POS Settings. Here, database settings can be configured, 
along with the amount of time (in seconds) to be added as padding to search results. 

Search Preferences 
Search preferences can be configured to customize which lists ($ite/DeviceNault) open with the Search and Retrieve 
Wizard, and which list opens on top. 
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Open System Values from the Setup tab, then select Search Preferences. Select checkboxes under Wizard to 
choose which lists open with the Search and Retrieve Wizard. Select which list to open on top using the buttons under 
Top Most. 

Text Stream allows selections to be made for the number of seconds before and after that should be used when 
performing transaction searches. 

Select one of the Search Results options to choose the position of search and retrieve results in relation to the 
surveillance pane. 

Option Description 

Beside (Default setting) Search and retrieve results appear below the surveillance panes. 

Below Search and retrieve results appear beside the surveillance panes. 

Automatic 
Selecting Automatic forces the Beside option to be used when the surveillance 
pane has a 16:9 aspect ratio; if the surveillance pane has a 4:3 aspect ratio, the 
Below option is used. 

Video Layout Preferences 
Video Layout Preferences allow configuration of which layouts are available for selection. 

Open System Values from the Setup tab, then select Video Layout Preferences. By default, all layouts are 
selected. Layouts that are selected are available for selection from the surveillance pane, virtual matrix and salvo 
editors. 

Custom Layout Designer 

Overview 

Use the Custom Layout Designer to create, save and edit custom surveillance layouts. When a custom layout is 
created, the number of rows, columns and aspect ratio can be defined. Layouts can be customized by merging panes, 
splitting panes or deactivating panes. Images can be applied to surveillance panes, allowing for custom / corporate 
branding. 

Procedure 134 Create a Custom Layout 

Step Action 

1 Select the Setup tab. 

2 Select System Values. 

3 Select Video Layout Preferences. 

4 In the Custom Video Layouts section, Press Add. 

5 Enter a Name. 
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Note: 
Layout names are limited to 12 characters in length. 

6 (Optional) Enter a Description. 

7 Choose an existing layout as a template. 

a Select an existing layout from the dropdown menu. 

Or 

Create a layout. 

a Click   to set the number of rows (Min: 1, Max: 8). 

b Click 'Il l to set the number of columns (Min: 1, Max: 8). 

c Click to set the layout orientation (Standard, Widescreen or Portrait). 

d Click to generate the layout. 

8 (Optional) Merge cells. 

Note: 
Cells can only be merged into square-shaped or rectangular-shaped groupings. 

a Select the cells that you want to merge. 
Selected cells are highlighted with a yellow border. 

b Click 

9 (Optional) Split merged cells. 

a Right-click on a merged cell. 

b Select Split Cell. 

c Select the number of rows. 

d Select the number of columns. 

Note: 
Merged cells can only be split as far as the original component cells. A cell cannot be divided further 
than itself. 

e Click OK. 

Note: 

Alternatively, merged cells can be split using the (split horizontal) and El (split vertical) 
buttons. 

10 (Optional) Deactivate Cells. 

a Right-click on a cell. 

b Select Deactivate Cell. 
The cell color changes from black to blue. 
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Note: 
Camera feeds cannot be displayed in deactivated cells. 
To reactivate a cell, right-click on a deactivated cell and select Activate Cell. 

11 (Optional) Add an image to a cell. 

a Right-click on a cell. 

b Select Add Image. 
A Windows Explorer window opens. 

c Select the image you want to add. 

d Click Open. 
The image appears in the cell. 

Note: 
Images can be added to active cells, deactivated cells and to merged cells. 
Camera feeds cannot be displayed in cells that contain images. 

12 (Optional) Set cell ID order. 

a Click to assign cell ID numbers. 

Note: 
Only active cells are assigned an ID number. 

b Swap Cell ID numbers by selecting two cells sequentially. 

c Click Finish. 

Note: 
To reset cell ID order, repeat steps 12a - 12c. 

13 Click to save the file and close the custom layout editor. 

- End - 

Procedure 135 Edit a Custom Layout 

Step Action 

1 Select the Setup tab. 

2 Select System Values. 

3 Select Video Layout Preferences. 

4 In the Custom Video Layouts section, right-click on a layout. 

5 Select Edit. 

6 (Optional) Edit the Name. 

Note: 
Layout names are limited to 12 characters in length. 

7 (Optional) Enter a Description. 

8 (Optional)Add an image to a cell. 
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a Right-click on a cell. 

b Select Add Image. 
A Windows Explorer window opens. 

c Select the image you want to add. 

d Click Open. 
The image appears in the cell. 

Note: 
Images can also be added to deactivated cells and to merged cells. 
Camera feeds cannot be displayed in cells that contain images. 

9 (Optional) Deactivate Cells. 

a Right-click on a cell. 

b Select Deactivate Cell. 
The cell color changes from black to blue. 

Note: 
Camera feeds cannot be displayed in deactivated cells. 
To reactivate a cell, right-click on a deactivated cell and select Activate Cell. 

10 Click ti--)1 to save the file and close the custom layout editor. 

- End - 

Procedure 136 Import a Custom Layout 

Step Action 

1 Select the Setup tab. 

2 Select System Values. 

3 Select Video Layout Preferences. 

4 In the Custom Layouts section, press Import. 

A Windows Explorer window opens. 

5 Navigate to the required file directory. 

6 Select the layout 

7 Click Open. 

- End - 

Procedure 137 Export a Custom Layout 

Step Action 

1 Select the Setup tab. 

2 Select System Values. 

3 Select Video Layout Preferences. 
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4 In the Custom Layout section, right-click on a layout. 

5 Select Export. 
A Windows Explorer window opens. 

6 Navigate to the export destination. 

7 Click Save. 

- End - 

Procedure 138 Delete a Custom Layout 

Step Action 

1 Select Setup tab. 

2 Select System Values. 

3 Select Video Layout Preferences. 

4 In the Custom Layout section, right-click on a layout. 

5 Select Delete. 

6 Click Yes. 

- End - 

Video Preferences 
Open System Values from the Setup tab, then select Video Preferences. 

Surveillance Preferences 
• Stop Video and Audio when not visible-when selected, audio and video will only be streamed when 

tab or window is visible. When a tab or window is not visible, video and audio streaming will be stopped. 

Note: 
Having multiple tabs or windows streaming video and audio will increase system and network 
resources and reduce performance. 

• Display times in UTC -when selected, displays time in Universal Coordinated Time. 

• Show virtual PTZ picture in picture-when selected, a picture in picture of the full camera view will be 
displayed when virtual PTZ is active. 

• Hide virtual PTZ picture in picture after 5 seconds -only available when the above option is 
enabled, when selected the picture in picture of the full camera view will be hidden after 5 seconds of 
virtual PTZ being active. 

• Display FPS on surveillance-when selected, current Frames Per Second will be displayed in the 
surveillance pane. 

• Display FPS on clip playback -when selected, current Frames Per Second will be displayed when 
playing back a clip. 
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• Enable Hardware Decoding - select to enable hardware decoding. You must be using victor unified 
client under a user account which has Windows Administrator privileges or this selection will be 
unavailable. 

• Use dark theme for surveillance -when selected, a dark theme will be used in surveillance panes. 

• Include only primary DB for timeline data - select to restrict Event data on the timeline to only the 
primary database, Event data in archived databases will not be included. 

• Maximum number of consolidated event icons displayed on the timeline-set the maximum 
number of consolidated event icons to display on the timeline. 

Fisheye Lens Default Settings 
Default behavior when using Fisheye lens should be set here. Use the dropdown menus to select default de-warped 
mode - 'Rectilinear or 'Panoramic'. 

Third Party Application 

Set which third party application should be used to edit still images. Select   then navigate to the executable file 
(.exe) for the preferred image editor. 

Video Overlay Preferences 
Set font size and color for video overlay in relation to Camera/Recorder and Date/Time information. 

Frame Expiry Preferences 
This setting uses values from 1 to 20 seconds. In limited bandwidth environments, setting the value allows you to tell 
victor how long the system should wait for the next 'good' frame before displaying a blank frame. 

Select the Never Expire checkbox to ensure no blank frames are ever displayed 

VideoEdge stream connection timeouts 
These settings are used to define the timeout periods (in seconds) for Rtsp Lan Timeout, RTSP Wan Timeout and 
Rtp Lan Timeout. Enter the required value in the corresponding fields. 

Video Recorder 
Open System Values from the Setup tab, then select Video Recorder. 

Time Difference Monitoring 
When enabled, victor will poll recorders to ensure time is synchronized between recorders and the victor Application 
Server. Select the Enable Monitoring Checkbox and set the Poll Period (Hours). If time becomes unsynchronized, 
victor will generate an alert. 
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Recorder Connections 
Select the Allow Communications checkbox to enable processing of communications between recorders and the 
victor Unified Client. 
Adjust the Default Recording Monitoring Level slider to enable or disable processing of different types of recorder 
information. 

Monitoring Level Effect 

Off No data polling or alarm handling takes place 

Basic Enables communication state polling and any core functionality provided by the recorder 
(for example, vaulting or archiving) 

Alarm/Status Enables alarm processing 

Device Configuration Enables data polling, name changes, camera settings, new or removed devices. 

Advanced Enables any functionality not covered by earlier levels (for example, event recovery) 

Alert Configuration 
Set the Minimum camera alert duration (Seconds). While a camera alarm is active, additional alerts relating to this 
alarm will not be generated until the Minimum camera alert duration has expired. If the alert duration is set to 0, an 
alarm will generate multiple alerts while the alarm is active. 

VideoEdge Port Setup 
LAN streaming can require a large number of User Datagram Protocol (UDP) ports to be open. Configuring port ranges 
in System Values (VideoEdge Port Setup) enables traffic to pass through networks with restricted port 
configuration. 

Note: 
Restricting ports can also help to make your system more secure. 

Default values are: 

victor Client UDP port range:Start 6000 End 7999 

VideoEdge server UDP port range:Start 32200 End 38199 
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victor Application Server 

Introduction 
The victor Application Server incorporates an industry-standard relational database (Microsoft SQL Server) used to 
manage and maintain a single record of: 

• Authorized users/passwords 

• Associated recorders and cameras 

• Roles and permissions 

• Alarm and event journals 

• Client license status 

• C•CURE 9000 configuration in a Unified environment. 

Only one instance of victor Application Server is required per site regardless of the number of recorders, clients or 
cameras connected. It can be installed on the same PC as the client for smaller sites or on a separate server for larger 
sites. 

The victor Application Server stores data relating to operator profiles, role information, objects, object status and who, 
and what interacts with your video network. 

Up to twenty victor Application Servers are supported per client, connecting to one at a time. victor Application 
Servers can be added, deleted and edited using the victor Application Servers editor on the Build tab of victor client. 

Add a new victor Application Server 
You can Add, Edit and Delete victor Application Server records using the server editor. 

Note: 
Each victor Application Server installation supports up to 20 records. 

Add a new victor Application Server 

Procedure 139 Add a new victor Application Server 

Step Action 

1 Select victor Application Servers from the Build tab. 

2 Select Edit from the dropdown menu. victor Application Servers editor displays. 

3 Select 0. New blank record is created in victor Application Server list. 

4 Double click the Display Name text box. 

5 Enter a Name for the victor Application Server. 

6 Double click the IP Address/Domain Name text box. 
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7 Enter IP Address/Domain Name as required. 

8 Double click the Port textbox. 

9 Enter the Port number as required (Port numbers 1026-65535 are supported). 

10 Select the Default radio button if the new victor Application Server is to become the default. 

Note: 
The default victor Application Server refers to the server that the client automatically connects to 
when single sign on is turned ON. This is the server which will display first on the victor Application 
server list on the login dialog. 

11 Select Save. 

- End - 

Add a new victor Application Server via the Client Sign in dialog 
You can add a victor Application Server from the client sign in dialog if required. 

Procedure 140 Add a new victor Application Server via the Client Sign in dialog 

Step Action 

1 Double click the victor unified client icon on the desktop. The client sign in dialog displays. 

2 Select Add. The Create Site Manager dialog will display. 

3 Enter a Display Name for the application server in the text box. 

4 Enter the IP Address/Domain Name in the text box. 

5 Enter the Port number as required (Port numbers 1026-65535 are supported). 

6 Select OK. 

7 The new victor Application Server can be selected from the dropdown. 

8 Select Authentication Method the operator uses from the dropdown - Windows or Basic. 

9 Enter Username. 

10 Enter Password. 

Note: 
Blank Password are not accepted 

11 Select OK to Login or Cancel to Exit 

- End - 

Edit victor Application Server 
You can Add, Edit and Delete victor Application Server records using the server editor. 

Procedure 141 Edit victor Application Servers 
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Step Action 

1 Select victor Application Servers from the Build tab. 

2 Select Edit from the dropdown menu. Server editor displays. 

3 Double click in relevant textboxes to edit values. 

4 Select Save. 

- End - 
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Switch victor Application Server 

Procedure 142 Switch victor Application Server 

You can switch the victor Application Server which victor client is connected to. 

Step Action 

1 Select — from the client title bar. Operator log out dialog opens. 

2 Select Log out. The client sign in dialog opens. 

3 Select or enter the Domain from the Domain pull-down menu. 

4 Enter Usemame in the usemame text box. 

5 Enter Password in the password text box. 

6 Select the victor Application Server to switch to from the dropdown. 

7 Select OK. 

- End - 

Change Default victor Application Server 

Procedure 143 Change default victor Application Server 

You can change the default victor Application Server victor client connects to. 

Step Action 

1 Select victor Application Servers from the Build tab. 

2 Select Edit from the dropdown menu. A list of all servers displays. 

3 Select the Default radio button of the victor Application Server you wish to make default. 

4 Select Save. 

Refer to Save and Close options for more information. 

5 Close and restart victor client. You will now connect to your selected default victor Application Server. 

- End - 
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Delete victor Application Server 
You can delete victor Application Server records from the system 

Note: 
The default victor Application Server cannot be deleted. 

Procedure 144 Delete victor Application Servers 

Step Action 

1 Select victor Application Servers from the build tab. 

2 Select Show Allfrom the dropdown menu. 

3 Right click on the server to be deleted. 

4 Select Delete. Are you sure you want to delete the specified object warning displays. 

5 Select Yes to delete or No to cancel. 

- End - 
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Databases 
victor Application Server contains several databases storing data about all aspects of your system: 

• ACVSCore - contains data about objects (e.g. cameras, recorders, operators etc.) 

• ACVSJournal - contains activity data about objects in victor. 

• ACVSAudit - contains data about object creation, modification and deletion in relation to victor. 

• ACVSBIRS - contains information to support BIRS reporting. 

• ACVSPOS - contains data about the victor Point of Sale feature. Only available if feature installed. 

• SWHSystemAudit - contains data about object creation, modification and deletion in relation to 
C•CURE 9000. 

• SWHSystemJournal - contains activity data about objects in C•CURE 9000. 
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Database Backup/Restore 
The database backup/restore feature provides a means to collect, save and restore system data. You can backup an 
existing Tyco database or restore a database from a specified folder location for the system SQL instance. 

The Backup/Restore tab is split into 2 sections - the upper section is used for Database Backup procedures, the lower 
section for Restore procedures as shown below: 
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Procedure 145 Backup/Restore databases 

Step Action 

1 Open the Server Configuration Application. 

2 Select Backup/Restore tab. 

To Backup a database: 

a Select the required database(s) using the checkboxes next to each database (double click required). Or 
select All Databases using the topmost checkbox. 

b Choose the Destination Folder to host the backup (you can select the default SQL folder or specify an 
alternate folder). 

c Select Backup database(s). (Backup progress is indicated during the operation). If operation is 
successful a dialog displays stating Backup(s) complete. 

d Select OK. 

To Restore a database: 

a Open the Server Configuration Application. 
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b Stop the Crossfire framework Services in the Services tab. 

c Select Backup/Restore tab. 

d Choose the Source Folder which hosts the required backup (you can select the Default SQL folder or 
specify an Alternate folder). 

Note: 
If an alternate location is used, you need to specify the location and click Refresh Backup List to 
display available backups in that location. 

e If required, use the Display Options control to view and filter available databases. 

f Select Refresh Backup List to display available backups. 

g Select the required database(s) using the checkboxes next to each database (double click required). Or 
select All Databases using the topmost checkbox. 

h Select Restore Selected Databases. Confirmation dialog displays. 

Note: 
1. If Framework services have not been stopped (step b) an error dialog will display instructing you to 
stop the services and try again 
2. A warning dialog displays informing of potential data loss due to the restore. 

i Select OK (Backup progress is indicated during the operation). If operation is successful a dialog dis-
plays stating Restore(s) complete. 

A Caution 
The Restore Backup procedure overwrites ALL current victor system data. 

- End - 
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Vault 

Introduction 
The vault feature provides the ability to protect media items (audio and video) from VideoEdge NVR (v4.24-) recorders. 

Vaulting an item applies a rule to a specific segment of media, tagging it as protected and preventing it from data 
culling. 

Media can typically be vaulted from: 

• Direct Export (Clips) 

• Event Viewer-via Export Clip 

• Activity List -via Right Click Investigate 

• Search Result List - via Clip Export 

• Map Viewer-via Export Clip 

Note: 
Vault option is disabled when non supported recorders are selected and when both non supported and supported 
recorders are selected, a warning message is displayed. 

Vault List 
All vaulted items are listed in the vault list. 

From the vault list you can: 

• Drag items into the Search and Retrieve wizard and use the vault criteria as a basis for a search. This 
selects the camera and date and time 

Note: 
1. If a subsequent vaulted item belonging to the same camera is dragged into the search and retrieve 
wizard, it replaces the original selection and changes the search time frame accordingly. 
2. If the vault item belongs to a different camera, a Yes/No dialog displays offering the option to 
override the timeframe and have both cameras selected. 
3. You can also drag cameras and/or dates from the vault list into the wizard. This means one 
camera can contain multiple vaults. In these instances the time range is changed to have a start time 
of the earliest vault time and an end time of the latest. 

• Drag items into a surveillance pane in which the items are treated as cameras 

• Double click items to launch investigator mode, paused at the item's start time 

Hovering on each level of item in the Vault list displays a summary of what is contained in the level below. 
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Procedure 146 Display the Vault List 

tep Action 

1 Select Clips from the Home tab. 

2 Select Vault List from the dropdown menu. 

- End - 

Vault Explorer 
The Vault Explorer provides a means to filter vaulted items by Recorder, camera and time range. 

It lists all recorders containing vaulted items, branching for each camera with vaulted data. 

Procedure 147 Locate items using the Vault Explorer 

tep Action 

1 Select Clips from the Home tab. 

2 Select Vault Explorer from the dropdown menu. Vault Explorer displays. 

3 Recorder Filter Section - Select the checkbox for each of the recorders to filter by. Cameras that are 
associated with the selection and have vaulted media display in the Camera Filter section. 

4 Camera Filter Section - Select the checkbox(es) for each camera to filter by. 

5 Select: 

a Date/Time Filter - Select either Recorder Local or UTC. 

b Date/Time Filter - Select Use Filter if required. 

c Select Start and End time and Dates. Results display in Results section. 

- End - 
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Incident Management 

Introduction 
Incident management can be used to manage information relating to an incident or event, for example a robbery or 
disturbance. Information in the form of clips, still images, report data, report charts, user entered notes, spreadsheets 
or external files can be compiled into a single package which can then be exported using a template to provide a report 
on the incident for review. 

Note: 
The review of external files requires a compatible 3rd party application. 

Incident Management consists of a four stage process: 

1 Creating an Incident 

2 Populating the Incident 

3 Clip stitching / clip combining 

4 Generating a Report 

Creating an Incident 
New Incidents can be created using the Incident Management icon on the Home tab. Incidents can be renamed or 
deleted from the Incident List. 

Procedure 148 Creating an Incident 

Step Action 

1 Select Incident Management from the Home tab. 

2 Select New Incident from the dropdown menu. 

The New Incident window opens. 
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M Incicknt 

Title New Incident 

IncideM Saving locabon 
victor unified client 
Remote location (Administrator) 

Incident Fader 

Meg.: 

Indents 

X 
 • 

3 Enter a bespoke Title in the field. 

4 Select the Incident Saving Location from the available list. 

Note: 
Local path restricts access to the workstation. 

5 (Optional) Select v to expand all items in the incidents tree. 

6 (Optional) Enter a Filter criteria in the field. Click tog clear the filter 

7 Click Li 

The Incident will appear in the Incident List. 

- End - 

Procedure 149 Filtering the Incident List 

Step Action 

1 Select Incident Management from the Home tab. 

2 Select Show all from the dropdown menu. 

The Incident List opens. 

3 Enter a Filter criteria in the field. Click 0 to clear the filter. 

- End - 

Procedure 150 Sorting the Incident List 

Step Action 
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1 Select Incident Management from the Home tab. 

2 Select Show all from the dropdown menu. 
The Incident List opens. 

3 Click 
The order menu appears. 

4 Select the order criteria: 

a Select Name, Size, Creation Date or Date Modified. 

b Select Ascending Order or Descending Order. 

c Select Show Local Incidents, or select Show Remote Incidents, or select both. 

Note: 
Order preferences are stored between sessions. 

- End - 

Procedure 151 Renaming an Incident 

Step Action 

1 Select Incident Management from the Home tab. 

2 Select Show all from the dropdown menu. 

The Incident List opens. 

3 Right-click the required Incident from the list. 

4 Select Rename Incident. 

5 Edit the name as required. 

6 Click Ok. 

- End - 

Procedure 152 Deleting an Incident 

Step Action 

1 Select Incident Management from the Home tab. 

2 Select Show all from the dropdown menu. 

The Incident List opens. 

3 Right-click the required Incident from the list. 

4 Select Delete Incident. 

A dialog box displays stating the Incident will be deleted and all of its components. 

5 Click Yes. 

- End - 

American Dynamics 170 

EFTA01223979



Populating an Incident 
Once an Incident has been created, it can be populated via the Incident List or using the Save to Incident button. 
Incidents can contain the following items - 

• Notes 

• Clips 

• Images 

• Spreadsheets 

• Imported files 

Populating an Incident using the Incident List 
The Incident List displays all created incidents and can be used to populate the created incidents with notes, clips, 
images, spreadsheets and imported files. 

Procedure 153 Populating an Incident from the Incident List - Adding a Note 

Step Action 

1 Select Incident Management from the Home tab. 

2 Select Show all from the dropdown menu. 

The Incident List opens. 

3 Right-click the required Incident from the list. 

4 Select Add Note. 

The Incident Management Text Editor opens. 

ps Player x  'Inca• anagement x 

[M Title security Alert 1 

Replace 

B I / 
a y.  Match Case E Use Wildcard 

If-I I-If -II -

Item Description 

1 Save & Close / Save 

2 Note Title (Incident name by default) 

3 

Font tools - 

• Bold 
• Italic 
• Underline 
• Strikethrough 
• Double strikethrough 

4 Paragraph tools - 
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Item Description 

• Remove Indent 
• Add Indent 
• Left alignment 
• Center alignment 
• Right alignment 
• Full justify 
• Increase font size 
• Decrease font size 

5 Find / Find and Replace 

6 Match Case (Use to refine results from Find / Find and Replace 
action 

7 

Use Wildcard (use of a Like Operator) allows pattern matching for 
string comparison: 

Characters in pattern vs Matches in string 

?- Any single character 
• - Zero or more characters 
# - Any single digit (0-9) 
[chartist] - Any single character in charlist 
[!challist] - Any single character not in charlist 

8 Redo and Undo 

5 Create the Note as required using the Incident Manager Text Editor. 

6 Click or Fri
- End - 

Procedure 154 Populating an Incident from the Incident List - Adding a Clip 

Step Action 

1 Select Incident Management from the Home tab. 

2 Select Show all from the dropdown menu. 

The Incident List opens. 

3 Right-click the required Incident from the list. 

4 Select Add Clip. 

The Clip Picker window opens. 
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V Op Fikker 

v Filter: I 
a AN Oen 

InCident 1 

OX 

5 (Optional) Select N. to expand all items in the clips tree. 

6 (Optional) Enter a Filter criteria in the field. Click to N clear the filter. 

7 Select the required clip. 

The Note editor displays. 

V Clip Picker 

filter. X 
4 * Clips 

; Incident 

Incident I 

Note:  Video Clip Details MI 

Incident : 

VI i'll*

Note: 
Selecting the dropdown arrow next to a clip will expand the clip to display the associated device(s). 

8 (Optional) Enter text in the Notes field as required, select Ni

9 (Optional) Select the Video Clip Details tab to view information regarding the selected clip. 
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10 Click 1m or 

V Clip Picker ka,.1-0.. 

Fitter 

• # Clips 

Incident 

x 

Incident 1 

Nets Video Clip Dear 

UPSood Dace 0000 
16/041201570:1404 

Start 'rime 
27/04/201510:1235 (B51

End Tine 
27/04/20151412:40 (851) 

Duration 
C000135 

Saved by 
NN 

Size 
Ll MB 

Recorder 

x 

- End - 

Clip Builder 

Overview 

Use the Clip Builder edit and combine video clips into a single playable video stream. Clip Builder supports the 
following clip editing features: 

• Clip splitting 

• Clip cropping 

• Clip cutting 

The built/edited clip can then be played back within the Clip Builder. Alternatively, the clip can be exported for 
playback in the Incident Player. 

Procedure 155 Editing a Clip in the Clip Builder 

Note: 
Clip building does not support audio content. 

Step Action 

1 Select Incident Management from the Home tab. 

2 Select Show all from the dropdown menu. 
The Incident List opens. 

3 Expand the Clips folder. 
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4 Right-click on the clip that you want to open in the Clip Builder. 
The context menu appears. 

5 Select Clip Builder. 
The clip opens in the Clip Builder window. 

6 Edit the clip as required using the toolbar buttons. 

Action Description Steps 

Set a 
marker 

Places a marker at the selected position in the 
video timeline. 

1. Click and drag the playhead to the desired position on the 
video timeline. 
2. Click the button at the top of the playhead. 
A marker appears at the bottom of the timeline. 

Click to add a 
marker to the 

umelone
Playhead 

Pe? Pm PR 

Marker 

Select Highlights a section of the video clip: 

1. Set a start marker. 
2. Set an end marker. 
The section of the video 
selected. 

clip between the two markers is 

4 

Selected area is 
highlighted blue 

Split Split the clip into two separate clips: 

1. Drag the playhead to the section of the video timeline where 
you want to split the clip.

2. Click to split the clip. 

Cut Cut footage from the clip: 
1. Select a section of the video clip. 

2. Click to cut the footage from the clip. 

Crop 

Retains the selected video and removes any 
video Crop footage from the clip. 

Note: Cropping a clip does not remove video 
from other clips on the same timeline. 

1. Select a section of the video clip. 

2. Click to crop any unselected footage from the clip. 
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Action Description Steps 

Delete Removes the selected video from the timeline. 
1. Select a section of the video clip. 

2. Click to delete the selected footage from the clip. 

Add clips Adds the selected clip to the timeline. 1. Open the Clips folder from the Incident Management page. 
2. Drag a clip from the Clips folder to the timeline bar. 

7 Click MI 
The Build Menu appears. 

8 Click Build to build the clip with Clip Builder. 

a Drag the clip from the thumbnail bar to the incident list or to the clip list. 

9 (Optional) Click Direct Action to build the clip with Direct Clip Action. 
The Direct Clip Action window appears. 

a Click Save to save the clip to the clips list. 

b Click Save to Incident to save the clip to an incident. 

- End - 

Procedure 156 Clip Combining 

Note: 
Clip combining does not support audio content. 
Clip combining can be accessed from the Incident list, from search results, from analytics results, or from bookmarks. 

Step Action 

1 Navigate to the Clips folder. 

2 Holding CTRL select the clips that you want to combine. 

3 Right-click on one of the selected clips. 
The context menu appears. 

4 Select Export clips. 
The Direct Clip Action window appears. 

5 Select the Combine Output checkbox. 

6 Click Export. 

7 (Optional) Use t and to reorder the clips in the list. 

8 (Optional) Select the Include source checkbox to export the source clips in addition to the combined clip. 

9 Click Next. 

10 (Optional) Choose the Export Location. 

11 Select Export. New dialog displays from where you can define Export locations, Passphrases, Export 
Options and Notes. 

12 Select Export Location(s) textbox: 

• Select [0 ] to add export location(s). 
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• Select to select the export location(s). 

• Select P1 to remove export location(s). 

13 If required, select the Export victorPlayer checkbox. For more information on victorPlayer, refer to Incident 
Management 

14 If required, select the Specify Filenames checkbox. This allows you to enter user friendly filenames for the 
clips. 

15 If required, select the Notes tab and add text as required. 

16 Select Export. If Specify Filenames was previously selected, proceed to Step 23. If Specify Filenames 
was not selected, export begins. 

17 Enter filename as required in the Filename textbox. 

18 Select Export. Progress bar displays showing progress of export. 

19 Select Finish. 

- End - 

Procedure 157 Populating an Incident from the Incident List - Import Clipboard Image 

Note: 
A clipboard image is one which is currently copied to the workstation clipboard, for example a screen shot. 

Step Action 

1 Select Incident Management from the Home tab. 

2 Select Show all from the dropdown menu. 

The Incident List opens. 

3 Right-click the required Incident from the list. 

4 Select Import Clipboard Image. 

The Direct Clip Action window opens. 
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5 Edit the text in the Image Name field. 

6 (Optional) Click C )  to create a new Incident. 

a Select Incident Management from the Home tab. 

b Select New Incident from the dropdown menu. 
The New Incident window opens. 

c Enter a bespoke Title in the field. 

d Select the Incident Saving Location from the available list. 

e (Optional) Select V to expand all items in the Incidents tree. 

f (Optional) Enter a Filter criteria in the field. Click to 

g Click NI
The Incident will appear in the Incident List. 

X clear the filter 

7 (Optional) Select N. to expand all items in the Incidents tree. 

8 (Optional) Enter a Filter criteria in the field. Click tog clear the filter 

9 Select the required Incident. 

10 (Optional) Select the Open Incident List on Completion checkbox. 

11 Click Save. 

12 Click Finish. 

- End - 

Procedure 158 Populating an Incident from the Incident List - Import Clip 

Step Action 

1 Select Incident Management from the Home tab. 

2 Select Show all from the dropdown menu. 

The Incident List opens. 

3 Right-click the required Incident from the list. 

4 Select Import Clip. 

A Window Explorer window opens. 

5 Navigate to the required file directory. 

6 Select the clip. 

Note: 
Only clips in native (.ISO, IMG, ZIP and MP4) format are supported. 
Media files in unsupported formats cannot be added to the clips list, but they can be added to the 
incident list as a third-party file. These media files can be included in an incident export, and are 
playable on third-party video players. 

7 Click Open. 

- End - 
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Note: 
Clips can also be imported by dragging a clip from Windows Explorer onto a clips folder or onto an incident folder. 

Procedure 159 Populating an Incident from the Incident List - Import Image 

Step Action 

1 Select Incident Management from the Home tab. 

2 Select Show all from the dropdown menu. 

The Incident List opens. 

3 Right-click the required Incident from the list. 

4 Select Import Image. 

A Window Explorer window opens. 

5 Navigate to the required file directory. 

6 Select the image. 

7 Click Open. 

- End - 

Procedure 160 Populating an Incident from the Incident List - Import Spreadsheet 

Step Action 

1 Select Incident Management from the Home tab. 

2 Select Show all from the dropdown menu. 

The Incident List opens. 

3 Right-click the required Incident from the list. 

4 Select Import Spreadsheet. 

A Window Explorer window opens. 

5 Navigate to the required file directory. 

6 Select the spreadsheet file. 

Note: 
Only Excel format spreadsheets are supported. 

7 Click Open. 

- End - 

Procedure 161 Populating an Incident from the Incident List - Import File 

Step Action 

1 Select Incident Management from the Home tab. 

2 Select Show all from the dropdown menu. 

The Incident List opens. 
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3 Right-click the required Incident from the list. 

4 Select Import File. 

A Window Explorer window opens. 

5 Navigate to the required file directory. 

6 Select the file. 

7 Click Open. 

• End - 

Populating an Incident using the Save to Incident Button 
The Save to Incident button can be used during several functions within the client to populate the created incidents 
with clips, images, reports, Dynamic Views, maps and heat maps. 

When selected the Save to Incident button :L'2. will launch a configuration window allowing you to specify which 
incident the item should be added a long with several other options. 

Note: 
Reports, journal entries, maps and heat maps can only be added to an incident using the Save to Incident button. 

Clips 

During clip creation, clicking Save to Incident will launch a new page in the Direct Clip Action window to associate that 
clip with a new or a pre-configured incident. 

Procedure 162 Populating an Incident using the Save to Incident Button - Clips 

Step Action 

1 Prepare the clip using the Clip Creation tools. 

2 When the Direct Clip Action window opens, click Save to Incident. 

The Save to Incident page displays in the Direct Clip Action window. 
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V Direct CIO Action !o! s i

Audio Clop Name 

O I Combined Output Clip 

l0 l li Save to the clip list 

-• filter: Ei g Clip Saving Location 

• :ri, inodens 
iii• m NB Incident 

victor unified client 
Remote Locabon (Administrator) 

CV Folder 

O•r Filter: Liti iiii 
• as Clips 

.7. Clips sub-folder 

re Clips - August 2015 

il Open Incident List On Completion Pavia's El 1=1 

3 (Optional) Select the Audio checkbox to include audio with the clip. 

4 Edit the Clip Name as required. 

5 (Optional) Click to create a new Incident. 

a Select Incident Management from the Home tab. 

b Select New Incident from the dropdown menu. 
The New Incident window opens. 

c Enter a bespoke Title in the field. 

d Select the Incident Saving Location from the available list. 

e (Optional) Select N. to expand all items in the Incidents tree. 

(Optional) Enter a Filter criteria in the field. Click top clear the filter 

g Click 
The Incident will appear in the Incident List. 

6 (Optional) Select N. to expand all items in the Incidents tree. 

7 (Optional) Enter a Filter criteria in the field. Click tog clear the filter 

8 Select the required Incident. 

9 (Optional) Select the Save to the clip list checkbox. 

a Select the Incident Saving Location from the available list. 

b (Optional) Select N. to expand all items in the clips tree. 

c (Optional) Enter a Filter criteria in the field. Click tog clear the filter. 

d Select the required saving location. 
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10 (Optional) Select the Open Incident List on Completion checkbox. 

11 Click Save. 

12 Click Finish. 

- End - 

Images 

During still image capture, clicking Save to Incident will launch a new page in the Direct Clip Action window to 
associate that image with a new or a pre-configured incident. 

Procedure 163 Populating an Incident using the Save to Incident Button - Images 

Step Action 

1 Prepare the image using the Still Image Capture tools. 

2 When the Still Image Capture window opens, click 

The Direct Clip Action window opens. 

YD 
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3 Edit the Image Name as required. 

4 (Optional) Click to create a new Incident. 

a Select Incident Management from the Home tab. 

b Select New Incident from the dropdown menu. 
The New Incident window opens. 

c Enter a bespoke Title in the field. 

d Select the Incident Saving Location from the available list. 

e (Optional) Select V to expand all items in the Incidents tree. 

f (Optional) Enter a Filter criteria in the field. Click to x clear the filter 
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g Click ri 
The Incident will appear in the Incident List. 

5 (Optional) Select v to expand all items in the Incidents tree. 

6 (Optional) Enter a Filter criteria in the field. Click tog clear the filter 

7 Select the required Incident. 

8 (Optional) Select the Open Incident List on Completion checkbox. 

9 Click Save. 

10 Click Finish. 

- End 

Image Editor 

Overview 

The Image Editor allows the user to crop and highlight/mark images to better illustrate the suspect/issue. The 
following image editing features are supported by victor Unified Client: 

• Crop image 

• Add text to image 

• Add an object to image (Available objects: Line, rectangle, ellipse) 

Edited images can be saved to incident folder. The incident will contain both the original image and the modified 
image. Users can view or revert to the original image by selecting the relevant option from the context menu. 

Procedure 164 Editing an Image 

Step Action 

1 Expand the Images folder in the incident list. 

2 Right-click on the image you want to edit. 

3 Select Open Image. 

4 Edit the image as required using the toolbar buttons. 

Element Name Action 

IL Undo IIIL To undo an action, click 

A Redo To redo a recently undone action, click A 

mode U Cursor Click i Rl to set your mouse pointer to cursor mode. 

View Full 
Image 

ii.:;1 
Click to view the full image within the image editor window. 
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Element Name Action 

N Crop image 1. Click #I
2. Click, hold and drag the mouse cursor to highlight the area to be cropped. 
3. Release the mouse button to crop the image. 

O Add text 
1. Click ill 
2. Click on a point in the image where you want to add text. 
3. Enter text. 
4. Click Ok. 

Font sty
le 1. Click the Font style box. 

2. Select a font style. Afial a 

Font size 1. Click the Font size box. 
2. Select a font size. 24 . 

Add an ellipse 

1. Select color from the dropdown menu. 
2. Select line style from the dropdown menu. 
3. Drag the line thickness slider to set line width. 
4. (Optional) Select the Fill checkbox to make the shape a solid object. 

5. Click  
6. Click and drag the ellipse to the desired shape. 
7. Release the left mouse button to create the ellipse. 

OI 

Add a 
rectangle 

1. Select color from the dropdown menu. 
2. Select line style from the dropdown menu. 
3. Drag the line thickness slider to set line width. 
4. (Optional) Select the Fill checkbox to make the shape a solid object. 

(0 1 
5. Click L_I 
6. Click and drag the rectangle to the desired shape. 
7. Release the left mouse button to create the rectangle. 

O I 

Add a line 

1. Select color from the dropdown menu. 
2. Select line style from the dropdown menu. 
3. Drag the line thickness slider to set line width. 

ED 
4. Click I \ I
6. Click and drag the line to the desired shape. 
7. Release the left mouse button to create the line. 

Line color 1. Click the Line color box. 
2. Select a line color. 

Li

Line style 1. Click the Line style box. 
2. Select a line style. 

thickness Move the slider to adjust the line thickness for an object. O Line 

Fill object 

Select the Fill object checkbox to create a solid rectangle or an ellipse, instead 
of a shape outline. 
Note: This option can only be selected for an Ellipse or Rectangle with a Solid 
Line style. 

r Fill 

Note: 
The Line color, Line style, Line thickness and Line object settings must be modified before creating an object. 
These settings cannot be modified for existing objects. 
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5 Click to save the image and close the image editor. 

- End - 

Reverting to an Original Image 

The original version of an image is stored in victor, alongside the edited version of that image. To revert to the original 
image at any time, select this option from the context menu. 

Procedure 165 Reverting to Original Image 

Step Action 

1 Expand the Images folder in the Incident List. 

2 Right-click on the image. 

3 Click Revert to Original Image. 
A popup window appears. 

4 Click OK. 

- End - 

Procedure 166 Viewing an Original Image 

Step Action 

1 Expand the Images folder in the incident list. 

2 Right-click on the image. 

3 Click Open Original Image. 
The original version of the image opens in the Image Editor. 

Note: 
When you open the original image, the image editing features are disabled. 

- End - 

Procedure 167 Open an Image externally 

Step Action 

1 Expand the Images folder in the incident list. 

2 Right-click on the image you want to open externally. 

3 Select Open Externally from the context menu. The image opens in Windows Photo Viewer. 

- End - 

Reports 
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Generated reports can be saved to an incident using the Save to Incident button. Reports can be saved as 
spreadsheets or images (if visualized). 

Note: 
Reports and data visualization will display results in the date and time of the local client. 

Procedure 168 Populating an Incident using the Save to Incident Button - Reports 

Step Action 

1 Execute the report using the Report Search tools. 

2 To save a report spreadsheet to an incident - 

a When the report is generated, click in the Reports and Data Visualization window. 

The Direct Clip Action window opens. 

V Direct Clip Action 

Spreadsheet Name 

Video Clip Activity 9.8-2015 • 9.8-2015 

0 

Filter: N
. - Incidents ••• 

4.4,, NB Incident 

I i Open Incident List On Completion &ICI 

b Edit the Spreadsheet Name as required. 

c (Optional) Click to create a new Incident. 

i. Select Incident Management from the Home tab. 

ii. Select New Incident from the dropdown menu. 
The New Incident window opens. 

iii. Enter a bespoke Title in the field. 

iv. Select the Incident Saving Location from the available list. 

v. (Optional) Select N. to expand all items in the Incidents tree. 

vi. (Optional) Enter a Filter criteria in the field. Click top clear the filter 
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vii. Click 
The Incident will appear in the Incident List. 

d (Optional) Select v to expand all items in the Incidents tree. 

e (Optional) Enter a Filter criteria in the field. Click to ^I clear the filter 

f Select the required Incident. 

g (Optional) Select the Open Incident List on Completion checkbox. 

h Click Save. 

i Click Finish. 

3 To save a visualized report image to an incident - 

a Click  la  to visualize the report. 

b Select Customize. 

c Click  40 
The Direct Clip Action window opens. 

V Direct C hp Actaan 

Image Name 

10 
cater: X I 

• NB Incident 

Open 'Nagar% fist On COmpleban Saw Can 

d Edit the Image Name as required. 

e (Optional) Click le to create a new Incident. 

i. Select Incident Management from the Home tab. 

ii. Select New Incident from the dropdown menu. 
The New Incident window opens. 

iii. Enter a bespoke Title in the field. 

iv. Select the Incident Saving Location from the available list. 
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v. (Optional) Select N. to expand all items in the Incidents tree. 

vi. (Optional) Enter a Filter criteria in the field. Click tog clear the filter 

vii. Click M 
The Incident will appear in the Incident List. 

(Optional) Select N. to expand all items in the Incidents tree. 

g (Optional) Enter a Filter criteria in the field. Click 
ton

 clear the filter 

h Select the required Incident. 

i (Optional) Select the Open Incident List on Completion checkbox. 

Click Save. 

k Click Finish. 

- End - 

Dynamic Views 

Dynamic views can be saved to an incident using the Save to Incident button. Dynamic views are saved as 
spreadsheets. 

Procedure 169 Populating an Incident using the Save to Incident Button - Dynamic 
Views 

Step Action 

1 Navigate to the required dynamic view. 

2 Select the entry you want to include in the generated spreadsheet. 

3 Click I :O1

The Direct Clip Action window opens. 

4 Edit the Spreadsheet Name as required. 

5 (Optional) Click to create a new Incident. 

a Select Incident Management from the Home tab. 

b Select New Incident from the dropdown menu. 
The New Incident window opens. 

c Enter a bespoke Title in the field. 

d Select the Incident Saving Location from the available list. 

e (Optional) Select V to expand all items in the Incidents tree. 

(Optional) Enter a Filter criteria in the field. Click tog clear the filter 

g Click LI_ 
The Incident will appear in the Incident List. 

6 (Optional) Select N. to expand all items in the Incidents tree. 
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7 (Optional) Enter a Filter criteria in the field. Click to X clear the filter 

8 Select the required Incident. 

9 (Optional) Select the Open Incident List on Completion checkbox. 

10 Click Save. 

11 Click Finish. 

- End - 

Maps 

Maps can be saved to an incident using the Save to Incident button. Maps are saved as images. 

Procedure 170 Populating an Incident using the Save to Incident Button - Maps 

Step Action 

1 Navigate to the required map. 

2 Right click the entry you want to view. 

3 Click View. 

The map opens in a new tab. 

4 Click ":•C' 

The Direct Clip Action window opens. 

5 Edit the Image Name as required. 

6 (Optional) Click C )  to create a new Incident. 

a Select Incident Management from the Home tab. 

b Select New Incident from the dropdown menu. 
The New Incident window opens. 

c Enter a bespoke Title in the field. 

d Select the Incident Saving Location from the available list. 

e (Optional) Select V to expand all items in the Incidents tree. 

f (Optional) Enter a Filter criteria in the field. Click to iXI clear the filter 

g Click t_l_ 
The Incident will appear in the Incident List. 

7 (Optional) Select N. to expand all items in the Incidents tree. 

8 (Optional) Enter a Filter criteria in the field. Click tog clear the filter 

9 Select the required Incident. 

10 (Optional) Select the Open Incident List on Completion checkbox. 

11 Click Save. 

12 Click Finish. 
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- End - 

Heat Maps 

Heat maps can be saved to an incident using the Save to Incident button. Heat maps are saved as images. 

Procedure 171 Populating an Incident using the Save to Incident Button - Heat Maps 

Step Action 

1 Generate the required heat map. 

I H 
2 Click 

The Direct Clip Action window opens. 

3 Edit the Image Name as required. 

4 (Optional) Click to create a new Incident. 

a Select Incident Management from the Home tab. 

b Select New Incident from the dropdown menu. 
The New Incident window opens. 

c Enter a bespoke Title in the field. 

d Select the Incident Saving Location from the available list. 

e (Optional) Select V to expand all items in the Incidents tree. 

f (Optional) Enter a Filter criteria in the field. Click tog clear the filter. 

g Click
The Incident will appear in the Incident List. 

5 (Optional) Select N. to expand all items in the Incidents tree. 

6 (Optional) Enter a Filter criteria in the field. Click tog clear the filter 

7 Select the required Incident. 

8 (Optional) Select the Open Incident List on Completion checkbox. 

9 Click Save. 

10 Click Finish. 

- End - 

Generating a Report 
Once an incident has been populated with all the required components, it can then be exported for viewing on other 
PCs. During this export process a report can also be generated using a Microsoft Word template file. The following 
templates are supplied as default: 

• BOLO (Be On the Look Out) Report - Includes a date and timestamp, actions required and associated 
images which have been added to the incident, i.e. still images for example a headshot. 
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• Media Clip Report - Includes a date and timestamp, summary of the incident, hyperlinks to the 
associated media clips, journal reports, files, lists of actions required, and images. 

• Blank Template - Doesn't include a date and timestamp but includes all items in the incident. 

Note: 
Files, spreadsheets and clips are listed as hyperlinks within the blank template. 

Procedure 172 Exporting an Incident 

Step Action 

1 Select Incident Management from the Home tab. 

2 Select Show all from the dropdown menu. 

The Incident List opens. 

3 Right click the incident you want to export. 

4 Select Export Incident. 

The Direct Clip Action window opens. 

V Direct Clip Action 

Hap F:\ 

Available Templates 

Incident Components 

v Filter: 

184.2 ME. 

Blank Template 

• 44 Security Alert 
• — Clips 

Package Left 
• - Images 

Area Map 
Suspect 

Report Order 

Area Map 
Package Left 
Suspect 

Preview IFancei 

5 (Optional) Edit the export directory. 

a Hover over the export directory field. 
Option icons display. 

F: 184.2 MB 

b (Optional) Click O to add additional directory locations for exporting the Incident multiple times. 

American Dynamics 191 

EFTA01224000



c Click   to choose an export directory using windows explorer. 

Or 

Enter the directory location in the field. 

6 Select the required template from the Available Templates dropdown. 

7 (Optional) Select v to expand all items in the Incidents tree. 

8 (Optional) Enter a Filter criteria in the field. Click tog clear the filter. 

9 Select the required components of the incident(s) to export. Click and 0 

from the report. Items can also be removed by selecting the item and clicking 

to include or exclude items 

10 Click and to change the order each component will appear in the report. 

11 (Optional) Click Preview to view a preview of the generated report. 

12 Click Export to export the files and generate the report. 

A folder will be created in the export location containing the generated report and associated files. 

• End - 

Viewing Incident Components using victor 
Incidents and their components can be viewed in the Incident List at any time. The method of viewing will depend on 
the selected file type: 

• Clips - Double click or right click > Playback Clip to view the clip. victor clips player launches providing 
playback control and so on. 
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■ - us • 4k Si fillS i tile EP a_ 

Item Description 

1 Layout selection 

2 Launch Investigator Mode 

3 Clip Creation and Export tools 

4 Cropped Still Image Capture 

5 Save Clip 

6 Enable / Disable Audio 

7 Launch / Close Timeline view 

8 Clip Progress Indicator 

9 Playback Controls 

• Images - Double click or right click > Open Image to view the image. Images will be opened in the 
default application assigned in Windows. 

• Notes - Double click or right click > Open Note to view the note. Notes will be opened in the Incident 
Management Text Editor. 

• Spreadsheets - Double click or right click > Open Spreadsheet to view the spreadsheet. Spreadsheets 
will be opened in the default application assigned in Windows. 

• Files - Double click or right click > Open File to view the file. Files will be opened in the default 
application assigned in Windows for the selected file type. 
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Note: 
When a default application has not been assigned for Images, Spreadsheets and other file types, you will be prompted 
to select an application via Windows. 
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Video Wall 

Introduction 
The Video Wall feature uses Client to Client Communication to enable layout components to be sent between 
displays attached to different workstations. 

Note: 
1. Client to Client communication is a licensable feature. 
2. Because victor Express is limited to a single client connection, Client to Client communication is not available. 

In order to send components to a receiving client, the component must be open on the sending client, therefore the role 
of the sender must allow viewing of the layout component. Similarly the receiver's role must allow viewing of the 
component. 

Typically, components are sent between workstations using the 'Send To' feature of an object's context menu. 

Configure Client to Client Communication (Workstations) 
Client settings for client to client communication are configured in the workstation editor. These settings determine 
how a workstation behaves when a client to client request is sent/received. 

There are four main settings: 

Setting Description 

Local Removal After Sending 

This controls whether components sent from a 
workstation remain open on the sender's 
workstation. 
Default is On 

Turn Off Client to Client Communication 

This controls whether a workstation automatically 
accepts or rejects requests. When selected, 
receiving workstations will not automatically 
accept components. 
Instead, the sender is informed that the receiving 
workstation is configured to reject and asked 
whether to force the component. 
If the component is forced, the receiver is asked 
whether to accept the request and select Yes or 
No. 
The Sending workstation is informed that the 
receivers client to client communication is turned 
off in 2 ways: 
• A Reject Dialog displays when attempting to 

send. 
• Receiver's Name highlights Red. 
Default is Off 

Maximize on Primary Monitor 
This controls whether a received component 
displays Full Screen. 
Default is On 
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Agent 

When Using the Send To feature, users need to 
navigate to displays via their attached 
workstations. 
Configuring a workstation as an Agent means the 
displays attached to the workstation appear as 
local displays in relation to senders workstations 
so the workstation level is avoided. 
Default is Off 

Procedure 173 Configure Client to Client Communication 

tep Action 

1 Select Devices from the Home tab. Device List displays. 

2 Select next to Workstations in the Device List. All workstations are listed. 

3 Right Click on the workstation to be edited. 

4 Select Edit. Workstation editor displays. 

5 Expand the Client to Client Communication section. 

6 Select or Deselect the Checkboxes as required to configure the workstation. 

7 Select Save. 

- End - 

Configure Client to Client Communication (Displays) 
You can Turn off Client to Client communication for individual displays. 

When selected, this option rejects all client to client requests automatically. The sender is informed that the receiver is 
configured to reject the request and asked whether to force it. In this case the receiver is asked whether to accept the 
request and is presented with a Yes/No dialog. 

The sending workstation is informed if a receiving workstation is in Reject mode in two ways: 

• A 'Rejecting' dialog displays next to the display when attempting to send 

• The receivers display name highlights red, indicating client to client communication is turned of for that 
display 

Procedure 174 Configure display client to client settings 

tep Action 

1 Select I next to Workstations in the Device List. All workstations are listed. 

2 Select next to the workstation which is attached to the display to be edited. 

3 Select next to Monitors. 

4 Right click the display to be edited. 

5 Select Edit. The display editor opens. 

6 Expand the Client to Client Communication section. 

7 Select/Deselect the Turn off Client to Client Communication checkbox as required. 
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8 Select Save. 

- End - 
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Virtual Matrix 

Introduction 
Virtual Matrix allows users to switch video in display panes of surveillance windows using a CCTV keyboard as if the 
video panes were all monitors attached to a traditional analog matrix. 
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5 6 7 8 

9 10 11 12 

13 14 I5 16 
Vowel 567nOts 1 

27 II 19 20 

21 22 23 24 

25 28 27 26 
29 30 31 32 

— 1 J . , tea 

Create a Virtual Matrix Profile 
You can define and add virtual matrix profiles to the system. 

Procedure 175 
Create a Virtual Matrix Profile 

49 50 61 52 

53 54 SS 56 

A 58 93 60 
II 62 63 64 

949.19 Menlo!. 

step Action 

1 Select Virtual Matrix from the Build tab. 

2 Select New from the dropdown menu. Virtual Matrix Editor displays. 

3 Enter a Name and Description in the General Section. 

4 The Enabled checkbox is selected by default, deselect to disable the virtual matrix. 

5 Expand the Settings Section. Select checkboxes as required for 
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• Monitor Number Overlay - Select if monitor numbers are to be displayed in the Virtual 
Matrix 

• Override User Layout - Select if you require the activation of the Virtual Matrix to close 
any existing camera views. 

6 Expand the Cameras Section. All available cameras are listed and assigned default virtual numbers. 

7 If required, renumber cameras: 

To renumber a single camera: 

a Select the camera row 

b Change the virtual number in the renumber cameras textbox 

c Select Selected 

d Repeat as required for subsequent cameras 

To renumber a range of cameras 

a Select the renumber cameras textbox 

b Enter the first number of the range to be assigned 

c Select All. Virtual number range updates 

8 Expand the Call ups section. All available call ups are listed. 

9 If required, renumber call ups: 

To renumber a single call up: 

a Select Tours or Salvos tab as required 

b Change the virtual number in the renumber call ups textbox 

c Select Selected 

d Repeat as required for subsequent call ups 

To renumber a range of call ups: 

a Select the renumber textbox 

b Enter the first number of the range to be assigned 

c Select All. Virtual number range updates. 

10 Expand the Monitors section. 

To add monitors: 

a Select tr.,1 Dropdown menu displays 

b Select Virtual Display or Analog Matrix as required. Selection displays in monitor list. 

Note: 
1. When adding an MP48 to a virtual matrix profile, the recorder inputs at the top of the camera list are 
automatically moved to the bottom. (You can manually edit the positions.) 
2. When adding more than one MP48 analog matrix, it should be noted that the camera inputs of the 
second analog matrix will be assigned virtual numbers in the sequence the 'excluded' entries are 
unchecked. 

c Change Video Layout and Workstation as required by double clicking the relevant field and selecting 
from the dropdown menu. 

d Repeat as required to add more monitors. (Maximum 4 virtual displays per workstation) 
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To renumber monitors: 

a Deselect the Add monitor ranges automatically checkbox. First pane field becomes a textbox. 

b Assign numbers manually by entering values in the First pane textboxes. Last pane field updates accord-
ing to the number of panes associated with the selected layouts. 

11 Select Save. 

- End - 

Renumber Camera Virtual Numbers 
The device list orders cameras alphabetically while the virtual matrix builds its camera list when first created. As new 
cameras become available they are appended to preserve the virtual numbering. 

This means the virtual matrix list of cameras is not always in the same order as the device list. 

Virtual camera numbers are labeled 1 through 99999 by default. Individual virtual numbers may be changed or whole 
ranges may be assigned new values. 

Note: 
Keyboards may not be able to call all virtual camera numbers as different keyboards have limits on the highest number 
they can recognize. 

Renumbering affects the command needed to call up a particular camera, so if you renumber cameras starting at '99', 
then to call up the first camera you need 99M+#K. 

Procedure 176 Renumber Camera Virtual Numbers 

tep Action 

1 Select Virtual Matrix from the Build tab. 

2 Select Show all from the dropdown menu. 

3 Right Click the Virtual Matrix to be changed. 

4 Select Edit. Virtual Matrix Editor displays. 

5 Expand the Cameras section. 

To renumber a single camera: 

a Select the camera row 

b Change the virtual number in the renumber cameras textbox 

c Select Selected 

d Repeat as required for subsequent cameras 

To renumber a range of cameras 

a Select the Renumber cameras textbox 

b Enter the first number of the range to be assigned 

c Select All. Virtual number range updates 

6 Enter the new camera ID in the Renumber Cameras text box. 

7 Select Save. 
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- End - 
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Renumber Call ups in a Virtual Matrix 
You can renumber the default numbers assigned to call ups in a virtual matrix either individually or by range. 

Procedure 177 Renumber Call ups in a Virtual Matrix 

tep Action 

1 Select Virtual Matrix from the Build tab. 

2 Select Show all from the dropdown menu. 

3 Right Click the Virtual Matrix to be changed. 

4 Select Edit. Virtual Matrix editor displays. 

5 Expand the Call ups section. 

6 Select Tours or Salvos as required. 

To renumber a single call up: 

a Select the call up row 

b Change the virtual number in the renumber textbox 

c Select Selected 

d Repeat as required for subsequent call ups 

To renumber a range of call ups 

a Select the Renumber textbox 

b Enter the first number of the range to be assigned 

c Select All. Virtual number range updates 

7 Select Save. 

- End - 
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Edit Monitors (Virtual Matrix) 
You can add and remove monitors from virtual matrices. A maximum of 4 virtual displays can be added to each 
workstation. 

Procedure 178 Edit Monitors (Virtual Matrix) 

tep Action 

1 Select Virtual Matrix from the Build tab. 

2 Select Show all from the dropdown menu. 

3 Right click the virtual matrix to be edited. 

4 Select Edit. 

5 Expand the Monitors section. 

To add Monitors: 

a Select 0 Dropdown menu displays 

b Select Virtual Display or Analog Matrix as required. Selection displays in monitor list. 

c Change Video Layout and Workstation as required by double clicking the relevant field and selecting 
from the dropdown menu. 

d Repeat as required to add more monitors. (Maximum 4 virtual displays per workstation) 

To remove monitors: 

a Highlight the monitor row. 

b Select . Monitor is removed 

To renumber monitors: 

a Deselect the Add monitor ranges automatically checkbox. First pane field becomes a textbox. 

b Assign numbers manually by entering values in the First pane textboxes. Last pane field updates accord-
ing to the number of panes associated with the selected layouts. 

To change Video Layouts: 

a Double click the video layout of the display to be changed. Available video layouts display. 

b Select the required layout. Video layout and pane numbers update. 

To change monitor workstation: 

a Double click the workstation name of the virtual display. List of available workstations displays. 

b Select workstation as required. 

6 Select Save. 

- End - 
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Analog Matrix 

Introduction 
You can add Megapower 3200 and MegaPower 48 Plus analog matrices to the system. Each matrix can specify one 
or more workstations to which they are serially connected. Once added to the system, the matrices will be available 
for inclusion in virtual matrix profiles so they can be controlled from a particular workstation via an attached keyboard. 

Once the matrix has been added to the system, it will be displayed along with other system devices in the Device List. 

A typical analog matrix configuration will have video feeds to the matrix coupled to a recorder which may already be 
part of the victor system. With this setup the virtual matrix allocates a camera Id to both the recorder camera and the 
analog matrix input. 

Camera mapping is required to allow playback from keyboard "Orange Buttons"; when the user selects a camera 
associated with the analog matrix this will allow the virtual matrix to identify its associated recorder if one is available 
and take the appropriate action to retrieve the clip and playback the video or signal an invalid operation. 

Analog Matrix Editor 
Using the Analog Matrix editor you can configure basic matrix properties via the General and Analog Matrix Setup 
sections. 

The Workstation Connections section is used to configure the COM Port, Baud Rate and Playback Monitor specific 
settings for each workstation matrix connection. Remote workstations can be dragged and dropped here from the 
Device List. 

The Inputs and Analog Matrix Playback Configuration section of the editor is used to configure camera mappings. 
Camera mappings are required to enable playback from keyboard 'Orange Buttons'. 

To configure the camera mappings, video streams which are already present on the victor system via a recorder are 
dragged from the device list onto the Analog Matrix editor "Camera Mapping" list. To manipulate the sequence of the 
list, delete, move up and move down functionality is available via a toolbar and context menu. 

Satellite Sites - The MP3200 allows a satellite site configuration permitting a site to access the resources of one or 
more remote sites. This feature is not available on MP48 nor MP48+ matrices. 

Before adding an analog matrix it should be correctly configured via its supporting configuration application (EasyCPU 
for MP3200 and Easy 48 for MP48). 

Note: 
1. Any video stream and monitor resources configured during the victor setup are always considered available to the 
associated victor workstation. 
2. Once an Analog Matrix has been added to victor, the victor workstation will always expect it to be available, no 
attempt will be made to poll the device for status. 
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Sites 
Any cameras not associated with an Analog Matrix are assigned to Site "0". 

The following keyboards do not allow for the calling of site '0': 

• ADCC200 

• ADCC300 

• ADCC1100 

For these models, you can use the keyboard's context menu Return to Home option to switch to site0. 

Create an Analog Matrix 
Users can define and add a analog matrices to the system using the Analog Matrix editor. 

Procedure 179 Create and Analog Matrix 

Step Action 

1 Select Analog Matrix from the Setup tab. 

2 Select New from the drop down list. 

3 In the General section enter a name in the Name text box. 

4 Enter a description in the Description text box. 

5 The Enabled checkbox is selected by default. To disable the Analog Matrix, deselect the checkbox. 

6 Expand the Analog Matrix Setup section. Select the model to be added: 

• MegaPower 3200 

Or 

• MegaPower 48 

7 Enter the Site number in the Site textbox. 

Note: 
Sites textbox is only available if MP3200 has been selected at Step 6. 

8 Enter the number of cameras in the Camera Count textbox. 

9 Enter the number of monitors in the Monitor Count checkbox. 

10 Enter a Usemame in the Usemame textbox. 

11 Enter a password in the Password textbox. 

12 Check the Requires Authentication checkbox if you require users to authenticate before accessing the analog 
matrix. 

13 Expand the Workstation Connections section. Use this section to configure workstations associated with the 
analog matrix. 

14 Select the workstation to attach the analog matrix to. (The current workstation is automatically added to the 
connection list along with default values for COM port, Baud rate and Playback Monitor, to add further remote 
workstations, drag them from the device list as required.) 

15 Double click default COM port and select an alternative from the dropdown if required. 
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Note: 
1. If a COM port is already in use by another device, it will appear as greyed out in the drop down list. 
You can see which device is using the COM port by viewing the tooltip. 
2. Select Blank to have no COM port assigned. 

16 Double click default Baud Rate and select an alternative from the dropdown if required. 

17 Double click default Playback Monitor and select alternative from the dropdown if required. 

18 Double click default value for Playback to Analog Matrix. 

19 Select or deselect the Enabled checkbox to enable or disable the feature. 

20 Enter the Matrix Input value in the Matrix Input textbox. 

21 Add further remote workstations by dragging and dropping them from the Device List onto the Connection 
List. 

22 Configure remote workstations as required (Refer to Steps 13-20 above). 

23 Expand Inputs and Analog Matrix Playback Configuration Section. Use this section to configure camera 
mappings and assign Pseudo numbers to analog inputs. 

24 Associate video feeds as required by dragging cameras or recorders from the device list into the Inputs 
Configuration list. 

25 Expand the Satellite Sites section. 

26 Drag required Satellite Sites from the Device list into the Satellite Sites list in the editor. 

27 Select Save. 

- End - 

Edit Analog Matrix - General/Setup Properties 
You can make changes to general properties of an Analog Matrix. Editable properties include Name, Description, 
Enabled/Disabled, Model, Camera Count and Monitor Count. 

Procedure 180 Edit Analog Matrix 

Step Action 

1 Select Analog Matrix from the Setup tab. 

2 Select Show all from the drop down menu. 

3 Right click the Analog Matrix to be edited. 

4 Select Edit. Analog Matrix editor displays. 

5 Expand the General section if changes are to be made. 

6 Make edits as required to: 

• Name 

• Description 

• Enabled (Check or uncheck Checkbox) 

7 Expand Analog Matrix Setup if changes are to be made. 

8 Make edits as required to: 
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• Model (Select from dropdown) 

• Site (Numerical value only) 

• Camera Count (Numerical Value only) 

• Monitor Count (Numerical Value Only) 

• Usemame 

• Password 

• Requires Authentication (Check or uncheck checkbox) 

9 Select Save. 

- End - 

Edit Analog Matrix - Add/Remove/Edit workstation connections 
You can add/remove workstations associated with the matrix as well as change the COM Port, Baud rate and 
Playback Monitor of specific workstations. 

Procedure 181 Edit Analog Matrix - Add/Remove/Edit workstation connections 

Step Action 

1 Select Analog Matrix from the Setup tab. 

2 Select Show all from the drop down menu. 

3 Right click the Analog Matrix to be edited. 

4 Select Edit. Analog Matrix editor displays. 

5 Expand the Workstation Connections section. 

6 To Add a remote workstation to the list: 

a Select the Workstation in the Device List. 

b Drag the workstation to the Workstation Connections list. 

c Release the workstation. The list updates to include the new remote workstation. 

7 To Edit properties of a workstation: 

a Double click the value to be changed. 

b Select the new value from the drop down list. Value updates to the new selection. 

8 To Remove a workstation from the list: 

a Select the workstation to be removed. 

b Right Click the workstation. 

c Select Remove Workstation Name'. Workstation list updates. 

9 Select Save. 

- End - 
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Edit Analog Matrix - Configure Inputs 
You can configure camera mappings and associations within the Analog Matrix editor. Camera mappings are required 
to enable playback from keyboard 'Orange Buttons'. 

Procedure 182 Edit Analog Matrix - Configure Inputs 

Step Action 

1 Select Analog Matrix from the Setup tab. 

2 Select Show all from the drop down menu. 

3 Right click the Analog Matrix to be changed. 

4 Select Edit. Analog Matrix editor displays. 

5 Expand the Inputs Configuration section. 

6 Drag video feeds from the device list as required and drop them into the list. You can drag recorders or 
cameras into the list. 

a Drag a video stream (Camera OR Recorder) from the device list and drop it in the inputs list. The list pop-
ulates with the video streams. 

b If required, renumber the default Pseudo Numbers. 

• To renumber a single input: 

a Select the cell containing the Pseudo number to be changed. 

b Enter the new number in the textbox at the top of the section between the All and Selected buttons. 

c Select Selected. The new number displays in the Pseudo number list. 

• To renumber all inputs: 

a Enter the first number of the new range in the textbox at the top of the section between the All and Selec-
ted buttons. 

b Select All. All numbers change to the new selection. 

7 You can edit the sequence of the list as well as change video streams by using the list's context menu. 

8 Select Save. 

- End - 

Add/Remove satellite sites 
Satellite Sites - The MP3200 allows a satellite site configuration permitting one site access to the resources of one or 
more remote sites. This feature is not available on MP48 nor MP48+ matrices. 

Procedure 183 Add/Remove satellite sites 

Step Action 

1 Select Analog Matrix from the Setup tab. 

2 Select Show all from the drop down menu. 

3 Right click the Analog Matrix to be edited. 

4 Select Edit. 
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5 Expand the Satellite Sites section. 

6 To Add a Satellite Site: 

a Select the Analog Matrix from the Device List. 

b Drag and Drop the Analog Matrix from the Device List into the Satellite Site list. 

7 Select Save. 

- End - 

Reconnect to an Analog Matrix 
You can reconnect to an Analog Matrix if a connection has been broken, without needing to edit the properties of the 
Analog Matrix. 

Procedure 184 Reconnect to an analog matrix 

Step Action 

1 Select Devices from the Home tab. Device List displays. 

2 Select next to Analog Matrices in the Device List window. All analog matrices are listed. 

3 Right click the Analog Matrix that needs to be reconnected. 

4 Click Reconnect. The analog matrix is reconnected. 

Note: 
The Reconnect option will be disabled if the analog matrix is disabled, or, if the local workstation 
details are incorrect in the Workstation Connections section. 

- End - 
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Layouts 

Introduction 
The default victor unified client layout consists of three tabbed toolbars (Home, Build and Setup), the Device List 
and a 2X2 Surveillance tab. This layout can be completely customized, allowing you to create a workspace that better 
suits the requirements of individual operators and roles. 

Note: 
The Ribbon controls are minimized by default. To show the controls, double click the Home, Build or Setup tab 

Window Types 
Various window types are supported within victor. Type changes and behavior can be accessed by right clicking the 
window title bar. victor unified client supports 3 window types: 

Floating Windows 
Creates a window that is independent of the client window. A floating window can be moved to anywhere on screen, 
resized and reshaped to suit your workspace. 

Dockable 
Creates a window that can be docked into position within the main client window. When a dockable window is 
dragged, a guide diamond is displayed (see below), allowing you to quickly dock it on one of the four sides of the 
workspace. When a docked window is undocked, it will float to the top of other windows. 

Tabbed 
Creates a window that appears in a tab. Tabbed windows are useful for organizing and switching between multiple 
open windows. 
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Configuring your Workspace 
You can create a custom layout to suit your individual workspace. 

Procedure 185 Dock Window 

Step Action 

1 Right click the title bar or tab of the window. 

2 Select Dockable. 

3 Drag the window to the middle area of the screen. The Guide diamond displays. 

4 Hover the cursor over the guide diamond arrow which corresponds with the area you want to dock the window 
in. Area highlights. 

5 Release the mouse, Window docks in position. 

- End - 

Procedure 186 Resize Windows 

You can resize a docked or floating window to provide more or less area in the workspace. 

Step Action 

1 If the window is tabbed, right click the title bar and select Floating or Dockable. 

2 Hover the cursor over the comer side of the window. Grab Handles display 

3 Select and drag the cursor to resize the window as required. 

- End - 

Procedure 187 Autohide Windows 

Autohide is only available in dockable windows that have been docked. 

When Autohide is enabled on a window, it will only be visible as a tab when it does not have focus. This means that 
the window is open and can be easily accessed, but the area it occupies is greatly reduced. 

Step Action 

1 Right click the title bar of the docked window. 

2 Select Autohide. The window will reduce to a tab view positioned according to the docked attribute of the 
window. 

3 Select the tab to view the window or remove focus to autohide. 

- End - 
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Procedure 188 Show/Hide the Ribbon 

You can Minimize or maximize the ribbon controls to create more workspace. This change is not saved as a layout 
change. 

Note: 
Default setting is minimized 

Step Action 

1 Double click the Home, Build or Setup tab. Ribbon is displayed. 

2 Double click the Home, Build or Setup tab. Ribbon is hidden. 

- End - 

Save / Switching Layouts 

Save 
Once your workspace has been configured, you can save the layout for later retrieval. 

Procedure 189 Save Current Layout 

tep Action 

1 Select Layout on the Build tab. 

2 Select Save as from the dropdown menu. Name textbox displays. 

3 Enter a name for the new layout. 

4 Select the Lock This Layout checkbox to lock the layout. 

Note: 
Users of a locked layout are unable to move components added to the layout. 

5 Select OK. The layout is saved. 

Note: 
The default layout cannot be deleted. 

- End - 

Switch 

Procedure 190 Switch to Saved Layout 

step Action 

1 Select Switch on the Home tab. List of layouts displays. 

2 Select the layout from the dropdown menu. New layout displays. 
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Switch on Primary 

Switch On Primary allows you to switch primary layout components to a saved layout, retaining video wall 
components in their current location. Primary layout components include the main victor unified client window and all 
tabbed, docked and floating windows. Video Wall components include panes that have been 'sent to' your display or 
video actions that have been activated. 

For example. If you had a layout configured like this: 

1+4144 4.1HHHII: 

Choosing Switch On Primary to the Default layout would make your layout this, retaining only Video Wall 
components: 

4 American Dynamics 
From Tyco Security Products 

Whereas choosing Switch to the Default layout would remove all layout components: 

American Dynamics 
Com Tyco Security Products 

Procedure 191 Layout - Switch on Primary 

Id, From Tyco Security Products 

American Dynamics 

Step Action 

1 Select Switch On Primary from the Build tab 

2 Select a layout from the dropdown menu. 

- End - 

Switching Users 
When switching users, selecting Options from the Switch Operator dialog opens the Options pane. Select Keep 
current layout to retain current layout. 
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Layout Groups 
Layout Groups allow layouts to be loaded onto client machines remotely. 

Procedure 192 Create Layout Group 

Step Action 

1 Select Layout Group from the Build tab 

2 Select New from the dropdown menu. The Layout Group editor opens 

3 Select the Name textbox and enter a name 

4 If required, select the Description text box and enter a description 

5 Drag required layout to the required workstation(s) 

6 Select Save 

- End - 

Procedure 193 Load Layout Group 

Step Action 

1 Select Switch Group from the Home tab 

2 Select the required layout from the dropdown list. Selecting a layout will switch the configured layout to all 
workstations specified in the layout group 

Note: 
1. Layout Groups will remain assigned to workstations until the layout is deleted or another layout 
selected 
2. Layout groups override selection from Switch on Primary or Switch 

- End - 

Refresh Layouts 
Various options are available to refresh layouts from the Home tab. 

Procedure 194 Refresh Layouts 

tep Action 

1 Select Refresh from the Home tab. 

2 Select from dropdown options. 

• Refresh Layout 

• Refresh on Primary 

• Refresh Group Layout 

- End - 
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Rename Tabbed Window 
Tabbed windows can be renamed. Any renaming will be saved when the layout is saved. 

Procedure 195 Rename Tabbed Windows 

tep Action 

1 Right Click the tab to be renamed. 

2 Select Rename. Name dialog displays. 

3 Enter a new name for the tab. 

4 Select OK. 

- End - 

Create New Tab Groups 
You can create new tab groups for convenient grouping and navigation of windows. To create tab groups, more than 
one tab must be open. 

Procedure 196 Create New Tab Groups 

btep Action 

1 Right Click on the tab to start the new group. This will be the first tab listed in the group. 

2 Select New Horizontal Tab Group or New Vertical Tab Group as required. New group is created per the 
selection. 

Note: 
1. Reorder tabs within groups by selecting and dragging tabs within the group. 
2. Move tabs between groups by right clicking the tab and selecting Move to Previous/Next Tab 
Group. 

- End - 

Merge Docked Windows 
You can merge docked windows to create more on-screen workspace. Merged windows are grouped together as a 
single tabbed screen element. 

Procedure 197 Merge Docked Windows 

btep Action 

1 Select the title bar of a docked window. 

2 Drag to the centre of the docked window to which it is to merge. The docking icon displays. 

3 Deselect the window in the centre of the docking icon. Windows merge. Navigate the windows by selecting 
appropriate tabs from the bottom of the merged window. 
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- End - 

View Window In Full Screen 
You can view any window in full screen mode. 

Procedure 198 View Window Full Screen 

tep Action 

1 Right click the title bar of the window. 

2 Select Send To from the context menu. 

3 Select the display in which to view the full screen window. 

A confirmation message will be displayed to let you know if the operation was successful or failed. 

- End - 

Save and Restore Current Layout 
Selecting the save layout option saves the current layout. Once your workspace is arranged, you can save the layout 
under a descriptive name and restore it later. 

Procedure 199 Save Current Layout 

tep Action 

1 Select Layout 

2 Select Save. The Choose save location dialog opens 

3 Navigate to the location you wish to save the layout to 

4 Enter a File Name 

5 Select Save 

- End - 

Procedure 200 Restore Layout 

tep Action 

1 Select Layout 

2 Select Load. The Select layout file to open dialog displays 

3 Navigate to saved layout file location and select required layout file 

4 Select Open. The surveillance window updates with the restored layout 

- End - 

Custom Layouts 
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You can use the Custom Layout Designer to create custom surveillance layouts. You can create new custom layouts 
from the Video Layout Preferences section of the System Values page. Refer to System Values for more 
information. 
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Controllers 

Introduction 
Various CCTV Keyboards, Multimedia Controllers and Joysticks are supported in victor for surveillance control.These 
can be used to navigate and switch video streams in display panes of surveillance windows and virtual matrices. 

Serial keyboards have fixed functionality within the victor surveillance environment whereas Joysticks, Gamepads 
and other Multimedia controllers are configurable. 

Controller button configuration (General Information) 
Some controllers are 'Plug and Play', others support configuration within victor, see below: 

Controller Device Button configuration options 

AD/Pelco Serial Keyboards Not Applicable: Refer to manufacturers instructions for 
default settings. 

System Keyboard (Standard QWERTY) Not Applicable: Refer to "System Keyboard Commands" for 
default settings. 

ExacqVision Keyboards (VM Desktop Model 100-590-2130) Via victor Client: Keyboards>Joystick Configuration. 

Axis 295 Video Surveillance Joystick 
Axis T8311 Video Surveillance Joystick Via victor Client: Keyboards>Joystick Configuration. 

Gamepads Via victor Client: Joystick'Gamepad Configuration (refer to 
"Gamepad controller configuration" 

ShuttlePRO v2 Not Applicable. Refer to "ShuttlePRO v2 controller" for 
default settings. 
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System Keyboards 
You can add a standard Windows keyboard and use it as a CCTV keyboard. 

Note: 
When using a system keyboard, surveillance commands can only be sent if the surveillance window has focus. Other 
controllers will operate regardless of whether the surveillance window has focus. 

Refer to System Keyboard Commands fora list of user commands. 

Procedure 201 Add a System Keyboard 

btep Action 

1 Select Keyboards from the Setup tab. 

2 Select New from the dropdown. 

3 Enter a name for the keyboard in the Name textbox. 

4 Enter a description for the keyboard in the Description textbox. 

Note: 
The Enabled checkbox is checked by default, deselect the checkbox to deactivate the keyboard. 

5 Expand the Keyboard section. 

6 Select System Keyboard from the Model dropdown. The COM Port and Baud Rate dropdown lists 
disappear. 

7 Select Save. 

- End - 

System Keyboard Commands 
When using a system (QWERTY) keyboard, the following commands are available: 

Command Action Command Action 

Arrow Keys Pan/Tilt w Stop 

Number Pad Arrow 
Keys 

Pan/Titt e Pause 

41- (Number Pad) Zoom in/Out r Play 

-1= Zoom in/Out t Fast Forward 

4m Monitor (4 is a number: 1-999) s Jump to Date (4 digits in month/day format) 

4k Camera (4 is a number: 1-9999) d Jump to Time (4 digits in 24 hour format) 

q Rewind Stj Site 
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Serial Keyboards 
Any of the listed AD/Pelco keyboards can be used in victor. 

Procedure 202 Add an AD/Pelco Keyboard 

tep Action 

1 Select Keyboards from the Setup tab. 

2 Select New from the dropdown. 

3 Enter a name for the keyboard in the Name textbox. 

4 Enter a description for the keyboard in the Description textbox. 

Note: 
The Enabled checkbox is checked by default, deselect the checkbox to deactivate the keyboard. 

5 Expand the Keyboard section. 

a Select the required Model from the dropdown. 

b Select the required COM Port from the dropdown. 

c Select the required BAUD Rate from the dropdown. 

6 Select Save. 

- End - 

System/Serial Keyboards: Supported functionality 

Serial Keyboards 

Feature System ADTTE AD 
2088/89 ADC0200 ADC0300 ADC1100 Pel co 

KBD300A* 

CameralMonitor Call up r r r r r r r 

Standard PTZ Control r r r r r r r 

Keyboard Macros r r 

Salvos r r r r r r 

Tours r r r r r 

Patterns r r 

Presets r r r r r r 

Focus/Iris Control r r r r r r 

Flip r r r r r 

Site r r r r r r 

Keyboard Functionality** 

"Using ASCII protocol (Pelco Keyboard requires an RS422 RS-232 converter) 

"" See Keyboard/Matrix Switcher Manual for specific functionality 
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Note: 
1. When using a system keyboard, commands can only be sent if the surveillance window has focus. Other 
keyboards are not affected and will continue to operate whether the surveillance window has focus or not. 
2. System keyboards cannot be edited from remote clients. 
3. Repeat should be set to 'Off' for all keyboards. Refer to the keyboard user documentation for instructions. 

American Dynamics Serial Keyboard Installation 
Wiring diagrams for installing keyboards: 

AD2088, AD2089, ADTTE, ADCC1100ADCC200, ADCC300 

AD2088 and AD2089 

Note: 
To install the AD2088 and AD2089 Keyboard, you require the Keyboard PC kit (ADACKBPC2000) 
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ADTTE 

Note: 
To install the ADTTE Keyboard, you require the Keyboard PC kit (ADACKBPC2000) 
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ADCC100 or ADCCO200/0300 

Note: 
To install the ADCC100 or ADCC200/300 Keyboards, you require the Keyboard PC kit (ADACKBPCMPCC) 

There are three Methods of connecting ADCC10O or ADCCO200/0300: 

• Method 1 

• Method 2 

Nob. Set RS232 baud 
rale to (default 1200) 

12 VDC @42amp 
(LIP PSU) 
[Positive Tip] 

MP-KMI 

Note. Set mode lo RS232 
and baud rate to 1200 
(default RS485 and 19203) 

To PC COM port 
— (Baud rate 1200) 

StraightThroucf 
Cable (MP-C81) 

RJ45 to D99 
(2025.0294-01) 

Flip Cable 
(8003-0047-01) 
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• Method 3 

Note Sel RS232 
baud rale to 
O00 

12 VDCO 42atr (.111-CP0) 
Posrove TIN 

A0CC1100 Staoght Dump 

Cf cables 0dP-CPU) 

IEFEES 

Requiredb 
Grand 

Note Set mode to RS232 and baud rate to 
1200 (default mode RS485 and baud rate 

ADCC0200-0300 19200) 

To PC Cat Pori 
(Baud Rate 1200) 

811445w DB9 
(2025-0294-01)
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Joystick/Gamepad configuration 

ExaqVision controllers configuration 
ExaqVision Default button assignments 

Note: 
1. Button is not configurable 
2. Number pad keys are not configurable 

Button Action Button Action 

C1 Select/Execute C9 Hokl tour 

C2 Go back C10 Flip 180° 

C3 Open/Close OSD C11 Stop 

C4 Next tab C12 Toggle Play/Pause 

C5 Previous monitor C13 Clear 

C6 Next monitor 14 *Monitor 

C7 Focus near 15 Last camera (Left joystick button) 

C8 Focus far 16 Next Camera (Right joystick button) 

Exaqvision controllers keyboard mapping can be configured within victor. 

Procedure 203 ExaqVision controllers: victor Configuration 

Step Action 

1 Select Keyboards from the Setup tab. 

2 Select Joystick Configuration from the dropdown. 

3 Select ExaqVision Surveillance Keyboard from the Load Preset Configuration dropdown. 

4 Select Supports Numeric Input if required. 

5 Select Apply. 

6 Expand the controller Controller Layout section: 

X/Y Axis 

a Use the Dead Zone slider bar on the X/Y axis section to set the number of pixels which the thumbstick 
needs to traverse before becoming active (the larger the dead zone, the less sensitive the controller) 

b Select Invert Y Axis if required (Reverses the default'Y' orientation- Up becomes Down, Down 
becomes Up) 

c Select Control assignment for X/Y axis- either Pan/Tilt or leave unassigned 

Z Axis 

d Use the Dead Zone slider bar on the Z axis section to set the number of pixels which the thumbstick 
needs to traverse before becoming active (the larger the dead zone, the less sensitive the controller) 

e Select Invert Z Axis if required (Reverses the default'Z' orientation) 
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f Select Control assignment for Z axis- select Zoom, Focus, Iris, Playspeed or leave unassigned 

X Position 

g Adjust the X position using the outer jog wheel. Use the Dead Zone slider bar to set the number of pixels 
which the jog wheel needs to traverse before becoming active 

h Select X Position if required 

i Select Control assignment for X Position either Pan/Tilt, Zoom, Iris, Playspeed or leave unassigned 

7 Expand the Keyboard Mapping section. 

a Use Press Key Here field to map supported virtual keyboard buttons. 

8 Select Save. 

- End 
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Axis controller configuration 

victor supports the Axis T8310 Video Surveillance control board. This consists of three units that can be installed 
separately or together as one unit. 

• T8311 Video Surveillance Joystick (Control PTZ functionality of cameras): Configurable in victor 

• T8312 Video Surveillance Keypad (Navigate between cameras, views and presets) Not Configurable 

• T8313 Video Surveillance Jog Dial (Jog and shuttle through recorded video) Not Configurable in victor 

Axis T8311 Default button assignments 

Button Default Assignment Button Default Assignment 

1 Select/Execute 4 Go back 

2 Open/Cbse OSD menu 5 Next tab 

3 Previous monitor 6 Next monitor 

Axis T8311 controller keyboard mapping can be configured within victor. 

Procedure 204 Axis Joystick: victor configuration (T8311) 

Step Action 

1 Select Keyboards from the Setup tab. 

2 Select Joystick Configuration from the dropdown. 

3 Select the Axis T8311 joystick from the Load Preset Configuration dropdown. 

4 Select Supports Numeric Input if required. 

5 Select Apply. 

6 Expand the controller Controller Layout section: 

X/Y Axis 

a Use the Dead Zone slider bar on the X/Y axis section to set the number of pixels which the thumbstick 
needs to traverse before becoming active (the larger the dead zone, the less sensitive the controller) 

b Select Invert Y Axis if required (Reverses the default'Y' orientation- Up becomes Down, Down 
becomes Up) 

c Select Control assignment for X/Y axis- either PaNTilt or leave unassigned 

Z Axis 

d Use the Dead Zone slider bar on the Z axis section to set the number of pixels which the thumbstick 
needs to traverse before becoming active (the larger the dead zone, the less sensitive the controller) 

e Select Invert Z Axis if required (Reverses the default'Z' orientation) 

f Select Control assignment for Z axis- select Zoom, Focus, Iris, Playspeed or leave unassigned 

7 Change default button assignments using the dropdown menus. 

8 Expand the Keyboard Mapping section. 

a Use Press Key Here to map supported virtual keyboard buttons. 

b Use the Keyboard Mapping section, to map the controller keyboard to system commands. 
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Note: 
To aid with key mapping, each keystroke on the controller highlights red on the GUI 

9 Select Save. 

- End 

victor supports the Axis 295 Video Surveillance control board. 

Axis 295 Default button assignments 

Button Default Assignment Button Default Assignment 

1 Go Back 7 Rewind 

2 Clear 8 Fast Forward 

3 Previous tab 9 Previous monitor 

4 Next tab 10 Next monitor 

5 Play/Pause 11 Open/Close OSD 

6 Stop 12 Select/Execute 

Axis 295 controllers can be configured within victor. 

Procedure 205 Axis Joystick: victor configuration (Axis 295) 

Step Action 

1 Select Keyboards from the Setup tab. 

2 Select Joystick Configuration from the dropdown. 

3 Select the Axis 295 joystick from the Load Preset Configuration dropdown. 

4 Select Apply. 

5 Expand the controller Controller Layout section: 

X/Y Axis 

a Use the Dead Zone slider bar on the X/Y axis section to set the number of pixels which the thumbstick 
needs to traverse before becoming active (the larger the dead zone, the less sensitive the controller) 

b Select Invert Y Axis if required (Reverses the default'Y' orientation- Up becomes Down, Down 
becomes Up) 

c Select Control assignment for X/Y axis - either Pan/Tilt or leave unassigned 

Z Axis 

d Use the Dead Zone slider bar on the Z axis section to set the number of pixels which the thumbstick 
needs to traverse before becoming active (the larger the dead zone, the less sensitive the controller) 

e Select Invert Z Axis if required (Reverses the default 'Z' orientation) 

f Select Control assignment for Z axis- select Zoom, Focus, Iris, Playspeed or leave unassigned 

6 Expand the Keyboard Mapping section. 

a Use Press Key Here to map supported virtual keyboard buttons. 
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b Use the Keyboard Mapping section, to map the controller keyboard to system commands. 

Note: 
To aid with key mapping, each keystroke on the controller highlights red on the GUI 

7 Select Save. 

- End - 

©American Dynamics 229 

EFTA01224038



Gamepad controller configuration 
victor supports gamepad 'Plug and Play' functionality meaning there is no requirement to 'Add' the controllers in victor. 

Gamepad controller default button assignments. 

Button Default Assignment 

Right shoulder Next monitor 

Left shoulder Previous monitor 

Left stick (Move) Pan/Tit 

Left Stick (Press) Open/Close OSD menu 

Right Stick (Move) Move mouse 

Right Stick (Press) Mouse left click 

Directional Pad Up Toggle Play/Pause 

Directional Pad Down Stop 

Directional Pad Left Rewind 

Directional Pad Right Fast Forward 

X Mouse right click 

Y Flip 180° 

B Go back 

A Select/Execute 

Left Trigger Zoom in 

Right Trigger Zoom out 

Gamepad controllers can be configured within victor. 

Procedure 206 Gamepads: victor configuration 

Step Action 

1 Select Keyboards from the Setup tab. 

2 Select Gamepad Configuration. 

3 Expand the Controller Layout section. 

4 For Left and Right Thumb Axes configuration: 

a Use the Dead Zone slider bar to set the number of pixels which the thumbstick needs to traverse before 
becoming active (the larger the dead zone, the less sensitive the controller) 

b Select Invert Y Axis if required (Reverses the default 'V' orientation - Up becomes Down, Down 
becomes Up) 

c Use the Control Assignment pulldown to define the functionality of the thumbstick (E.G., Mouse Con-
trol or Pan/Tilt control) 

5 Use the Button Assignments control to map the controllers physical buttons to victor surveillance actions. 
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Note: 
Default actions are assigned to the controller buttons; these are appended with (Assigned) in the 
dropdown assignment lists 

6 Left/Right Trigger configuration (underside of the controller. LT/RT): 

a Assign a Dead Zone up to 255 pixels using the slider 

b Assign the button 

c Use the Control Assignment pulldown to define the functionality of the trigger buttons 

7 Direction Pad Configuration: 

a Use the Dropdown menus to assign actions against Up, Left, Right and Down commands. 

8 Select Save. 

- End - 
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ShuttlePRO v2 controller 
ShuttlePRO v2 is a multimedia controller which works within any computer application with keyboard commands. 

To enable ShuttlePro support in victor you should: 

1 Install ShuttlePro V2 software (provided with the ShuttlePro product). 

2 Run the Contour Shuttle Device Configuration utility. 

3 Use the utility's Settings Management section to import victor.pref file from CAProgram 
Files TycolvictorClient1Configlvictor shuttlepro.pref 

4 Select OK. ShuttlePro controller will be ready to use. 

victor has been developed to provide ShuttlePRO v2 support natively; there is therefore no need for configuration 
within the victor environment. 

ShuttlePro V2 Default button assignments: 
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Configuring Patterns and Presets using numeric input USB Keyboards 
The keyboard should be configured for use with victor. 

Procedure 207 Keyboards: Configuring Patterns using numeric USB keyboard 

Step Action 

1 Select the Setup tab. 

2 Select Keyboards. 

3 Select Joystick Configuration. 

4 Configure one of the Button Assignments for the keyboard to 'Set Pattern'. Refer to the victor Administration 
and Configuration guide if further help if required. 

5 Program a pattern using the USB joystick: 

a Input a pattern number on the numeric keypad of the USB Joystick. 

b Press the Joystick button which has the 'Set Pattern' assignment, this will begin the programming pro-
cess. 

c Using the joystick, pan tilt and zoom to define the pattern and then press the 'Set Pattern' button again to 
save the defined pattern and close out of programming mode. 

6 To run the pattern, input a pattern number on the numeric keypad of the USB Joystick and then press the 
Joystick button which has the "Run Pattern" assignment 

- End - 

Procedure 208 Keyboards: Configuring Presets using numeric USB keyboard 

Step Action 

1 Select the Setup tab. 

2 Select Keyboards. 

3 Select Joystick Configuration. 

4 Configure one of the Button Assignments for the keyboard to 'Set Preset'. Refer to the victor Administration 
and Configuration guide if further help if required. 

5 Program a preset using the USB joystick: 

a Pan, Tilt and Zoom to the region where the preset is to be programmed. 

b Input a preset number on the number pad of the USB joystick. 

c Press the joystick button which has the 'Set Preset' assignment. 

d Repeat as required. 

6 To run the preset, input a preset number on the numeric keypad of the USB Joystick and then press the 
Joystick button which has the 'Run Preset' assignment. 

- End - 
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Workstations 

Introduction 
Workstations refer to the machines running victor client software. They display by default on the device lists of client 
machines and are editable via Workstation editors. 

From the editor you can configure workstation descriptions and Client to Client Properties. 

Context menu options specific to workstations include the ability to Logout Local Operators, Logout Remote 
Operators, Delete Workstations, Identify Monitors. 

Identify Monitors 
You can use the Identify Monitors feature to display the names of all monitors associated with each client workstation. 
Monitor names are displayed on screen for 3 seconds after making the selection. 

Procedure 209 Identify Monitors 

tep Action 

1 Select I next to Workstations in the Device List. All workstations are listed. 

2 Right Click the required workstation. 

3 Select Identify Monitors. Display Names display for 3 seconds on all monitors attached to that workstation. 

- End - 

Operator Logout (Remote) 
You can use the context menu of workstations listed in the device list to remotely log out operators. 

Procedure 210 Operator Logout (Remote) 

Step Action 

1 Select next to Workstations in the Device List. All workstations are listed. 

2 Right Click the required workstation. 

3 Select Log Operator XXXX Out. Warning dialog displays. 

4 Select Yes to log the operator out or No to cancel. 

- End - 
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Rename Displays 
Default display names are Display 1,2,3 etc. You can edit the default names as required. 

Procedure 211 Rename Displays 

tep Action 

1 Select 

2 Select 

next to Workstations in the Device List. All workstations are listed. 

next to the workstation which is attached to the display to be renamed. 

3 Select next to Monitors. 

4 Right click the display to be renamed. 

5 Select Rename. Textbox displays. 

6 Enter a new name for the display. 

Note: 
Display names are limited to 255 characters maximum. 

7 Select OK. 

- End - 

Delete Displays 
You can delete displays from workstations. Deleted displays will no longer appear as options when using the Send To 
function. 

Procedure 212 Delete Displays 

tep Action 

1 Select 

2 Select 

next to Workstations in the Device List. All workstations are listed. 

next to the workstation which is attached to the display to be deleted. 

3 Select next to Monitors. 

4 Right Click the display to be deleted. 

5 Select Delete. A Warning dialog displays. 

6 Select Yes to Delete or No to Cancel. 

- End - 

Rename Workstations 
Workstations will default to their assigned Windows name. You can edit the default name as required. 
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Procedure 213 Rename Workstations 

step Action 

1 Select I next to Workstations in the Device List. All workstations are listed. 

2 Right click the workstation to be renamed. 

3 Select Edit. The workstation editor will display. 

4 In the Display Name textbox enter a new name for the workstation. 

5 Select Save. 

End - 
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Point of Sale 

Introduction 
Point-of-Sale (POS) systems are used to facilitate and record financial transactions between businesses and 
customers. Most commonly they are used in retail environments for product sales. 

victor incorporates a comprehensive set of POS integration features which are available as a licensed add-on. 

Using the victor unified client you can import two types of POS data: raw POS transactions from your POS system, 
and POS exception reports produced by your POS exception reporting system. 

Once POS data is imported into victor, a range of investigation tools are available. You can access video of each 
transaction, and use victor's video investigation tools, such as Investigator Mode and Clip Export to gather video 
evidence. In addition victor provides advanced POS searching capabilities which can use to find specific transactions 
based on predefined POS rules. 

When POS is installed, a new database called ACVSPOS is created on your system. This database will store all POS 
data. 

Configuration 
Before using victor's POS features, several configuration steps should be followed: 

The most important aspect of this configuration is to identify which cameras record video of which POS terminals (or 
cash registers). This is achieved creating POS terminal objects in victor, and associating those with camera objects. 
The steps involved are: 

1 Create a POS Store object 

2 Create POS Terminal objects 

3 Associate POS Terminals with relevant cameras 

After these general steps are complete, victor is ready to import POS data. When POS data is imported, it is 
automatically synchronized with video based on Time (See POS Time Offset) and Terminal ID with camera 
associations. This means operators are not required to know or remember which cameras cover which terminals and 
are not required to manually enter dates/times to view POS transactions or exceptions. 

Camera Region Editor 
The Camera Region Editor provides a means to visually identify areas within a camera view which are represented by 
Customers, Merchandise, Employees and Terminals. 

While not specifically a POS feature, making associations between cameras with defined regions and edge devices 
allows users to view pertinent regions of camera views when triggers are initiated from the associated items. This can 
be particularly useful in a retail environment. 
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UnifiedPOS Data Import 
Raw POS transactions are imported into victor in standard UnifiedPOS XML format. The UnifiedPOS XML format was 
developed by the National Retail Federation (NRF)Association for Retail Technology Standards (ARTS). The format 
is a public standard for exchange of POS data in an XML form. See your POS system documentation or contact your 
POS system vendor to determine how you can export UnifiedPOS data for use with victor. 

A Caution 
Before importing POS data into victor you should remove or securely obscure any sensitive credit card information. 
victor has not been certified for PCI DSS compliance. 

This chapter details how to: 

• Create a POS Store 

• Create POS Terminals 

• Associate Terminals with Cameras 

• Define Camera Regions 

• Import POS Transactions 

• Search POS transactions 

• View POS Transactions 

• Import POS Exception Reports 

• View POS Exception Reports 

Create a POS Store 
You can create POS store objects within victor client. These objects can be associated with multiple terminal objects. 

Procedure 214 Create a POS Store 

Step Action 

1 Select Store from the Setup tab. 

2 Select New from the dropdown. 

3 Enter a Name for the POS Store in the Name textbox. 

4 Enter a Description for the POS Store in the Description textbox. 

5 Enter the RetailStorelD. 

Note: 
The RetailStorelD must match the ID used by the POS system or no transactions will be imported. 

6 Select Save. 

• End - 

Create POS Terminal Objects 
You can create one or more POS Terminals within victor. These are then typically associated with cameras which 
have fields of view covering the POS terminals. 
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Procedure 215 Create POS Terminal Objects 

Step Action 

1 Select Terminal from the Setup tab. 

2 Select New from the dropdown. 

3 Enter the Store to be associated with the terminal. 

4 Enter a Name for the Terminal in the Name textbox. 

5 Enter a Description for the Terminal in the Description textbox. 

6 Enter the WorkstationlD. 

7 Select Save. 

Note: 
The WorkstationlD should match the ID used by your POS system for this terminal or no 
transactions will be imported. 

- End - 

Associate POS Terminals with Cameras 
Using the Associations section in the POS Terminal editor, you can associate one or more cameras with the terminal. 
These should be cameras whose field of view includes the physical terminal. 

Procedure 216 Associate POS Terminals with Cameras 

Step Action 

1 Select Terminal from the Setup tab. 

2 Select Show All from the dropdown. 

3 Right Click the Terminal to edit. 

4 Select Edit. 

5 Expand the Associations section. 

6 Select O. The Object selector displays. 

7 Use the Object selector to select cameras to associate with the terminal. 

8 Select OK. 

9 Select Save. 

- End - 
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Camera Region Editor 
The Camera Region Editor allows you to define color coded overlays on camera views associated with terminals. 

Four overlay types are available: Customer Present, Merchandise, Employee and Terminal. 

Assigning regions to terminal cameras in a retail environment makes them easily identifiable when POS video is 
retrieved for those terminals. 

Note: 
The Customer Present region can be aligned with the customer present analytic available on VideoEdge 4.4+ 

Regions can be assigned from the Camera region editor in the Build tab, or alternatively you can access the editor by 
right clicking on a terminal on the device list and selecting Configure Regions. 

To use the Region editor the camera must be associated with a terminal. 

Procedure 217 Edit Camera Regions 

Step Action 

1 Select Camera Region Editor from the Build tab. The Editor displays. 

2 Select click the terminal with which the camera view is associated. Camera icons display. 

3 Select the Camera on which to draw the Region of interest (ROI). Camera view displays with drawing tools. 

4 Select the region type to be drawn from: 

• Customer Present (Analytic available) 

• Merchandise (For information only) 

• Employees (For information only) 

• Terminal (For information only) 

5 Use drawing tools to draw the required ROI. 

6 Select Save or continue drawing / editing as required. 

- End - 
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UnifiedPOS Transactions 

Importing UnifiedPOS Transactions 
UnifiedPOS Transaction Reports can be imported into victor allowing video data to be aligned with transaction data. 

During import, the file is validated against the UnifiedPOS standard. If the file is not in UnifiedPOS XML format, the 
import will fail. 

During the import, victor examines each transaction and checks for corresponding stores and terminals in victor using 
the RetailStorelD and WorkstationlD properties. Any transactions that do not have a corresponding store and terminal 
in the system are rejected. The rest will are stored in the victor database. 

Procedure 218 Import POS Transactions 

Step Action 

1 Select Transactions from the Build tab. 

2 Select ImportUnifiedPOS. Import File dialog displays. 

3 Navigate to the file to import. 

4 Select Open. 

5 Enter Time Offset if required. This is the time between the POS terminal and victor. 

6 Select OK. The file import begins. The file is validated first to ensure UnifiedPOS requirements are met. 
Select More Detail to view progress and status of import. 

Note: 
Workstation ID, and Retail Store ID must align with the corresponding object properties in victor. 

7 Select Close when import is complete. 

- End - 
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POS Search and Retrieve 
Using the POS Search and Retrieve wizard, you can search POS Transactions and view results alongside associated 
video data. Transaction video displays in the POS surveillance window while the associated transaction data displays 
in a separate pane. 

Procedure 219 Search POS Transactions 

Step Action 

1 Select Search and Retrieve (POS) from the Home tab. Transaction Search Wizard displays. 

2 Drag the required terminal or store into the terminal list area. 

3 Specify the start and end time to be searched within. 

4 Select checkbox if Customer Filtering is required, then select the filter 

• Include All Transactions - No Customer filtering. 

• Include only transactions with no customers (Requires Customer present video Intel-
ligence). 

• Include only transactions with customers (Requires Customer present video Intel-
ligence). 

Note: 
Customer Present Video Intelligence is a VideoEdge NVR 4.4+ licensed add-on. In order to use this 
feature, a license must be purchased for each camera. 

5 Apply UnifiedPOS search rules if required: 

a Select Q Object selector displays. 

b Select the POS Search property from the object selector. 

c Select OK Search property displays in the wizard. 

d Apply And/Or and Operator Values as required. 

e Apply Value as requires - This field may be a dropdown selection or free text depending on the Search 
property selected. 

6 Select Finish. Search results (video and transaction data) display in the POS surveillance window. 

- End - 
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POS Terminal View 
You can view POS transactions related to specific terminal objects directly from the device list. This action opens a 
transaction surveillance window displaying the cameras associated with that terminal. 

Procedure 220 POS Terminal View 

Step Action 

1 Right click the required terminal on the device list 

2 Select View. Transaction Viewer displays. 

3 Use playback controls to navigate to the required time interval. 

Note: 
You can use the play controls to navigate forwards and backwards through the video. While paused, 
you can drag in additional cameras or terminals that will be time synchronized with the others. As 
transactions occur on one of the terminals in the POS Transaction Viewer, the text of that transaction 
will be displayed in the text pane to the right of the video. The text will remain in this pane until it is 
replaced by another transaction. 

If configured, overlays are displayed in this view displaying camera regions defined for merchandise, Customer 
present, Employee or Terminal. Refer to Camera Region Editor. 

- End - 

POS Exceptions Reports 

POS Exception Reports 

in addition to raw POS transactions, victor can also import POS Exception Reports. A POS Exception Report 
typically lists transactions deemed to be exceptional in some way. 

Trying to align exception data with video data manually can be very time consuming and error prone. The victor POS 
exception report feature automates much of this process. 

Assuming the POS terminals are already configured (If not refer to Create POS Terminal Objects and Associate 
POS Terminals with Cameras). You can then import POS exception reports and align video data with the 
transactions. 

POS Exception Reports come in many different formats from different vendors and are often customized by company 
rules and procedures. Therefore, victor has a flexible template-based system that can understand many different 
report types and formats. 
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POS Exception Report Requirements 

At a minimum, POS exception reports must: 

• Be in Row-Column Format 

• Be either .csv or .xls file format 

• Contain columns for Date, Time and POS Terminal ID of the transaction 

• List exceptional transactions 

Any other information the report may contain will be imported and displayed but is not required for the import. 

Three types of rows are supported: 

• Key row (one) - The first row of the report.This row names the columns in the report 

• Terminal rows (one or more). Contain the transaction data 

• Group rows (one or more). Used to link together terminal rows 

Import POS Exception Reports 
The POS Report Import wizard guides you through the several steps required to import a new report and also create a 
report template. Templates are useful as the next time you import a report of that type, victor will recognize it and 
import it directly. 

Procedure 221 Import POS Exception Reports 

A Caution 
Before importing POS data into victor you should remove or securely obscure any sensitive credit card information. 
victor unified client has not been certified for PCI DSS compliance. 

Step Action 

1 Select Report from the Build tab. 

2 Select Import Report. Exception Report Import Wizard displays. 

3 Select Browse. 

4 Navigate to and select the exception report. 

5 Select Open. A Report Preview displays. Use the Report Type dropdown to select New or Existing. If it is a 
new report type, the wizard will guide you through the rest of the process, if you select an existing report type, 
the wizard will bypass report configuration and prompt for import. 

6 Select Next. Exception Report Header screen displays. Set the report header by selecting the row 
containing the required column headers. After selecting the header row, you can change the column header 
names by selecting the name in the preview area and entering a new name. 

7 Select Next. Mandatory Columns screen displays. Drag column headers from the preview datagrid into the 
relevant column dropboxes. 

8 Select Next. Additional Info screen displays. If your exception report groups exceptions underneath header 
rows, select a header row from the preview datagrid and then select a property header from the property table. 

9 Select Next. Save Report Template screen displays: 

• Enter New Report Name (Select Save when entered) - The new template will save 
with this name. 
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• Select Enable Customer Filtering if required. This means you can filter POS Excep-
tion Reports based on whether a customer was present at the time of the exception or 
not. 

Note: 
Customer Present Video Intelligence is a VideoEdge NVR 4.4+ licensed add-on. In order to use this 
feature, a license must be purchased for each camera. 

• Enter a Time offset if required 

10 Select Next. Import Summary Screen displays. Review the report summary and use Previous and Next 
Buttons to make any amendments as required. 

11 Select Finish. 

The report can be accessed from Build Tab > Exception Reports > Show All. Right click the report and select 
View, Send To or Delete as required. 

- End - 
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Generic Edge Devices and Reports 

Introduction 
You can import Generic Exception Reports which can be associated with either cameras or Generic Devices within 
victor to associate video data with report data. 

Generic Edge Devices must be configured within the client before reports can be created to associate victor video with 
report data. 

Generic Edge Devices 

These devices are hardware objects which are added to victor for reference only. They enable you to associate 
cameras so that when generic exception reports are run, you can view video aligned with report data. 

victor does not poll these devices for status, the only meaningful reference which links the device to reports is the 
External Identifier which maps to the report. 

Associated camera views can be accessed by right clicking on the objects in the device list and selecting View. 

Generic Exception Report Requirements 

At a minimum, exception reports must: 

• Be in Row-Column Format 

• Be either .csv, .txt, .xls or .xlsx file format 

• Contain columns for Date, Time and Generic Edge Device 

• List exceptional transactions 

Any other information the report may contain will be imported and displayed but is not required for the import to be 
successful. 

Three types of rows are supported: 

• Key row (one) - The first row of the report. This row names the columns in the report 

• Terminal rows (one or more). Contain the transaction data 

• Group rows (one or more). Used to link together terminal rows 
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Import Generic Exception Reports 
The Generic Exception Report wizard guides you through the several steps required to import a new exception report 
and also create report templates. Templates are useful as the next time you import a report of that type, victor will 
recognize it and import it directly. 

Procedure 222 Import Generic Exception Reports 

tep Action 

1 Select Exception Reports from the Build tab. 

2 Select Import Report. Exception Report Import Wizard displays. 

3 Select Browse. Open dialog displays. 

4 Navigate to and select the exception report. 

5 Select Open. A Report Preview displays in the File Select screen. 

6 Select Generic Edge Devices or Cameras from the Type dropdown. 

7 Use the Report Type dropdown to select whether the report is new or uses an existing template. If New 
Report Type is selected, the wizard will guide you through the rest of the process, if you select an existing 
report type, the wizard will bypass report configuration and prompt for import. 

8 Select Next. Exception Report Header screen displays. Set the report header by selecting the row 
containing the required column headers. After selecting the header row, you can change the column header 
names by selecting the name in the preview area and entering a new name. 

9 Select Next. Mandatory Columns screen displays. 

10 Drag column headers from the preview datagrid into the relevant column dropboxes. 

11 Select Next. Save Format screen displays: 

• Enter New Report Name (Select Save when entered) - The new template will save with 
this name 

• Enter an External Device Time Offset if required 

Note: 
This setting allows you to adjust for differences between the External device Clock and the Video 
System Clock so report time data and Video data align. 

12 Select Next. Import Summary Screen displays. Review the report summary and use Previous and Next 
Buttons to make any amendments as required. 

13 Select Finish. 

The report can be accessed from Build Tab > Exception Reports > Show All. Right click the report and select 
View, Send To or Delete as required. 

- End - 
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Camera Region Editor 

Introduction 
The Camera Region Editor provides a means to visually identify areas within a camera view represented by: 

• Customers 

• Merchandise 

• Employees 

• Terminals 

Making associations between camera defined regions and edge devices allows users to view pertinent regions of 
camera views when triggers are initiated from the associated items. 

Define Camera Regions 
Camera regions can be assigned from the Camera region editor in the Build tab, alternatively, you can access the 
editor by right clicking on a terminal on the device list and selecting Configure Regions. 

Procedure 223 
Edit Camera Regions 

Step Action 

1 Select Camera Region Editor from the Build tab. The Editor displays 

2 Select the Camera on which to draw the Region of interest (ROI). Camera view displays with drawing tools. 

3 Select the region type to be drawn from: 

• Customer Present 

• Merchandise 

• Employees 

4 Use drawing tools to draw the required ROI 

5 Select Save or continue drawing / editing as required 

- End - 
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Reports and Data Visualization 

Introduction 
The reporting function is used primarily to display Journal and Audit information on system objects and activity. 

Various predefined report templates are available within the client or alternatively, you can use 'Ad Hoc' reports for 
more customizable reports which allow search terms to be used. 

The Data Visualizer feature allows users to display report data graphically using Charts, Timelines and Report Grids. 

Journal Filter 
The Journal Filter is used to regulate the amount of data being written to the database (joumaled) by 
blocking/unblocking specific alert types. The feature is accessed from System Values on the Setup tab. 

The following message types cannot be blocked and will always be joumaled: 

• General Purpose Interface Activity 

• Operator Login 

• State Change 

• System Activity 

• System Error 

The default setting is to record, meaning messages will be written to the database unless they are blocked in the 
journal filter. 

Note: 
Motion Detection, Light Change and Motion Exception Alerts are blocked by default. 

Report exceptions are controlled at Object and Type level. Object Exceptions override Type Exceptions - therefore if 
an alert type is blocked at type level but allowed for a specific object, the object's alert will be written to the database 
but the block on the type remains valid. 
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Generate / Save Reports 
Various predefined report templates are available within the report editor. These can be used to generate reports to 
retrieve Journal and Audit information on system objects and activity. From the reporting dialog, reports can be saved 
so they can be executed later. 

Procedure 224 Generate / Save Reports 

tep Action 

1 Select Reports and Data Visualization from the Home tab. 

2 Select New from the dropdown. Reports Editor displays. 

3 Select the required date range using the Date Range Picker. 

4 If required, select a report Category from the dropdown. 

5 Select a report Template from the dropdown. 

Note: 
1. Available templates may vary depending on which integrations are installed. 
2. On selection each template populates the fields below the drop down with relevant filters 
(appropriate to report type). 

6 Select Pi and use the Object Selector to apply filters as required. 

7 Select New Tab checkbox to open results in a new tab (optional). 

8 Select from the following: 

• Execute to run the report 

• Visualize to send report results to Data Visualizer 

• Save to save the report for future use (new dialog displays) 

Note: 
The Save dialog allows the user to provide a Name and Description for the report. It also allows the 
user to specify whether the report should prompt for new/different filters when it is executed. If 
checked when the report is executed the standard report dialog will be presented with the saved 
report information loaded. If the user configures a report with 'Custom" as the Date Range, the report 
will prompt on execution so the user can specify dates. 

• Exit to exit without saving. 

- End - 
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Ad Hoc Reports 
The Ad Hoc tab contains journal message types that do not have associated report templates. The control that is 
shown for these types of reports allow you to pick an object, type or to enter a name to filter by. 

Procedure 225 Generate/Save Ad Hoc Reports 

Step Action 

1 Select Reports and Data Visualizer from the Home tab. 

2 Select New from the dropdown. Report Editor displays. 

3 Select the required date range using the Date Range picker. 

4 Select the Ad Hoc tab. 

5 Select the Event Type from the dropdown menu. 

6 Use the Object Selector or the Name textbox to enter a search term. 

7 Select New Tab checkbox to open results in a new tab (optional). 

8 Select from the following: 

• Execute to run the report 

• Visualize to send report results to Data Visualizer 

• Save to save the report for future use (New dialog displays) 

Note: 
The Save dialog allows the user to provide a Name and Description for the report. It also allows the 
user to specify whether the report should prompt for new/different filters when it is executed. If 
checked when the report is executed the standard report dialog will be presented with the saved 
report information loaded. If the user configures a report with 'Custom" as the Date Range, the report 
will prompt on execution so the user can specify dates. 

• Exit to exit without saving 

- End - 

Show All 
You can view an object list of all saved/available reports by selecting Reports on the Home tab and Show All. 

The saved reports are shown in a dynamic view and are by default grouped by Report Template type. 

Right Clicking on any report offers the following options: 

• Edit: Modify the filters for the report. 

• Delete: Deletes the saved report. 

• Execute: Displays a dynamic view with the results of the report. 

• Visualize: Displays a data visualization control with the results of the report. 
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Find in Journal 
The Find in Journal feature allows you to search for joumal records relating to specific objects of interest. 

If the Find in Journal feature is available for an object, it is typically accessible from the object's context menu. 

Procedure 226 Find in Journal 

tep Action 

1 Right click the required object. 

2 Select Find in Journal. Report Selection dialog displays. 

3 Select the required Report Type from the dropdown. 

4 Select the date range using the From and To date controls. 

Note: 
The Search Name will be populated by the name of the object selected. If required, enter the 
Operator Name. 

5 Select OK. Reports displays. 

- End - 

Log General Message 
You can write a manual entry to the joumal using the Log General Message feature. 

As well as entering a manual message, you can select and edit any of the predefined messages which may be 
available. 

General messages are available as a report type. 

Procedure 227 Log General Message 

tep Action 

1 Select Log General Message from the Home tab. Log Message(s) dialog displays. 

2 To enter a manual message: 

a Enter a message as required. 

b Select 9j to enter additional messages. Select to remove messages. 

c Select OK. Selected messages are joumaled. 

3 To enter a predefined message: 

a Select Select Message from Predefined Message log dropdown. 

b Select Predefined Message. 

c Select O to enter additional messages. Select 0 . to remove messages. 

d Select OK. Selected messages are joumaled. 

- End - 
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Predefined Messages 
Predefined Log Messages can be created which can then be used when required to acknowledge or clear an event 
without needing to type text. 

Messages are identifiable by their labels which are assigned when they are created. 

Labels and message fields are mandatory for every message created. Labels can be up to 100 characters in length 
and messages up to 3000. 

The language for each message can also be assigned, this means when a user logs a message, the messages 
available are filtered to provide current language messages only. To log a message in a different language, you must 
switch language in the client. 

Procedure 228 Create a Predefined Log Message 

tep Action 

1 Select Predefined Message Log from the Build tab. 

2 Select New from the dropdown menu. New Predefined Message editor displays. 

3 Select the Language dropdown. 

4 Select the language in which the message is to be displayed. 

5 Double click the Label textbox. 

6 Enter Label text as required. Double click the Message textbox. 

7 Enter message text as required. 

8 01Select   to add additional messages or to remove selected messages. 

9 Select Save. 

0 

- End - 
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Data Visualization 
Data Visualizer can be used use to graphically chart most event data available in victor. The charts can be used to 
visualize the data over time, and to compare different events as different data series. 

A typical use case for data visualizer could be for People or Object counting. This could be achieved by using Data 
visualizer combined with the VideoEdge Video Intelligence software add-on to form a useful People Counting solution. 

Note: 
The Video Intelligence software is a licensed add-on to the VideoEdge NVR product. You must obtain a license for 
each camera before the video intelligence features are available. 

Report Results 
Once search parameters have been entered into the Reports or Ad Hoc tab (see Generate / Save Reports and Ad 
Hoc Reports), select Visualize. Report results will display in the Data Visualizer. 

Search & Retrieve Results 

Once a Search & Retrieve has been run, select Al to view results in the Data Visualizer. 

Using the Data Visualizer 
Once data has been populated in the Data Visualizer, it can be further manipulated. 

`Drill Down' 
When results have been populated in the Data Visualizer, the X axis will display time relevant to search criteria and 
the Y axis will display the number of occurrences. In the example shown below, the search was carried out over a 3 
day period, with each column representing 1 day: 
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From this view, you can further 'drill down' into a time period by double clicking a column. For example, double clicking 
on the 'Apr 08' column will 'drill down' into that day, displaying columns for each hour, as shown below: 
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You can continue to 'drill down' into more narrow timeframes until the Drill Down Threshold of occurrences has been 
reached. The Drill Down Threshold is set from the Customize tab of the Data Visualizer and is the limit of number 
of occurrences that you can drill down to. Once the Drill Down Threshold has been reached, double clicking a 
column will open a surveillance pane displaying results. If no video is associated, drilling down will return a view of the 
type. 

Customize Tab 
Buttons available on the Customize tab are outlined below: 

it al it I, Fit Horizontal & Vertical - fits chart horizontally and vertically 

4-1 Fit Horizontal - fits chart horizontally 

Fit Vertical - fits chart vertically 

-I- Toggle Crosshairs - toggles crosshairs on chart on and off 

121- Toggle Gridlines - toggles gridlines on chart on and off 

is, Export to File - exports current data visualizer view as a .jpg file 

{LI , Export to Excel - exports current data visualizer view and data in Microsoft Excel format (.xlsx) 

- Export to XPS - exports data as a .xps file 

The Series section of the Customize tab enables customizing of the color of all series displayed in the data 
visualizer, along with the ability to add a Mean line or Trendline to the chart. 
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The Customize section of the Customize tab enables changing of axis settings to Log Axis and Show Zeros, along 
with changing the series Type (Line, Column, Bar, Area), which Trendline (Linear, Logarithmic, Quadratic, Cubic) is 
displayed and setting of the Drill Down Threshold. 

Filter Tab 
The Filter tab allows for filtering of the chart by Object Type, Object Name or Alarm. Select required option then 
select Update Chart to apply. 

Report Search 
Selecting the Report Search tab opens the report search interface from which reports and ad hoc reports can be run. 
Refer to Generate / Save Reports for more information. 
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Sites 

Introduction 
A Site is a user definable list of folders into which you can drag devices and objects. 

Sites allows users to organize and group objects into logical folder views instead of the traditional device driven views. 

Users can create sites and folders with custom names and organize the objects within according to criteria relevant to 
that site. 

For example, a folder can be named 'East Car Park' and that folder can be used to group objects related to that 
particular area (Cameras, Recorders etc.) 

The site list is therefore used as a convenient method from where to open objects and views related to a particular 
physical location. 

Create a Site 
You can add new sites to victor which allow you to group and manage devices within a specific area. 

Procedure 229 Create a Site 

tep Action 

1 Select the Sites tab. Site window displays. 

2 Right Click in the white space within the sites window. 

3 Select Add Site. A new folder is created called New Site. 

4 To rename the folder 

a Right click the folder 

b Select Rename Site 

c Enter Site Name 

d Select OK. 

Note: 
Site list reorders alphabetically as new sites are added, deleted or renamed. 

5 To Add Objects: 

a Select the object to be added 

b Drag and Drop into the required site folder 

c Repeat as required 

6 To Remove Objects: 

a Right click the object to be removed 

b Select Remove from the list. 
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Note: 
Delete option is also available in this context menu. Selecting Delete removes the object 
permanently. 

- End - 

Add All Objects from a Map to a Site 
All objects from a map can be added to a Site. This allows for configuration of areas of your facility on a map to be 
quickly added to a site for logical grouping. 

Procedure 230 Add All Objects from a Map to a Site 

Step Action 

1 Select the Sites tab. Site window displays. 

2 Right Click on the Site you want to add objects to. 

3 Select Add Items from Map. Object Selector opens. 

4 Select the Map to add objects from then select OK. All objects from the Map will be added to the Site. 

- End - 

Adding a Items to a Site from the Right Click Menu 
You can add new compatible items to a site at any time using the right click menu. 

Procedure 231 Adding a Items to a Site from the Right Click Menu 

tep Action 

1 Navigate to the required item. 

2 Right click on the item. 

3 Select Add to Sites... 

The Object Selector window opens. 

4 Click Select All to select all the available folders, you can de-select all by clicking Clear All. 

Or 

Select the folder(s) you want to add the item too. 

5 Click OK. 

- End - 

American Dynamics 258 

EFTA01224067



General Purpose Interface 

Introduction 
The General Purpose Interface (GPI) is a programmable bi-directional communication protocol which enables victor to 
interact with third party devices. 

To achieve this, the General Purpose Interface: 

• Initializes communication between victor client and a third party device. 

• Maintains a communications channel by polling the third party device. 

• Defines General Purpose Actions which send messages to third party devices using victor event activation 
and supports acknowledgment messages from third party devices. 

• Defines General Purpose Monitoring Points which represent monitoring points in third party devices. 

• Defines General Purpose incoming message protocols which interpret incoming messages from third party 
devices and support acknowledgment for incoming messages. 

Terminology 

GPI General Purpose Interface 

Device The central third party hardware device 

Monitoring Point victor data type which changes state based on 
incoming messages from the device 

Protocol 

Action Messages Sent to the device as a result of events triggered in 
victor 

Actions 
Objects created in victor which are transmitted to 
the General Purpose Device based on activated 
events in victor 

Input Where the input strings are sent from the device 
through the Serial/Network port to victor 

Output Where the output is an action and requests a 
response from the device 

Poll Where the poll is an action which requires a 
response from the device 

STX Start of Text 

ETX End of Text 
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The General Purpose Interface can work with any device which uses ASCII code communications protocol for event 
monitoring, such as: 

Intercom Process Control Equipment 

Burglar/Intrusion Environmental 

Dome Control Lighting 

Access Control Refrigeration 

Elevators Wireless Communication 

The third party device sends pure ASCII messages via a serial port (RS-232) or remotely via a TCP/IP port (Lantronix 
or Systech) to the General Purpose Interface Driver. 

This means that you can respond to alarms from many types of third party devices as well as the system video and 
health alarms described in 'Events'. 

The General Purpose interface supports the following functionality: 

• Input - Where the input strings are sent from the device through the Serial/Network port to victor 

• Output - Where the output is an action and requests a response from the device 

• Poll - Where the poll is an action which requires a response from the device 
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Monitoring Points 
Monitoring Points are victor data types which change state based on incoming messages from the device. Monitoring 
Points can be configured to directly trigger Events. 

Events can be designed to activate any victor event action. 

You can configure a message protocol which then parses the received Monitoring Point string. You can also define 
header and trailer characters in the Protocol area of the General Purpose Interface. 

Monitoring Points can also be annunciated at the monitoring station and written to the historical journal. 

Monitoring Point Message Processing 
When the General Purpose Driver receives the message from the device, it does the following: 

1 Parses the message and looks for poll or action responses 

• If it finds a poll or action response, it processes the response 

• If it does NOT find a poll or action response, it continues to parse 

2 Looks for a message protocol 

• If it finds a message protocol, it processes the protocol 

• If it does NOT find a message protocol, it continues to parse 

Note: 
The device can delimit the message with or without header and trailer characters 

Poll Command 
The Poll Command, frequency of polling and expected response (Poll Command Acknowledgment) are all defined as 
part of the configuration of a specific General Purpose Device. 

Poll Command Acknowledgment 

Some protocols will include an acknowledge character returned to the device that issued the polling command - this is 
additional confirmation that the general purpose device received the command. 

Output 
Output is performed using an Action which is activated by an Event. The output sends a string of characters to the 
General Purpose Device through the serial/network port. 

The optional expected response is also configured as part of the action. 
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Virtual Keyboard 
As the ASCII characters between 0 and 32 are not visible on screen and have no equivalent keyboard button, the 
virtual keyboard is relied on to enter these values. Some common values are the STX (Start of Text) and ETX (End of 
Text) which have no keyboard button but can be entered via the virtual keyboard. 

When configuring some General Purpose Interface components, you will be required to use a Virtual Keyboard as not 
all characters are available on a standard keyboard. The keyboard displays on screen when • is selected. 

The virtual keyboard is required when entering text into: 

• General Purpose Device Editor - Device Information section to enter the Poll Com-
mand/Poll Command Acknowledgment 

• General Purpose Protocol Editor - Protocols section to enter keywords 

• General Purpose Action Message Editor - Action Message section to enter Out-
going and Acknowledgment messages 

• General Purpose Monitoring Point Editor Messages section to enter Acknow-
ledgment message 

NUL SOH STX SIX EOT I ENQ ACIFT1 8El rEtqMT 
CR SO SI OLE OC1 OCEMDC3TO-C41 NAK SYN-I ETB1 

CAN [EMI- SUB ESC  I GS ERS r US DEL TAB I 

giCaLLAILE 

ASCII Table Button 
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NUL I SOH I STX J ETX I EOT ENQ I ACK I BEL I BS I LF I VT FF 

CR I SO J Si j DLE J oci f DC2 f DC3 I DC4 I NAK I SYN I ETB 

CAN I EM I SUB I ESC I FS I GS I RS I US I DEL I TAB 

ASCII TABLE 

Dec Hex Char Deo Hex Char Dec Hex Char Dec Hex Char Dec Hex Char Dec Hex Char 
00 00 NUL 24 18 CAN 48 30 0 72 48 H 96 60 ' 120 78 x 
01 01 SOH 25 19 EM 49 31 1 73 49 I 97 61 a 121 79 y 

02 02 STX 26 IA SUB 50 32 2 74 4A J 98 62 b 122 7A z 
03 03 ETX 27 1B ESC 51 33 3 75 4B K 99 63 c 123 7B { 
04 04 EOT 28 IC FS 52 34 4 76 4C L 100 64 d 124 7C 

05 05 ENQ 29 1D GS 53 35 5 77 4D H 101 65 e 125 7D } 

06 06 ACK 30 1E RS 54 36 6 78 4E N 102 66 f 126 71 
07 07 BEL 31 IF US 55 37 7 79 if 0 103 67 g 127 7F DEL 

08 08 BS 32 20 SP 56 38 8 80 50 P 104 68 h 
09 09 HT 33 21 ! 57 39 9 81 51 Q 105 69 i 

10 OA LF 34 22 • 58 3A : 82 52 R 106 6A 3 
11 OB VT 35 23 # 89 3B ; 83 53 S 107 6B k 
12 OC FF 36 24 S 60 3C < 84 54 T 108 6C 1 

13 0D CR 37 25 t 61 3D = 85 55 U 109 6D m 
14 OE SO 38 26 6 62 3E > 86 56 V 110 6E n 

15 OF SI 39 27 ' 63 3F ? 87 57 W 111 6F o 

16 10 DLE 40 28 64 40 @ 88 58 X 112 70 p 
17 11 DC1 41 29 ) 65 41 A 89 59 Y 113 71 q 
18 12 DC2 42 2A • 66 42 B 90 5A Z 114 72 r 
19 13 DC3 43 2B + 67 43 C 91 5B [ 115 73 s 

20 14 DC4 44 2C 68 44 D 92 50 \ 116 74 t 
21 15 NAK 45 2D - 69 45 E 93 SD ] 117 75 u 
22 16 SYN 46 2E • 70 46 F 94 SE " 118 76 v 

23 17 ETB 47 2F / 71 47 G 95 51 119 77 w 

Procedure 232 Entering Text Using the Virtual Keyboard 

tep Action 

1 Navigate to the field where text is to be entered. 

2 Select  . Virtual Keyboard is displayed. 

3 Select characters as required. Characters display in the text field. 

Note: 
ASCII table can be viewed by selecting ASCII Table 

4 Select Save. 

- End - 

Create New Device 
Third Party Devices can be created and configured within the client. 
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Field Description 

Name Enter a unique name to identify the General 
Purpose Device. 

Description Enter a description of the General Purpose Device. 

Enabled Select checkbox to enable the General Purpose 
Device. 

Vendor Click to select the name of the manufacturer of the 
General Purpose Device. 

Poll Period (seconds) 
Enter the period in seconds during which victor 
attempts to poll this General Purpose Device. The 
default value is 10 seconds. 

Poll Command 

Enter the poll command (command string) that 
victor sends to the General Purpose Device. 

Open the virtual keyboard by selecting • , 
allowing creation and editing of text strings. 

Poll Command Acknowledgment 

Enter a poll command acknowledgment (the 
command string) that the General Purpose Device 
sends back to victor as acknowledgment of the poll 
message. 

Open the virtual keyboard by selecting 0  , 
allowing creation and editing of text strings. 

Journal Unknown Message Select this option to record unknown messages 
received by victor in the historical journal 

Serial Port Select Serial Port if you are using a serial 
connection. This is the default port type. 

Network Port Select Network Port if you are using a terminal 
server for the connection. 

IP Address 

Enter the TCP/IP address of the network port 

Note: 
This option is only available if you select 
the Network Port option. 

Communication Port 

Enter the port number: 
• Serial Port - enter a port number such as COM1, 

COM2, etc. 
• Network Port - enter the TCP/IP port number 

which the terminal uses to communicate with 
victor 

Reconnection Period (secs) 

Enter the duration in seconds before trying to 
reconnect to an unresponsive network device. 

Note: 
This field is only available if you select the 
Network Port option 

TimeOut Delay Time (1/10 secs) Enter the extra interval (in 1/10 seconds) that victor 
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waits for a response from the device after sending 
a message to the switcher. 

If a response is not received in time, the message 
is retransmitted or communications failure 
declared. 

Default value is 20 (2 seconds). 

Comm Fail Delay Time (secs) 

Enter the time period (in seconds) after the 
TimeOut Delay Time expires that victor waits to 
declare an unresponsive device as failure. 

Default value is 300 seconds. 

Header Character 

Enter a value (in decimal) to define the first 
character in a message from the General Purpose 
Device. Zero (0) indicates that any character can 
be the first character. 

Default value is zero (0) 

Trailer Character 

Enter a value (in decimal) to define the last 
character from the General Purpose Device. 

Default value is 13. 

Note: 
1. The value cannot be zero (0). 
2. A Trailer Character is mandatory. 

Message Resend Count 

Enter the number of times victor should attempt to 
resend a message that the device has not 
acknowledged receiving. 

Default value is zero (0). 

Max Buffer Size 

Enter the maximum size of the buffer that stores the 
message from the device. 

Default value is 2000. 
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Procedure 233 Create New Device 

step Action 

1 Select Device from the Setup tab. 

2 Select New. General Purpose Device editor displays. 

3 Enter a name for the device in the Name textbox. 

4 Enter a description for the device in the Description textbox. 

5 The Enabled checkbox is selected by default. To disable the device, deselect the checkbox. 

6 Select the vendor from the Vendor drop down menu. 

7 Enter Poll Period. 

Note: 
1. When configuring a non-zero Polling Period, non-zero values should be set for TimeOut Delay 
and Comm Fail Delay times. 
2. When configuring a zero Polling Period, zero should also be set for TimeOut Delay and Comm 
Fail Delay times. 

8 Enter the poll command in the Poll Command textbox. This is a stream of bytes, usually set by the device 
manufacturer, sent on a regular basis to the device to maintain communications. 

9 Enter Poll Command Acknowledge. This is the expected response from the device which is sent back to 
victor as acknowledgment of the poll message. 

10 The Journal Unknown Message checkbox is deselected by default. To enable, select the checkbox. 

Note: 
Enabling Journal Unknown Message means that any message received by the victor General 
Purpose server component that does not match an existing protocol will be sent to the activity 
viewer. When disabled, unknown messages are ignored. 

11 Select either Serial Port or Network Port. 

• If Serial Port is selected: 

a Enter Communication Port. 

• If Network Port is selected: 

a Enter IP Address. 

b Enter Communication Port. 

c Enter Reconnection Period. 

12 Enter TimeOut Delay Time in 1/10th seconds. 

13 Enter Comm Fail Delay time. 

14 Enter Header Character. 

15 Enter Trailer Character. 

Note: 
Trailer Character is mandatory. 

16 Enter Message Resend Count. 

17 Enter Max Buffer Size. 
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18 Select Property from the drop down menu. 

19 Select Value from the drop down menu. 

20 Select J then select an Action from the Object Selector. 

21 Select Save. 

- End - 

Create New Monitoring Point 
New monitoring points can be created and configured from the General Purpose Interface. 

Each monitoring point supports up to five activated status properties which are assigned during configuration. 
Activation and deactivation messages associated with each monitoring point are drawn from the message protocol 
pool. 

State changes occur depending on the interpreted incoming messages of the General Purpose Device. State changes 
are recorded in the journal logs and can trigger other actions in victor. 

Field Description 

Name Enter a unique name for the monitoring point. 

Description Enter a description of the monitoring point. 

Enabled Select to enable the monitoring point. 

General Purpose Device Select the General Purpose Device to be 
monitored. 

Acknowledgment Message 
Enter a message string that victor sends to the 
General Purpose Device as an acknowledgment 
message. 

Journal Message 
(1-5) 

Enter a meaningful word to identify the message 
logged in the historical journal by this device. 

Activation Message 
(1-5) 

Select ..g  and use the Object Selector to select a 
General Purpose Incoming Message Protocol to 
trigger this monitoring point to activate. 

Deactivation Message 
(1-5) 

Select 91 and use the Object Selector to select a 
General Purpose Incoming Message Protocol to 
trigger this monitoring point to deactivate. 

Procedure 234 Create New Monitoring Point 

Step Action 

1 Select Monitoring Point from the Setup tab. 

2 Select New. Monitoring Point Device editor displays. 

3 Enter a name for the monitoring point in the Name textbox. 

4 Enter a description for the monitoring point in the Description textbox. 

American Dynamics 267 

EFTA01224076



5 The Enabled checkbox is selected by default. To disable the device, deselect the checkbox. 

6 In the Device section, select and use the Object Selector to select the required device. 

7 Enter Acknowledgment Message. 

8 Enter a meaningful word or phrase in the Journal Message 1 textbox. 

9 Select Oland use the Object Selector to select an Activation Message. 

10 Select ° and use the Object Selector to select a Deactivation Message. 

11 Repeat steps 8-10 to add more joumal, activation and deactivation messages, up to a maximum of 5. 

12 Expand the Alerts section. 

13 Select[ O1 to add an alert. 

14 Select Property from the drop down menu. 

15 Select Value from the drop down menu. 

16 Select   then select an Action from the Object Selector. 

17 Select Save. 

- End - 
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Add New Protocol 
New general purpose protocols can be created and configured from the General Purpose Interface. This is the 
language used to communicate with the device. 

Protocols are established via a dynamic process which combines match criteria, keywords and character positioning. 
Individual message protocols then get combined with monitoring points to identify state changes in the General 
Purpose Device. 

Optionally, acknowledgment messages can be associated and transmitted with the monitoring point. 

Field Description 

Match Criteria 
(1-5) 

Select match criteria for the keyword: 
Include - the system will expect the keyword to be 
included in a message from the General Purpose 
Device 
Exclude - the system will not expect the keyword to 
be included in a message from the General 
Purpose Device 

Keyword 
(1-5) 

Enter a keyword (max 50 characters) from this 
message protocol. 

Note: 
ASCII Hex 00 (Zero Zero) cannot be used 
in a keyword 

Position 
(1-5) 

Enter a position for the keyword: 
Value >0 (Zero) - the software device receiver 
searches for the keyword only at this position when 
mapping a message 
Value =0 (Zero) - the keyword can be at any 
position in the message (default) 

Example: To find -CDE' in the string -ABCDE, the 
Keyword value should be •CDE* and the Position 
value, l' 

Note: 
Spaces and unprintable characters such 
as carriage returns (<CR>) or line feeds 
(<LF>) must be counted 

Procedure 235 Add New Protocol 

tep Action 

1 Select Protocol from the Setup tab. 

2 Select New. General Purpose Protocol editor displays. 

3 Enter a name for the protocol in the Name textbox. 

4 Enter a description for the protocol in the Description textbox. 

5 Select Match Criteria from the drop down menu. 

6 Enter a Keyword. 
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7 Enter the Position. 

8 Repeat steps 5-7 to add more protocols, up to a maximum of 5. 

9 Select Save. 

- End - 

Create New Action Message 
New action messages can be created and configured from the General Purpose Interface. Action messages are sent 
to the device as a result of events triggered in victor. 

Field Description 

Name Enter a unique name for the action message 

Description Enter a description for the action message 

Outgoing Message Define a message for victor to send to the General 
Purpose Device 

Acknowledgment Message 
Define the message sent by the General Purpose 
Device as acknowledged that the outgoing 
message was received 

Procedure 236 Create New Action Message 

step Action 

1 Select Action Message from the Setup tab. 

2 Select New. Action Message editor displays. 

3 Enter a name for the action message in the Name textbox. 

4 Enter a description for the action message in the Description textbox. 

5 Enter outgoing message text in the Outgoing Message textbox. 

6 Enter acknowledgment message text in the Acknowledgment Message textbox. 

7 Select Save. 

- End - 
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Create a new General Purpose Action 
New actions can be created and configured from the General Purpose Interface. Actions created in victor are 
transmitted to the General Purpose Device based on activated events in victor. Actions can be associated with 
acknowledgment messages. 

Field Description 

Name Enter a unique name to identify the General 
Purpose Action 

Description Enter a description of the General Purpose Action 

General Purpose Device Select CI' and use the Object Selector to select the 
General Purpose Device being monitored 

General Purpose Action Message 
Select 10-I and use the Object Selector to select the 
General Purpose Action Message that this action 
triggers 

Procedure 237 Create a new General Purpose Action 

tep Action 

1 Select Action from the Setup tab. 

2 Select New. General Purpose Action editor displays. 

3 Enter a name for the action in the Name textbox. 

4 Enter a description for the action in the Description textbox. 

5 Select --13  next to General Purpose Device and use the Object Selector to select the device being 
monitored. 

6 Select 131 next to General Purpose Action Message and use the Object Selector to select the action 
message that this action triggers. 

7 Select Save. 

- End - 
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Health Monitoring 

Introduction 
victor Health Dashboard displays the health status of all active configured victor devices. 

The dashboard uses color coding to indicate the health status of devices: 

Green - Normal 

Yellow -At Risk 

Orange - Pre-Failure (Also applies to failover VideoEdge NVRs not currently in use) 

Red - Device Alert 

Gray - Unknown State 

The color coding for health alerts can be edited using "Health Monitoring Preferences". 

Note: 
1. Intellex and HDVR/exacqVision recorders that do not use all analog ports display as red (Device Alert). If you prefer 
the recorders displayed as gray (unknown Alert) as opposed to red you can disable offline cameras via the victor 
camera editor. 
2. Disabled or excluded devices are not visible in Health Monitoring. 
3. If a recorder is excluded the connected cameras and audio devices will also be excluded. 

Alerts can be configured to display in the Health Dashboard for the following items: 

Recorders 

Alert Category Alert Name 

Alert Status Normal 

Unknown 

Overheat 

Reboot 

Alarm Recovery Completed 

Sensor Alarm 

Archive Storage Status Normal 

Unknown 

Degraded 

Protection Status Primary Not Active 

Primary Active 
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Failover 

Monitor 

None 

Storage Status Unknown 

Normal 

Disk Full 

Raid Degradation 

Volume Missing 

No Volumes 

Volume Corrupt 

Volume Failed 

New Volume 

Volume Re-Added 

Unhealthy Disk 

Disk Temperature 

Cameras/Audio 

Alert Category Alert Name 

Camera Video Loss 

Unknown 

Dark Frame Detection 

Normal 

Video Recording Failure 

Video Pipeline Failure 

Alert Status (Audio) Unknown 

Normal 

Audio Recording Failure 

Audio Loss 

Communication Status Online 

©American Dynamics 273 

EFTA01224082



Unknown 

Offline 

Unknown 

Storage Status Unknown 

Normal 

Maximum Retention 
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Using the Health Dashboard 
The Health Dashboard can be launched from the Home tab: 
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The Health Dashboard will open displaying 2 panes: the Alerts View pane and the Device View pane. 

Alerts View Pane 
The alerts pane displays a summary of the active health alerts in the system. Double-clicking a device within the 
alerts pane will display details on the alerUmalfunction and provide details of when the alerUmalfunction occurred. 

The alerts view pane displays all health dashboard supported devices and sites, along with an indication of their health 
status. Devices which will display in the health dashboard are: 

Recorders Intellex 

VideoEdge NVR 

HDVR/exacgVision 

ADTVR 
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Controllers iStar 

apC 

ISC 

Intrusion Devices DSC PowerSeries Panels 

Bosch Receivers 

Sur-Gard Receivers 

Fire Devices Simplex 41000 Panels 

MZX Panels 

Doors iStar 

apC 

ISC 

Elevators Kone 

Otis 

Thyssen Krupp 

Health status is indicated by highlighting at Object Type Level. Users can then navigate through the Device or Site 
List to display health status information for all devices. Double clicking a device in the Device/Site List Pane will 
display more detailed information in the Device Information Pane. 

Device View Pane 
The device view pane will display selected devices in their own tab. Use the device type selector icons to select a 
device type or select a device on the Alerts View pane to display the detailed information. 

Various controls and filters are available to limit or expand device information by type, severity or device quantity per 
page. You can also expand/collapse device information and use pagination controls to scroll dashboard pages. 
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Device Information Tab 
The Device Information Tab displays more detailed information of configured victor devices, including those selected 
from the Device/Site List Pane and can be used to display detailed health status information for the selected device. 

For example, double clicking a recorder will open an interface like the one shown below: 
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This interface displays detailed device information as well as the health status of the device. To view all configured 
objects of a certain type, use the device category buttons. 

Health Mode in Maps 
Health status information can be viewed on Maps. For more information, refer to Viewing Maps. 
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Unification/Integration 

Introduction 

C•CURE Unification 
You can manage C•CURE 9000 access control events through victor. Lock and unlock doors, check status of access 
control devices, and acknowledge events and alarms. In addition, you can arm and disarm inputs and deactivate and 
pulse outputs. You can see the status of all controllers and other access control devices both from the device list and 
through maps. Events can be acknowledged in either C•CURE 9000 client or the victor client as required and update 
real-time. C•CURE 9000 alarms display on victor maps, event viewer and in reports/activity list. 

Note: 
victor and C•CURE integration requires the following versions: 
victor version v4.2+ 
C•CURE 9000 v2.1+ 
For detailed installation instructions, refer to the victor/C•CURE unification manual. 

Third Party Integrations 
victor extends Event Management support to various third party fire and intrusion integrations. For a full list of drivers, 
refer to the American Dynamics website (www.americandynamics.net):

Integration with third party add-ons enables victor's device list to display Third party hardware. All objects support the 
victor privilege configuration and authorization. 

All actions and state changes related to integrated objects are written to victor's journal database and display on the 
activity list. victor's reports also support Access Control, Fire and Security modifications. 

Alarms from integrated objects can be used to trigger victor Events. 

Refer to the relevant victor integration manual for detailed information on integration, installation and operation 
instructions. 
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Appendix A: victor MAS/SAS Support 

Introduction 
To enhance scalability and deployment in enterprise environments, victor unification with C•CURE allows you to 
configure a site that is part of a 'hub-and-spokes' topology, but also has the ability to function in a disconnected 
environment with complete local command and control. 

The Master Application Server (MAS) and up to 20 Satellite Application Servers (SAS) can be deployed as a single 
system. The satellite servers provide real time response for critical operations like events and actions while the 
master server provides a rolled up monitoring and reporting interface. 

Each SAS contains database records for the system hardware connected to it, as well as other data relating to user 
authentication and authorization. Each SAS synchronizes with the MAS so that SAS local data is replicated to the 
MAS for central management and monitoring. 

Data Types 

Data Types 
Global: Data which is configured on the MAS and synchronized to all SASs. 

Local: Data which is configured on and exists only on SASs. 
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Installation 
The following enterprise deployments are supported: 

• Installing victor locally on a C-CURE SAS or remotely connecting to a C-CURE SAS 

• Installing C-CURE on an existing victor Application Server and making it a SAS in an existing Enterprise 
environment 

• Installing victor on the MAS 

Note: 
Installing victor without C-CURE is not supported in SAS/MAS deployments 

MAS Installation 
Unified Server MAS can be installed by running the Tyco Security Products unified installer. The standard unified 
server installer lays down all prerequisites required for MAS/SAS installation. 

A Caution 
Refer to product datasheets for information on system hardware and software requirements 

MAS Installation prerequisites 

The system where the MAS software will be installed must be a dedicated system on a domain. The system 
should not host any other major applications 

Ensure clocks are synchronized between the MAS and the SASs 

The Windows domain user account of the MAS installer must be a system administrator for the system where the 
MAS will be installed. (The account you install under must be a domain account, not a local computer account.) 

The Windows user account of the MAS installer must have been configured as a SQL Administrator (sysadmin 
role) 

The SQL Browser Service must be enabled and running 

You must have or obtain a MAS software license with the Application Server option enabled 

Note: 
Grant Administrative privileges to your Domain account on the new MAS. 

Step Action 

1 Follow the standard installation instructions provided on the unified server Installation guide until the Install-
ation Type dialog displays. 

2 At the Installation Type dialog, select Advanced (for Enterprise users) and select Next. Destination folder 
displays. 

3 Select Next. 

4 Select Application Server Installation. Further options display. 

5 Select Install as a Master Application Server. 
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6 Select Next. 

7 Enter the database server name.Database server and Login Credentials dialog displays. 

8 Select the local SOL server required for the installation (previously installed) as the Database Server and 
select Next. The Remote Access Credentials dialog displays. 

9 Enter Domain Username and Password as required. 

Note: 
Use a Domain AccountlUsemame whose password will not be automatically updated as this will 
adversely affect future connectivity. If your Windows password should change, you will need to 
update the password used by the unified Windows services. 

10 Select Next. The Ready to Install dialog displays listing the installation directory and the system server 
type. 

11 Select Install. 

Note: 
1. The Installing displays detailing status messages and progress (This process can take a 
considerable amount of time) 
2. If the installation completes without errors, the InstallShield Wizard Completed dialog box opens 
3. If you received any warnings during the installation, the system displays a dialog box listing the 
number of warnings. You can view these warnings in the %TEMP% directory. 

12 Select Finish. 

Note: 
Once installation completes, you must register the product within sixty days from the date the 
application was installed. 

- End - 
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SAS Installation 
Unified Server SAS can be installed by running the Tyco Security Products unified server installer. The standard 
unified server installer lays down all prerequisites required for MAS/SAS installation. 

SAS Installation prerequisites 

pl_i i _'_i 

The system where the SAS software will be installed must be a dedicated system on a domain. The system should not 
host any other major applications 

Ensure clocks are synchronized between the MAS and the SASS 

The Windows domain user account of the SAS installer must be a system administrator for the system where the SAS 
will be installed. 

The Windows user account of the SAS installer must have been provisioned as a SQL Administrator (sysadmin role) 
on the MAS. 

The Windows user account of the SAS installer must have been previously configured as a victor/C.CURE Global 
Operator with the SYSTEM ALL Privilege at the MAS to which this SAS will connect. 

The CrossFire Services must be configured to run using a domain user account on the SAS. That account must also 
be a MAS operator able to access the MAS SQL database. 

The SQL Browser Service must be enabled and running. 

The MAS server that will be the master server for this SAS must be reachable via the network (its name or IP address 
must be resolvable). 

The MAS server that will be the master server for this SAS must be running as well as the Software House CrossFire 
Framework and Component Framework Services. 

A Caution 
Refer to product datasheets for information on system hardware and software requirements 

Step Action 

1 Follow the standard installation instructions provided on the unified server Installation guide until the Install-
ation Type dialog displays. 

2 At the Installation Type dialog, select Advanced (for Enterprise users) and select Next. Destination folder 
displays. 

3 Select Next. 

4 Select Application Server Installation. Further options display. 

5 Select Install as a Satellite Application Server and enter the Master Application Server name or IP 
Address and select Next the Database server ddialog displays. 

6 For the Database Server, select the required SAS database server name. 

7 Select Next. 

8 Enter your DomainlUsername and your Password, confirm your password and click Next. The Ready to 
Install the Program dialog box opens listing the location of the Installation directory, the Database server 
type, and the system SQL server type. 

9 Select Install.The Installing dialog displays. 
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Note: 
1. The Installing displays detailing status messages and progress (This process can take a 
considerable amount of time) 
2. If the installation completes without errors, the InstallShield Wizard Completed dialog box opens 
3. If you received any warnings during the installation, the system displays a dialog box listing the 
number of warnings. You can view these warnings in the %TEMP% directory. 

10 Select Finish. 

Note: 
Once installation completes, you must register the product within sixty days from the date the 
application was installed. 

- End - 

©American Dynamics 283 

EFTA01224092



Operation 
MAS/SAS deployment affects how users interact with victor in various ways. Each of the following subsections 
describes the enhanced user experience in affected areas as well as system capabilities and how they differ from a 
non MAS/SAS environment. 

Data Synchronization 
victor specific data configured at the SAS in local partitions will synchronize up to the MAS. The victor Journal and 
Audit will synchronize from the SAS to the MAS every four hours by default (this value can be changed in System 
Values). 

victor Application Server Interaction 
General 

On the MAS, the dynamic view of victor Application Servers lists all the SASs and the MAS the user has access to: 

Site Manages 
(Mire ❑.-.niptkon I CV .01( ( 141 c IXvkYtxwl Man-

ECS2DS:ARME'r 2 Unif,eO.1AS 

13OS2DEVSAS1 SAS 01 

BOS2STEVETR2VM SAS 02 

BOS2STEVETTU2 SAS 03 

81.R1WKO077 SAS 04 

8112TARM02 SAS OS 

80(i Raton, F; PIrt3ry 

Westford. MA interactive 

Westford, MA Interactive 

Westford. MA Interactive 

Bangalore. Inds* Interactive 

Belfast. Ireland Noniinteractwe 

Ready to Synchronize 

Ready to Synchronize 

Ready to Synchronize 

Ready to Synchronize 

Ready to Synchronize 

Otfline 

One Or mere partner renters has a problem 

Interactive 

From the dynamic view on the MAS you have the option to go interactive/non•interactive with a given SAS. This is 
done via the right-click context menu. 

When a victor Application Server is made interactive, it means that activity and events will be sent from the SAS up to 
victor that is connected to the MAS (as if the client was directly connected to the SAS as its primary server). 

You can configure whether each operator is be default interactive with any given victor Application server in the 
Application Server section: 

0 Applkalion Servers 
l'nk SAS (nth Operitcr to men,101 them MAOrnitiCally wen operator logs in 

Name otkoptiOn •Address LCKatsOn 
J. BOS20CVSAS1 SAS 01 1113t145..153 viestran MA 
..0 BOS2STEVETR2VM SAS 02 1038.145.1SO West's:M. MA 
J BOS2STEVET7U2 SAS 03 1113t145.151 Vitslfool. MA 
J. B.RIWKD077 SAS 04 10.47512.25 Bangalore. India 
..e REI.2TAR1.402 SAS 05 16925460232 Breast Ireland 

The items that are checked will be automatically interactive at startup when this operator logs in. 

Sites 
When a server is started, it will create a Site in the Site List with the same name as the victor Application Server. This 
can be changed, but can't be deleted. This means that every installation will have at least one Site present at all times. 
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Events 
Events that are configured on the MAS are global. That means all events configured will be synchronized to all 
interactive SASs. 

The Event Viewer on the MAS is an event sink for all events from all SAS that are currently interactive. 

If the source of an event activation belongs to an existing site, the site name will display in the Site field. If the source 
does not belong to an existing site, the site that was created by the victor Application Server is displayed. 
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SAS Online: Normal event management (Acknowledge/Clear) workflows work the same as if directly connected to 
the SAS. 

SAS Offline: The event activation in the event viewer cannot be modified. 

The operations that are performed on any event activation on the MAS or SAS is mirrored in real-time in both event 
viewers. 

The review operation available via the context menu will operate as normal on both the MAS and SAS. 

Event Setup 
Configure All: 

Event Configurations of this type are synchronized to all SASs. This means that if the user configures All Doors -> 
Forced -> Activate Global Event, every door in the Enterprise will activate this event when the door is forced. 

Specific Objects: 

These event configurations are saved on the SAS that owns the object being configured. So for a specific SAS door -> 
Forced -> Activate Global Event, the configuration for this action will be saved at the SAS. 

Note: 
Event Setup editor on the MAS shows configurations for all objects in related SASs. 
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Maps 
Maps can be created on MASs and SASs. 

MAS Maps: Maps created on MASs will not synchronize to SASs. 

SAS Maps: Maps created on SASs, along with all their layers and objects are synchronized to the MAS and are 
available to the MAS client. 

Health Monitoring 
Health monitoring at the MAS displays the health of all supported devices enterprise wide and if the SAS is interactive, 
the states update accordingly. 

The victor Application Server health status is included on the MAS dashboard as well as the status of all available 
MAS and SAS machines. 

Reports/Data Visualization 
At the MAS client, reporting and data visualization is available for data up to the last successful synchronization of 
SAS data up to the MAS. 

Licensing 
There are no additional license requirements to install victor on a SAS. 
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Appendix B - Creating & Editing Templates 

Introduction 
victors Incident Management supports the ability to create a central report which ties together incident components in 
a user-defined format. This is controlled by two methods; the first is during export control, you can change the report 
order of individual items in the Direct Clip Action window. The second is via the default templates / user created 
templates. 

Templates and generated reports use Microsoft's OpenXml standard, and are therefore supported by a number of word 
packages in addition to Microsoft Word. 

Note: 
Microsoft Word 2007 onwards supports the OpenXml standard. 

Adding and Deleting Templates 

Templates can be added during the report generation process from the Direct Clip Action window by clicking [01. this 
opens a file explorer window allowing navigation and select of the desired template.Templates can also be removed by 

clicking 

Note: 
Templates are referenced rather than copied. It is recommended to store templates in a shared location. 

Creation of Templates 
The following information is based on the process required for Microsoft Word (specifically the 2010 release). 

Templates must be created and saved as .dotx files (Word XML Document), .dotx files allow the creation of the format 
of the template and to order the content. The incident components are inserted using the Content Controls, along with 
the inclusion of their own static content and formatting, this allows for the creation of bespoke report templates. 

Note: 
The Content Controls are available on the Developers ribbon. The ribbon is not shown by default 

Procedure 238 Displaying the Developers Ribbon - MS Word 

Step Action 

1 Open MS Word. 

2 Select File. 

3 Select Options. 

The Word Options window opens. 

4 Select Customize Ribbon. 
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5 Select the Developer checkbox in the Main Tabs pane. 

6 Click OK. 

- End - 

Content Controls Recognized by Incident Builder 

Content 
Control Name Description Report Output 

Title Incident Name Text 

Date Date of export Text 

Image Incident Image (Requires a Picture Content Control to 
manage the output size of the image Image 

Media Incident clip Clip name linking to the player 

Spreadsheet Incident spreadsheet Spreadsheet name linking to the spreadsheet 
file 

Note Text Rich Text 

Hyperlink Additional files File name linking to the actual file 

RemainingContent A place holder for additional content that hasn't been 
already added to the document 

All of the above. Note - Images will be limited 
by the page size 

Note: 
Only Content Controls with a title matching one of the names above will be replaced during report generation. 

Inserting a Picture 
When a new template file has been created or when editing an existing template, pictures can be added using the 
Content Controls in the Developer ribbon. 

Procedure 239 Adding a Picture to a Template 

Step Action 

1 Select the Developer tab. 

The Develop ribbon displays. 

2 Select g 

An image placeholder is placed in the document. 

3 Resize/ position the placeholder as required. 

4 Select Properties from the controls module of the Developer ribbon. 

Note: 
Ensure the content is selected. 

The Content Control Properties window opens. 
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Content Control Properties ? x 

General 

Locking 

❑ Content control cannot be deleted 
❑ Contents cannot be edited 

OK Cancel 

5 Enter IMAGE in the Title field. 

6 Enter a value/description in the Tag field to provide context to the content. The Tag is used on the incident 
export page for the content. 

7 Click OK. 

- End - 

Inserting Content Control for Text and Content Links 
Text and Content Links can be placed using the Rich Text Content Control icon in the Developer ribbon. 

Procedure 240 Adding all other Supported Content to a Template 

Step Action 

1 Select the insertion point using the cursor. 

2 Select Aa 

A Rich Text placeholder is placed in the document. 

Click here to enter text. 

3 Select Properties from the controls module of the Develope ribbon. 

Note: 
Ensure the content is selected. 

The Content Control Properties window opens. 
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Content Control Properties X 

General 

TN: 

❑ Use a style to format contents 

Style: Default Paragraph Font v 

-44 New Style... 

Locking 

❑ Content control cannot be deleted 
❑ Contents cannot be edited 

Rich Text Properties 

❑ Remove content control when contents are edited 

OK Cancel 

4 Enter a Title in the field. The title must be one of the following - 

• TITLE 

• DATE 

• MEDIA 

• SPREADSHEET 

• NOTE 

• HYPERLINK 

• REMAININGCONTENT 

5 Enter a value/description in the Tag field to provide context to the content. The Tag is used on the incident 
export page for the content. 

6 Click OK. 

- End - 

Further Information 
Further information for the use of Content Controls, you can search the internet for information on - 

• Word Content Controls 

• OpenXml 

• OpenXml SDK 

Note: 
The OpenXML SDK's productivity tool can be used for discovering issues and understanding document structure. 
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Appendix C: Deploying the victor Web Service 

Introduction 
The following section provides background information on the victor Web Service and its integration with victor Web 
LT. 

General 

The victor Web Service is a Representational State Transfer (REST) service developed using the ASP.NET MVC4 
Web API technology. The Web Service provides a RESTful API using the latest Model View Controller (MVC) design 
available with the .NET 4.5 framework. 

The RESTful API enables the Partner web applications connecting to the Web Service to do GET/PUT/DELETE and 
POST operations. 

The victor Web Service is hosted on a Microsoft Internet Information Services (IIS) Web Server. 

victor Web LT 

From release V4.7 victor Web LT has been enhanced to support vAS Integration, allowing the receipt of alerts from 
victor Unified Client to victor Web LT. This feature is reliant on web sockets, using the victor Web Service for vAS 
integration is not supported in a Windows 7 Environment. The victor Web Service can be deployed on a separate 
Windows 8/ 8.1 / Server 2012 platform to act as a 'middle-man' between the Windows 7 victor environment and the 
victor Web LT server. 

Issue 

Before you run the installation dashboard, ensure that the manual prerequisites are installed / enabled to successfully 
deploy the victor Web Service. 

Solution 

The following prerequisites must be installed / enabled to permit the successful deployment of the victor Web service. 

• IIS (Microsoft Internet Information Services)— In all instances IIS must be enabled prior to running the 
installation dashboard 

• ASP.NET MVC 4 (Framework)— In all instances MVC 4 must be downloaded and installed prior to running 
the installation dashboard 

• ARR (Application Request Routing 3.0)— In instances where a vAS Integration with victor Web LT is 
required on a single system, i.e. the vAS, victor Web Service and victor Web LT are all installed on one 
system, ARR must be downloaded and installed before running the dashboard. 
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Procedure 241 Prior to running the victor only installer Windows 7 

Step Action 

1 Enable IIS. 

a Click Start. 

b Type Turn on Windows Features' in the search field, and press RETURN. 
The Windows Features window opens. 

a Windows featu 

Turn Windows features on or off 
To turn a feature on, select its check box. To turn a feature cff, clear its 
check box. A filed box means that only part of the feature is turned on. 

Games 
Indexing Service 

1 Internet &plata 10 
Internet Information Services 
Internet Information Sextets Plostable Web Core 

• Media features 
RI Microsoft .NET Framework 35.1 

Microsoft Message Queue (MSMQ) Server 
RI Print and Document Serrates 
./ Remote Deferential Compression 

RIP Listener 
toev.• paint NfS 

OK Cancel I 

c Select the Internet information Services checkbox. 

d Click OK. 

Note: 
For Windows Server 2012 the web server role must be enabled to activate IIS. 

2 Download and install MVC 4. 

a Open your Internet Browser and search for ASP.NET MVC 4. Download should only be acquired from 
the official Microsoft site. 

b Select the option to install using the standalone MVC 4 Installer. 

c Select the required language. 

d Click Download. 

e Once downloaded, launch the executable and follow the instructions of the installation wizard. 

3 Launch the victor Installer Dashboard and commence installation. 

- End - 
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Procedure 242 Prior to running the victor only installer Windows 8 / 8.1 / Server 2012 
with victor Web LT vAS Integration 

Step Action 

1 Enable IIS. 

a Click Start. 

b Type Turn on Windows Features' in the search field, and press RETURN. 
The Windows Features window opens. 

fy Windows 

Turn Windows features on or off 
To lure a feature on, select its check box. To tuns a feature oft clear its 
check bow- Arced box means that orgy part of the feature is tuned on. 

n I. Games 
Indaing Service 

• Internet Explorer 10 
kernel Int orma 'ion $4.^..ceis 
Internet Information Strokes Hostable Web Core 
Media Features 

• a Microsoft NET Framework 33.1 
Mir tosoft Message Queue (MSMQ) Server 

• oi Pont and Document Services 
• Remote Dig etenuai Compassion 

RIP Listener 
(new. few Nft 

OK Cancel I 

c Select the Internet information Services checkbox. 

d Click OK. 

Note: 
For Windows Server 2012 the web server role must be enabled to activate IIS. 

2 Download and install MVC 4. 

a Open your Internet Browser and search for ASP.NET MVC 4. Installer package should only be down-
loaded from the official Microsoft site. 

b Select the option to install using the standalone MVC 4 Installer. 

c Select the required language. 

d Click Download. 

e After the installer downloads, launch the executable and follow the instructions of the installation wizard. 

3 Download and install ARR 

a Open your Internet Browser and search for Application Request Routing Offline Installer. Installer 
package should only be downloaded from the official Microsoft site. 

b Click Install this extension. 

c Click Install Now. 

d Once downloaded, launch the executable and follow the instructions of the installation wizard. 
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Note: 
During the deployment of the victor Web LT standalone installer, ARR settings will be automatically 
configured. 

4 Launch the victor Installer Dashboard and commence installation. 

5 Once completed, launch the victor Web LT standalone installer. 

- End - 

Procedure 243 Prior to running the Unified installer Windows 7 

Step Action 

1 1. Enable IIS 

a Click Start. 

b Type Turn on Windows Features' in the search field, and press RETURN. 
The Windows Features window opens. 

Turn Windows features on or off 0 
To turn a feature on, select its check box. To turn a feature off, clear its 
check box. A fulled box means that only part of the feature is turned on. 

rrni, Games 
Indexing Service 

rigj Internet Explorer 10 

I I, Internet Information Sconces Hostable Web Core 

LL X. Media Features 
• Microsoft .NET Fremovork 331 

IL T). Microsoft Message Queue (MSMQ) Sent 
• Print and Document Services 

711 y Remote DIfferential Compression 
I. RIP Listener 

r. eavrnfmNf( 

Internet Int ormatron Services 

OK 

c Select the Internet information Services checkbox. 

d Click OK. 

Note: 
For Windows Server 2012 the web server role must be enabled to activate IIS. 

2 Download and install MVC 4. 

a Open your Internet Browser and search for ASP.NET MVC 4. Download should only be acquired from 
the official Microsoft site. 

b Select the option to install using the standalone MVC 4 Installer. 

c Select the required language. 

d Click Download. 

e After the installer downloads, launch the executable and follow the instructions of the installation wizard. 

3 Launch the Unified Installer Dashboard and commence installation. 
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• End • 

Procedure 244 Prior to running the Unified Installer Windows 8 / 8.1 / Server 2012 with 
victor Web LT vAS Integration 

Step Action 

1 Enable IIS. 

a Click Start. 

b Type Turn on Windows Features' in the search field, and press RETURN. 
The Windows Features window opens. 

I
f& Vfavdows Features 

Turn Windows features on or off 0 

To turn a feature on, select its check box. To turn a feature off, clear its 
check box. A flied bar means that only part of the feature is turned on. 

Games 
Indexing Service 

I Internet Friskier 10 
Internet Information Se”..ces 
Internet Information Services Hostable Web Core 
Media Features 

• D Microsoft .NET Frameteo.rk 331 
Microsoft Message Queue (MSMQ) Serve, 

• fi Print and Document Services 
Remote Differential Compression 
RIP listener 
Services for NES 

OK 

c Select the Internet information Services checkbox. 

d Click OK. 

Note: 
For Windows Server 2012 the web server role must be enabled to activate IIS. 

2 Download and install MVC 4. 

a Open your Internet Browser and search for ASP.NET MVC 4. Installer package should only be down-
loaded from the official Microsoft site. 

b Select the option to install using the standalone MVC 4 Installer. 

c Select the required language. 

d Click Download. 

e After the installer downloads, launch the executable and follow the instructions of the installation wizard. 

3 Download and install ARR 

a Open your Internet Browser and search for Application Request Routing Offline Installer. Installer 
package should only be downloaded from the official Microsoft site. 

b Click Install this extension. 

c Click Install Now. 
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d Once downloaded, launch the executable and follow the instructions of the installation wizard. 

Note: 
During the deployment of the victor Web LT standalone installer, ARR settings will be automatically 
configured. 

4 Launch the Unified Installer Dashboard and commence installation. 

5 Once completed, launch the victor Web LT standalone installer. 

- End - 

Procedure 245 PROCEDURE - STANDALONE VICTOR WEB SERVICE DEPLOYMENT 

Step Action 

1 Enable IIS. 

a Click Start. 

b Type Turn on Windows Features' in the search field, and press RETURN. 
The Windows Features window opens. 

ff  Windows Keay 

Turn Windows features on or off 
To turn a feature on, select its check box To tun a feature oft dear its 
check box. A filed box means*** only part of the feature is tuned on. 

Games 
Indexing Service 
Internet Explorer10 
intend Information .Ser.,-.ces 

Internet Information Services Hostable Web Core 
J Media Features 

. 0 Microsoft .NET Framework 33.1 
Microsoft Message Queue (MSMQ) Server 

. DI Print and Document Services 
J Remote Differential Compression 

PIP Listener 
Services for NES 

( OK Cancel 

c Select the Internet information Services checkbox. 

d Click OK. 

Note: 
For Windows Server 2012 the web server role must be enabled to activate IIS. 

2 Download and install MVC 4. 

a Open your Internet Browser and search for ASP.NET MVC 4. Installer package should only be down-
loaded from the official Microsoft site. 

b Select the option to install using the standalone MVC 4 Installer. 

c Select the required language. 

d Click Download. 

it, American Dynamics 296 

EFTA01224105



e After the installer downloads, launch the executable and follow the instructions of the installation wizard. 

3 Download one of the following Installation packages from the American Dynamics website. 

a victor Unified 

b victor Only 

c victor Application Server and SQL 32/64 bit 

4 After you download the installer, extract the contents of the zip file and navigate to the bin folder within the 
package. 

5 Double-click CrossFireWebService.msi. 

6 The following dialog box appears if your system does not have Microsoft .NET Framework 4.5 installed. Click 
Install to proceed. 

CrossFdeWebServiceSetup 

The °taro COMPOrgit WI be neded x you machine 

licroecit .NET Framework 4.5 et86 and x64) 

Do you vesh to wS these ocerponeried 

e no &cote Cancer. sews yet era 

canto 

7 After Microsoft .NET Framework 4.5 installation is finished, the victor Web Service Setup Wizard appears. 
Click Next. 

8 Click Next. The End-User License Agreement appears. 

9 Select I accept the terms in the License Agreement and click Next. 
The Destination Folder screen appears. Click Next to display the server and database authentication screen. 

victor web service for end-users Setup 

CCURE 9000 Server and Database Authentication 
Select COPE 900) server and database server authenticattm method 

Select the COPE 9000 server. Admiristrative rights on the server are rewired. 

igcal system 

r Remote system 

Please enter user credentials 

Doman: 

Lain ID: 

eassword: 

ICFSAD 

mbrom 

Next > I cancel I 
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10 Select the Remote System option button. 

11 Enter the domain and name of the victor Application Server you want to include in your vAS Integration, or its 
IP address. 

12 Enter the Login ID of the vAS 

Note: 
This must be a Windows Administrator Account 

13 Enter the Password of the vAS. 

14 Click Next. 

15 If the installer is unable to identify the database server automatically, a dialog box appears to request that you 
enter the servemame and database instance (Example: myserverl SaLExpress) and click OK. 
The Installation Options dialog box appears. 

16 If you are installing the Web Service in a Redundant configuration, select Redundant server installation using 
supported third party redundancy and enter the domain and name of the Virtual server system, or its IP 
address. 

17 Click Next. 

18 Click Next to begin the installation. A dialog box with a progress bar appears so you can monitor installation 
progress. 
The Installation Completed screen appears. 

19 Click Finish to complete the installation. 

- End - 

Issues with victor Licensing Options 

Issue 

This technical bulletin informs our customers on how to address issues for certain add-on options on their victor Server 
software license: 

Use Case Model Number Description 

1 ADVC-WEBSERVICE Add-on license option to support victor Web Service V4.5.1+ 

2 ADVC-MATRIXDVR Add-on license option to support Matrix DVR V4.5.1+ 

Pre-requisites 
• Compatible host PC that meets/exceeds the system requirements for the installed server 

application/license: 

• victor Professional (aka Site Manager) 

• Unified Server (Victor/C•CURE) 

• Compatible host PC that meets/exceeds the system requirements for the installed client application: 

• victor Unified Client 

• In Warranty or valid SSA for victor software license 
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• Valid login account for victor (Windows Domain or Basic Authentication) 

• Email and internet access 

If you purchased the optional victor Web Service licensed add-on option (ADVC-WEBSERVICE), registered and 
applied the updated license, but are having issues with an application that is designed to integrate using the victor 
Web Service, then please following the steps below: 

Procedure 246 How to fix victor Web Service (For victor V4.5.1 and higher) 

Step Action 

1 Log into the host PC running the victor or Unified Server software using administrator-level credentials. 

2 Launch the Server Configuration application (Run as administrator) and proceed to save a screenshot of the 
Services tab. 

3 Next, launch the License Manager application and proceed to save a screenshot for each tab: Unified tab, 
victor tab and CCURE tab. 

4 From License Manager, click Generate from the Unified tab and save the XML-generated file. 

5 Proceed to send an email to to request assistance with victor Web Service issue. 
Please be sure to attach the following five (5) files: 

a Screenshot of Services tab from the Server Configuration application 

b Screenshot of Unified tab from the License Manager application 

c Screenshot of victor tab from the License Manager application 

d Screenshot of CCURE tab from the License Manager application 

e XML file generated by the License Manager application 

6 After the Licensing Team receives the email with the required files, they will review the request and send you 
an updated same-version victor license file during normal business hours. 

7 Save the updated victor license file (.LIC) onto the victor or Unified Server. 

8 From License Manager, click Add new license from the Unified tab and select the updated victor license 
file. 

Note: 
Only one (1) victor license file (e.g. HostName_v45_x64_ESS#WWWWWWWW:frifft_esslicense.lic) and 
one (1) CCURE license file (e.g. CCURE9000.LIC) should be present in the default folder. If more 
than one victor license is present, then you must manually rename/move/delete the older victor 
license file(s). 
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a Oa 

L r! L. 4 Local Disk (C:) a Program Files (d6) a Tyco s CrossFire A License -H Search License p 

Elk Edit view look Help 

Organize - Include in library • Share with • Burn New folder 

ko 

▪ ko-KR 

▪ License 

4 Logging 

nl 

E IL@ 

Name 
_awinizuige_ouzci.odrunnyuntic_rivicu_, cuir_440-4.4nuou-sou... 

CCURE9000.UC 

2. 8O52LBS/-0NMACH2_v46 x6d_ESS1013201,16036_esslicenstlic 

Type 
VLV 

UC File

LK File 

victorTemp 00.lic.bak1 BAKI File 

10 items 

Note: 
After the License Manager has successfully added the updated victor license file, it should prompt 
the message about restarting the services to activate the new license. Make sure to proceed with 
restarting services in order for the application to use the updated license file. 

Note: 
On a Unified system or C•CURE 9000 system, the License Manager will not automatically restart 
the services after adding a license file. Therefore, you will need to manually launch the Server 
Configuration application and proceed to STOP and START both of the CrossFire Services. 

9 After the services have been restarted, check the following applications: 

a Server Configuration: Check the Services tab to make sure that all services are running. 

b License Manager: Check the Unified, victor and CCURE tabs to make sure all of the license inform-
ation is correctly being recognized. 

10 Your victor or Unified Server should now be properly configured and victor Web Service should now be 
working. 

- End - 

HOW TO FIX MATRIX DVR (FOR VICTOR V4.8 AND HIGHER) 

If the optional Matrix DVR licensed add-on option (ADVC-MATRIXDVR) was previously purchased/licensed for 
V4.5.1 or V4.6, then these customers will need to follow the steps below after upgrading to V4.8 to support the correct 
number of Matrix DVR recorders. 

Procedure 247 How to fix Matrix DVR (For victor V4.8 and higher) 

Step Action 

1 Log into the host PC running the victor or Unified Server software using administrator-level credentials. 

2 Launch the Server Configuration application (Run as administrator) and proceed to save a screenshot of the 
Services tab. 
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3 Next. launch the License Manager application and proceed to save a screenshot for each tab: Unified tab. 
victor tab and CCURE tab. 
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Note: 
Confirm that the SSA is still valid (see Unified tab). If expired, then contact your sales associate or 
email to request a quote to purchase SSA before continuing. 

4 From License Manager, click <Generate> button from the Unified tab and save the XML-generated file. 

Anti fej License Manager 

Unified victor CURE 9000 

General License Information 
License types. victor - Professional 

CURE 9000 - Series P 

victor SSA expires on: Saturday. October 31. 2015 

victor sepal number: F55101320146036 

(-CURE 9000 SSA expires on: Friday, March 18, 2016 

(CURE 9000 serial number: 9.99999 

Crossfire : Current version licensed 

Acquire License 

Generate system information: 

License details 
License directory: C: \ Program Files (036) \ Tyco \ Crossf ire \ License 

License flies 

805218SHINMACHZ.v46x64ESS101320146036..esslicense.k 
CCURF900atIC 

Add new license 

Name 

unifiedServer_BOS2LBSHINMACH2SysInfo.xml 
Type 
XML Document 

5 Proceed to send an email to to request assistance with victor Web Service issue. 
Please be sure to attach the following five (5) files: 

a Screenshot of Services tab from the Server Configuration application 

b Screenshot of Unified tab from the License Manager application 

c Screenshot of victor tab from the License Manager application 

d Screenshot of CCURE tab from the License Manager application 

e XML file generated by the License Manager application 

6 After the Licensing Team receives the email with the required files, they will review the request and, if valid, 
will generate and email an updated same-version victor license file during normal business hours. 

7 Save the updated victor license file (.LIC) onto the victor or Unified Server. 

8 From License Manager, click Add new license from the Unified tab and select the updated victor license 
file. 
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3. license Manager =  1 1 

Unified victor C•CURE 9000 

General License Information 
License types : victor - Professional 

CCURE 9000 - Series P 

victor SSA expires on : Saturday. October 31.2015 

victor canal numbet ESS101320146036 

CCURE 9000 SSA expires on : Friday, March 18.2016 

CCURE 9000 :tie' number : 9.99999 

Crossfire Current version licensed 

Acquire license 

Generate system information : Generate 

License deeds 
License directory :CAProgram Files 0436WYCCAO0SSfirMLiftnfr 
License files: 

80S2L8SHINMACH2_v46_x64ESS101320146036 est/Kerne ric 
CCURE90XtUC 

Add new kense 

Note: 
Only one (1) victor license file (e.g. HostName_v45_x64_ESS#WWWWWWWWWW#Lesslicense.lic) and 
one (1) CCURE license file (e.g. CCURE9000.LIC) should be present in the default folder. If more 
than one victor license is present, then you must manually rename/move/delete the older victor 
license file(s). 

S  Local Disk (C:) a Program Files (66) a Tyco a CrossFire a License "__.) 4, I Search License ,p 

Eile Edit view DOS tidy 

Organize • Include in library • Share with • Burn New (Scher Eli 
ko 

ko-KR 

4,, License 

J. Logging 

nl 

Name 
U-10 J••• VlU 

Type 
rot 

LIC File 3
LIC File 

BAK1 File 

f CCURE9000.LIC 

  BOS2U3SHINMACH2_v46_x64_ESS101320146036_esslicensetic 

4 

vittorTernp 001 ic.bak1 
ul 

10 items 

Note: 
After the License Manager has successfully added the updated victor license file, it should prompt 
the message about restarting the services to activate the new license. Make sure to proceed with 
restarting services in order for the application to use the updated license file. 

Note: 
On a Unified system or C•CURE 9000 system, the License Manager will not automatically restart 
the services after adding a license file. Therefore, you will need to manually launch the Server 
Configuration application and proceed to STOP and START both of the CrossFire Services. 

9 After the services have been restarted, check the following applications: 

a Server Configuration: Check the Services tab to make sure that all services are running. 
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b License Manager: Check the Unified, victor and CCURE tabs to make sure all of the license inform-
ation is correctly being recognized. 

10 Your victor or Unified Server should now be licensed and configured to support all of your Matrix DVR 
recorders via the victor Unified Client software. 

- End - 
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Appendix D: Supporting Newer Client Versions on older 
Server Software 

Introduction 
This section explains how to support newer victor Unified Client software versions on older victor Application Server 
software versions. For customer sites that are dependent on version-specific server integrations, they have been 
traditionally unable to use any client-side feature enhancements and/or bug fixes due to incompatibility between 
server-and-client application versions. For those customers who fall into this scenario, we have incorporated changes 
to address this requirement and can now support the following use cases: 

Use 
Case victor Application Server Version 

Compatible Version of victor Unified Client 

Default Version Optional Compatible 
Version 

1
V4.5.1 
V4.5.1N2.30R2 

victor Professional 
Unified victor/C•Cure V4.5.1 victor Unified Client V4.8 victor Unified Client

2 
V4.6 
V4.6N2.40 

victor Professional 
Unified victor/C•Cure V4.6 victor Unified Client V4.8 victor Unified Client 

Pre-requisites 
• Compatible host PC that meets/exceeds the system requirements for the installed server 

application/license: 

• victor Professional (aka Site Manager) N4.5.1 or higher) 

• Unified Server (victor/C•CURE)N4.5.1N2.30R2, V4.6N2.40, V4.7N2.40, 
V4.8N2.42) 

• Compatible host PC that meets/exceeds the system requirements for the installed client application: 

• victor Unified Client (V4.5.1, V4.6, V4.7, V4.8) 

• victor or Unified victor/C•CURE must be in warranty or have valid SSA 

• Valid login account on victor (Windows Domain or Basic Authentication) 

• Valid login account on American Dynamics web page (access to Online Registration) 

• Email and internet access 

Supporting newer Client versions on older Server software (for victor V4.5.1 and higher) 

if your victor or Unified Server deployment is unable to upgrade the server software due to version-specific 
integrations, then you have the ability to update the victor Unified Client software version by following the steps below: 

Procedure 248 Updating victor Unified Client Only 

Step Action 

1 Log into the host PC running the victor or Unified Server software using administrator-level credentials. 

2 Launch the Server Configuration application (Run as administrator) and proceed to save a screenshot of the 
Services tab. 
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3 Launch the License Manager application and proceed to save a screenshot for each tab: Unified tab, victor 
tab and CCURE tab. 
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Note: 
Confirm that the SSA is still valid (see Unified tab). If expired, then contact your sales associate or 
email to request a quote to purchase SSA before continuing. 
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4 From License Manager, click Generate from the Unified tab and save the XML-generated file. 

'rip License Manager 

Walled victor C.CURE 9000 

General License Information 
License types: victor - Professional 

C-CURE 9000 - Series P 

victor SSA expires co : Saturday. October 31.2015 
victor serial number: E55101320146036 

CCURE 9000 SSA expires on: FreSay, March 18, 2016 

CCURE 9000 serial number: 9.99999 

CrossEire : Current version licensed 

Acquire License 

Generate system information : r Generate 1 

License deals 
License directory: CAProgram Res (x86)\ Tyco $. Crosshreticense 
License Hes : 

805.21.8SHINMACH2_v46_44 ESS101320146036_esslicense.lic 
CCURE9000UC 

Add new license 

Name 

unifiedServer_BOS2LBSHINMACHZ.Sysinfo.xml 
Type 

XML Document 

5 Proceed to send an email to to request assistance with updating your current victor 
Server license (V4.5.1 or V4.6) to V4.8. Please be sure to include the following information and attachments: 

a Specify that you require an updated license-only file to enable support for V4.8 victor Unified Client. 

b Screenshot of Services tab from the Server Configuration application. 

c Screenshot of Unified tab from the License Manager application. 

d Screenshot of victor tab from the License Manager application. 

e Screenshot of CCURE tab from the License Manager application. 

f XML file generated by the License Manager application. 

6 After the Licensing Team receives the email with the required information and files, they will review the 
request and, if valid, will generate and email an updated same-version victor license file during normal 
business hours. 

7 Save the updated victor license file (.LIC) onto the victor or Unified Server. 

8 From License Manager, click Add new license from the Unified tab and select the updated victor license 
file. 
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License Manager 

fed victor I C-CURE 9000 

General license Inf orrrtabon 
License types: 

VICO( SSA expires on: 

victor serial number: 

CCURE 9000 SSA moves on: 

CCURE 9000 serial number: 

Crossfire: 

Acquire License 

victor - Professional 
CCURE 9000 - Senes P 

Saturday. October 31. 2015 
ESS 101320146036 
Friday, March 16 2016 

9-99999 
Current version licensed 

Generate system information : Generate 

License detais 
License directory: CAProgram Files (x86)‘TycoN,Crossfire‘Litense 

License kits: 

BOSILESHINMACHZ.v46_xfd_ESS101320146036esslicensek 
CCURE900GUC 

Add new license 

• •

Note: 
Only one (1) victor license file (e.g. HostName_v47_x64_ESS#WWWWWWWWWW#Lesslicense.lic) and 
one (1) CCURE license file (e.g. CCURE9000.LIC) should be present in the default folder. If more 
than one victor license is present, then you must manually rename/move/delete the older victor 
license file(s). 

f bai (e) . Program Res 0661 F Tyco F 0.,,Firi. License  .  41 
Be Edit DEW look tidy 

Organize • Inckak in Wary • Share will Brim Nen folder 

▪ ka 
ko-KR 

k License 

in Logging 
• nl 

10 lens 

iolo Sal 

Starch LIM,

Name Type 
_aaininatage_iy../aueearionrowa-ne.intau_ieJeW2/41-3UNINeditnitY./... ULU rue 

CCURI9000.LIC 

BOS2LBSHINMACH2_v46_,64_ESS101320146036_esslicenserIc 

UC File 

LK File 

BAK1 File L, victorTemp 00.6c.bakl 

Note: 
After the License Manager has successfully added the updated victor license file, it should prompt 
the message about restarting the services to activate the new license. Make sure to proceed with 
restarting services in order for the application to use the updated license file. 

9 After the services have been restarted, check the following: 

a Server Configuration: Check the Services tab to make sure everything is Running. 

b License Manager: Check the Unified, victor and CCURE tabs to make sure all of the license inform-
ation is correctly being recognized. 

10 Your victor or Unified Server should now be licensed and configured to support the newer V4.8 victor Unified 
Client software. 

11 Launch your web browser and go to the American Dynamics web site (www.americandynamics.net). 
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12 Login with your assigned web site credentials and go to the Support > Software Downloads page. 

13 Navigate to Video Management Systems > victor > victor Installation Software v4.8 page, scroll-down 
and click on victor Client Only to download the V4.8 victor Unified Client software. 

Softer< Downloads 
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14 Once downloaded, proceed to upgrade only the clients to the latest V4.8 victor Unified Client software 
which will now be compatible with your older victor or Unified Server software version (V4.5.1 or V4.6). 

- End - 
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End User License Agreement (EULA) 

IMPORTANT - READ THIS END-USER LICENSE AGREEMENT ("EULA") CAREFULLY BEFORE 
OPENING THE DISK PACKAGE, DOWNLOADING THE SOFTWARE OR INSTALLING, COPYING 
OR OTHERWISE USING THE SOFTWARE. 

THIS EULA IS A LEGAL AGREEMENT BETWEEN YOU AND SENSORMATIC ELECTRONICS, LLC 
("TYCO"), WHICH SOFTWARE INCLUDES COMPUTER SOFTWARE AND MAY INCLUDE MEDIA, 
PRINTED MATERIALS, AND "ON-LINE" OR ELECTRONIC DOCUMENTATION (COLLECTIVELY, 
THE "SOFTWARE"). BY BREAKING THE SEAL ON THIS PACKAGE, DOWNLOADING THE 
SOFTWARE OR INSTALLING, COPYING OR OTHERWISE USING THE SOFTWARE, YOU AGREE 
TO BE BOUND BY THE TERMS OF THIS EULA. IF YOU DO NOT AGREE TO ALL OF THE TERMS 
AND CONDITIONS OF THIS EULA, DO NOT OPEN, DOWNLOAD, INSTALL, COPY OR 
OTHERWISE USE THE SOFTWARE. 

I. SCOPE OF LICENSE. The Software may include computer code, program files and any associated media, 
hardware or software keys, printed material and electronic documentation. The Software may be provided to you 
pre-installed on a storage device (the media) as part of a computer system or other hardware or device ("System"). 
The Software is protected by copyright laws and international copyright treaties, as well as other intellectual prop-
erty laws and treaties. All title and intellectual property rights in and to the Software (including but not limited to 
any images, photographs, and text incorporated into the Software), the accompanying printed materials, and any 
copies of the Software, are owned by Tyco and/or its suppliers. The Software is licensed, not sold. All rights not 
expressly granted under this EULA are reserved by Tyco and its suppliers. 

2. GRANT OF LICENSE. This EULA grants you the following rights on a non-exclusive basis: 

a. General. This EULA permits you to use the Software for which you have purchased this EULA. Once you 
have purchased licenses for the number of copies of the Software that you require, you may use the Software and 
accompanying material provided that you install and use no more than the licensed number of copies at one time. 
The Software is only licensed for use with specified Licensor-supplied Systems. If the Software is protected by a 
software or hardware key or other device, the Software may be used on any computer on which the key is 
installed. If the key locks the Software to a particular System, the Software may only be used on that System. 

b. Locally Stored Components. The Software may include a software code component that may be stored and 
operated locally on one or more devices. Once you have paid the required license fees for these devices (as determ-
ined by Tyco in its sole discretion), you may install and/or use one copy of such component of the Software on 
each of the devices as licensed by Tyco. You may then use, access, display, run or otherwise interact with ("use") 
such component of the Software in connection with operating the device on which it is installed solely in the man-
ner set forth in any accompanying documentation or, in the absence of such, solely in the manner contemplated by 
the nature of the Software. 

c. Remotely Stored Components. The Software may also include a software code component for operating one or 
more devices remotely. You may install and/or use one copy of such component of the Software on a remote 

©American Dynamics 310 

EFTA01224119



storage device on an internal network with all of the devices and may operate such component with each device 
over the internal network solely in the manner set forth in any accompanying documentation or, in the absence of 
such, solely in the manner contemplated by the nature of the Software; provided however, you must still acquire 
the required number of licenses for each of the devices with which such component is to be operated. 

d. Embedded Software/Firmware. The Software may also include a software code component that is resident in a 
device as provided by Tyco for operating that device. You may use such component of the Software solely in con-
nection with the use of that device, but may not retrieve, copy or otherwise transfer that software component to 
any other media or device without Tyco's express prior written authorization. 

e. Backup Copy. You may make a back-up copy of the Software (other than embedded software) solely for 
archival purposes, which copy may only be used to replace a component of the Software for which you have cur-
rent valid license. Except as expressly provided in this EULA, you may not otherwise make copies of the Soft-
ware, including the printed materials. 

3. OTHER RIGHTS AND LIMITATIONS. Your use of the Software is subject to the following additional lim-
itations. Failure to comply with any of these restrictions will result in automatic termination of this EULA and will 
make available to Tyco other legal remedies. 

a. Limitations on Reverse Engineering and Derivative Works. You may not reverse engineer, decompile, or dis-
assemble the Software, and any attempt to do so shall immediately tertninate this EULA - except and only to the 
extent that such activity may be expressly permitted by applicable law notwithstanding this limitation. You may 
not make any changes or modifications to any portion of the Software, or create any derivative works, without the 
written permission of an officer of Tyco (except as provided in Section 3(f) of this EULA with respect to "open 
source" software). You may not remove any proprietary notices, marks or labels from the Software. You shall insti-
tute reasonable measures to ensure compliance with the terms and conditions of this EULA by your personnel and 
agents. 

b. Copyright Notices. You must maintain all copyright notices on all copies of the Software. 

c. Transfer. You may only transfer your rights under this EULA (i) as part of a permanent sale or transfer of all of 
the devices for which the Software is licensed as applicable; (ii) if you transfer all of the Software (including all 
component parts, the media and printed materials, any upgrades and this EULA); (iii) if you do not retain any cop-
ies of any portion of the Software; (iv) if the recipient agrees to the terms of this EULA; and (v) if the Software is 
an upgrade, such transfer must also include all prior versions of the Software. You agree that failure to meet all of 
these conditions renders such transfer null and void. 

d. Termination. Without prejudice to any other rights, Tyco may terminate this EULA if you fail to comply with 
the terms and conditions herein. In such event, you must immediately destroy all copies of the Software and all of 
its component parts. To the extent the Software is embedded in hardware or firmware, you will provide prompt 
access to Tyco or its representative to remove or lock Software features or functionality as Tyco determines. 

e. Subsequent EULA. Tyco may also supersede this EULA with a subsequent EULA pursuant to providing you 
with any future component, release, upgrade or other modification or addition to the Software. Similarly, to the 
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extent that the terms of this EULA conflict with any prior EULA or other agreement between you and Tyco 
regarding the Software, the terms of this EULA shall prevail. 

f. Incorporation of "Open Source" and other Third Party Software. Portions of the Software may be subject to cer-
tain thirty party license agreements governing the use, copying, modification, redistribution and warranty of those 
portions of the Software, including what is commonly known as "open source" software. A copy of each applic-
able third party license can be found in the file README.TXT or other documentation accompanying the Soft-
ware. By using the Software you are also agreeing to be bound to the terms of such third party licenses. If 
provided for in the applicable third party license, you have a right to receive source code for such software for use 
and distribution in any program that you create, so long as you in turn agree to be bound to the terms of the applic-
able third party license, and your programs are distributed under the terms of that license. A copy of such source 
code may be obtained free of charge by contacting your Tyco representative. 

g. Trademarks. This EULA does not grant you any rights in connection with any trademarks or service marks of 
Tyco, its affiliates or its suppliers. 

h. Rental. You may not sublicense, rent, lease or lend the Software. You may not make it available to others or 
post it on a server or web site or otherwise distribute it. 

i. Software Keys. The hardware/software key, where applicable, is your proof of license to exercise the rights gran-
ted herein and must be retained by you. Lost or stolen keys will not be replaced. 

j. Demonstration and Evaluation Copies. A demonstration or evaluation copy of the Software is covered by this 
EULA; provided that the licenses contained herein shall expire at the end of the demonstration or evaluation 
period. 

k. Registration of Software. The Software may require registration with Tyco prior to use. If you do not register 
the Software, this EULA is automatically tertninated and you may not use the Software. 

I. Additional Restrictions. The Software may be subject to additional restrictions and conditions on use as specified 
in the documentation accompanying such Software, which additional restrictions and conditions are hereby incor-
porated into and made a part of this EULA. 

m. Upgrades and Updates. To the extent Tyco makes them available, Software upgrades and updates may only be 
used to replace all or part of the original Software that you are licensed to use. Software upgrades and updates do 
not increase the number of copies licensed to you. If the Software is an upgrade of a component of a package of 
Software programs that you licensed as a single product, the Software may be used and transferred only as part of 
that single product package and may not be separated for use on more than one computer or System. Software 
upgrades and updates downloaded free of charge via a Tyco authorized World Wide Web or FTP site may be 
used to upgrade multiple Systems provided that you are licensed to use the original Software on those Systems. 

n. Tools and Utilities. Software distributed via a Tyco-authorized World Wide Web or FTP site (or similar Tyco-
authorized distribution means) as a tool or utility may be copied and installed without limitation provided that the 
Software is not distributed or sold and the Software is only used for the intended purpose of the tool or utility and 
in conjunction with Tyco products. All other terms and conditions of this EULA continue to apply. 
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4. EXPORT RESTRICTIONS. You agree that you will not export, re-export or transfer any portion of the Soft-
ware, or any direct product thereof (the foregoing collectively referred to as the "Restricted Components"), to 
IRAN, NORTH KOREA, SYRIA, CUBA and SUDAN, including any entities or persons in those countries, 
either directly or indirectly ("Tyco's Position"). You also agree that you will not export, re-export or transfer the 
Restricted Components to any other countries except in full compliance with all applicable governmental require-
ments, including but not limited to applicable economic sanctions and constraints administered by the U.S. Treas-
ury Department and applicable export control measures administered by the U.S. Department of Commerce and 
U.S. Department of State, any other U.S. government agencies, and measures administered by the European 
Union or the government agencies of any other countries. Any violation by you of the applicable laws or reg-
ulations of the U.S. or any other government, or where you breach Tyco's Position notwithstanding whether or not 
this is contrary to any aforementioned applicable laws or regulations, will result in automatic tertnination of this 
EULA. 

5. U.S. GOVERNMENT RESTRICTED RIGHTS. The Software is Commercial Computer Software provided 
with "restricted rights" under Federal Acquisition Regulations and agency supplements to them. Any use, duplic-
ation or disclosure by the U.S. Government is subject to restrictions as set forth in subparagraph (cXl Xii) of the 
Rights in Technical Data and Computer Software clause at DFAR 255.227-7013 et. seq. or 252.211-7015, or sub-
paragraphs (a) through (d) of the Commercial Computer Software Restricted Rights at FAR 52.227-19, as applic-
able, or similar clauses in the NASA FAR Supplement. Contractor/manufacturer is Sensortnatic Electronics, LLC, 
6 Technology Park Drive, Westford, MA 01886. 

6. LIMITED WARRANTY. 

a. Warranty. Tyco warrants that the recording medium on which the Software is recorded, hardware key, and the 
documentation provided with it, will be free of defects in materials and workmanship under nortnal use for a 
period of ninety (90) days from the date of delivery to the first user. Tyco further warrants that for the same period, 
the Software provided on the recording medium under this license will substantially perform as described in the 
user documentation provided with the product when used with specified hardware. THE FOREGOING 
EXPRESS WARRANTY REPLACES AND IS IN LIEU OF ALL OTHER WARRANTIES OR 
CONDITIONS, WHETHER EXPRESS, IMPLIED, OR STATUTORY, INCLUDING BUT NOT LIMITED 
TO, ANY IMPLIED OR OTHER WARRANTIES OF MERCHANTABILITY, FITNESS FOR A 
PARTICULAR PURPOSE, TITLE, NON-INFRINGEMENT OR NON-MISAPPROPRIATION OF 
INTELLECTUAL PROPERTY RIGHTS OF A THIRD PARTY, CUSTOM, TRADE, QUIET 
ENJOYMENT, ACCURACY OF INFORMATIONAL CONTENT, OR SYSTEM INTEGRATION. TYCO 
MAKES NO WARRANTY THAT ANY PORTION OF THE SOFTWARE WILL OPERATE ERROR-
FREE, FREE OF ANY SECURITY DEFECTS OR IN AN UNINTERRUPTED MANNER. TYCO SHALL 
NOT BE RESPONSIBLE FOR PROBLEMS CAUSED BY CHANGES IN THE OPERATING 
CHARACTERISTICS OF THE DEVICE(S) UPON WHICH THE SOFTWARE IS OPERATING, OR FOR 
PROBLEMS IN THE INTERACTION OF THE SOFTWARE WITH NON-TYCO SOFTWARE OR 
HARDWARE PRODUCTS. TYCO NEITHER ASSUMES NOR AUTHORIZES ANY OTHER PERSON 
PURPORTING TO ACT ON ITS BEHALF TO MODIFY OR TO CHANGE THIS WARRANTY, NOR TO 
ASSUME FOR IT ANY OTHER WARRANTY OR LIABILITY CONCERNING THIS SOFTWARE. THE 
WARRANTY MADE BY TYCO MAY BE VOIDED BY ABUSE OR MISUSE. THIS LIMITED 
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WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS. YOU MAY HAVE OTHER RIGHTS UNDER 
MANDATORY LAW THAT VARY FROM STATE TO STATE AND COUNTRY TO COUNTRY. 

b. Exclusive Remedy. Tyco's entire liability and your exclusive remedy under the warranty set forth in this Section 
6 will be, at Tyco's option, to (i) attempt to correct Software errors with efforts Tyco believes suitable to the prob-
lem, (ii) replace at no cost the recording medium, Software or documentation with functional equivalents as applic-
able, or (iii) refund a pm-rated portion of the license fee paid for such Software (less depreciation based on a five-
year life expectancy) and tertninate this EULA, provided, in each case, that Tyco is notified in writing of all war-
ranty problems during the applicable warranty period. Any replacement item will be warranted for the remainder 
of the original warranty period. No remedy is provided for failure of the Software if such failure is the result of 
accident, abuse, alteration or misapplication with respect to the Software or any hardware on which it is loaded. 
Warranty service or assistance is provided at the original point of purchase. 

7. LIMITATION OF LIABILITY & EXCLUSION OF DAMAGES. 

a. LIMITATION OF LIABILITY. IN NO EVENT WILL TYCO'S AGGREGATE LIABILITY 
(INCLUDING, BUT NOT LIMITED TO, LIABILITY FOR NEGLIGENCE, STRICT LIABILITY, 
BREACH OF CONTRACT, MISREPRESENTATION AND OTHER CONTRACT OR TORT CLAIMS) 
ARISING FROM OR RELATED TO THIS EULA, OR THE USE OF THE SOFTWARE, EXCEED THE 
GREATER OF USD$5.00 OR THE AMOUNT OF FEES YOU PAID TO TYCO OR ITS RESELLER FOR 
THE SOFTWARE THAT GIVES RISE TO SUCH LIABILITY. BECAUSE AND TO THE EXTENT 
THAT SOME JURISDICTIONS DO NOT ALLOW THE EXCLUSIONS OR LIMITATIONS OF 
LIABILITY ABOVE, THESE MAY NOT APPLY TO YOU. 

b. EXCLUSION OF OTHER DAMAGES. UNDER NO CIRCUMSTANCES SHALL TYCO OR ANY OF 
ITS RESELLERS OR LICENSORS BE LIABLE FOR ANY OF THE FOLLOWING: (I) THIRD PARTY 
CLAIMS; (II) LOSS OR DAMAGE TO ANY SYSTEMS, RECORDS OR DATA, OR LIABILITIES 
RELATED TO A VIOLATION OF AN INDIVIDUAL'S PRIVACY RIGHTS; OR (III) INDIRECT, 
INCIDENTAL, SPECIAL, CONSEQUENTIAL, PUNITIVE, RELIANCE, OR COVER DAMAGES 
(INCLUDING LOST PROFITS AND LOST SAVINGS), IN EACH CASE EVEN IF TYCO HAS BEEN 
ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. YOU ARE SOLELY RESPONSIBLE AND 
LIABLE FOR VERIFYING THE SECURITY, ACCURACY AND ADEQUACY OF ANY OUTPUT 
FROM THE SOFTWARE, AND FOR ANY RELIANCE THEREON. SOME JURISDICTIONS DO NOT 
ALLOW THE EXCLUSION OF INCIDENTAL OR CONSEQUENTIAL DAMAGES, OR THE 
LIMITATION ON HOW LONG AN IMPLIED WARRANTY LASTS, SO SOME OF THE ABOVE 
LIMITATIONS MAY APPLY TO YOU ONLY TO THE EXTENT PERMITTED BY THOSE LAWS. 

8. GENERAL. If any provision of this EULA is found to be unlawful, void, or for any reason unenforceable, then 
that provision shall be severed from this EULA and shall not affect the validity and enforceability of the remaining 
provisions. You should retain proof of the license fee paid, including model number, serial number and date of pay-
ment, and present such proof of payment when seeking service or assistance covered by the warranty set forth in 
this EULA. This EULA is governed by the laws of the State of New York, without regards to its conflicts of law 
principles. The parties hereby irrevocably agree that they submit themselves to the personal jurisdiction of the state 
and federal courts of New York for purposes of resolving any and all disputes arising under or related to these 
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terms and conditions. The parties specifically exclude the application of the provisions of the United Nations Con-
vention on Contracts for the International Sale of Goods. 
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